
Xper Information Management System 2.3

English

Instructions for Use



Contents  i
P

h
ili

p
s 

H
ea

lt
h

ca
re
Contents

Contents ............................................................................................................................. i

Introduction ....................................................................................................................... 1
About the Xper Information Management System ........................................................... 1
About the Instructions for Use ......................................................................................... 1
Usage of the Product ........................................................................................................ 2
Intended Use/Indications for Use ..................................................................................... 3
Contraindications .............................................................................................................. 3
Limitations of Use ............................................................................................................. 3
Compatibility ..................................................................................................................... 3
Compliance ....................................................................................................................... 4
Symbols Glossary .............................................................................................................. 4
Training ............................................................................................................................. 6
Power Supply .................................................................................................................... 6
Workplace Design ............................................................................................................. 6
Other Instructions for Use ................................................................................................ 7
Errors in the information supplied with the product ........................................................ 7
About Screen .................................................................................................................... 7
Software Updates ............................................................................................................. 7
Installation ........................................................................................................................ 7
General System Overview ................................................................................................. 7

Safety ................................................................................................................................. 9
Important Safety Directions .............................................................................................. 9
Specific Safety Information ............................................................................................. 10
Network Safety, Security and Privacy ............................................................................. 12
Getting More Information .............................................................................................. 13

Operation ......................................................................................................................... 15
Admitting Patients .......................................................................................................... 15
Document Scanning ........................................................................................................ 29
Entering Procedural Data ................................................................................................ 30
Hemodynamics Screen ................................................................................................... 37
Image Review .................................................................................................................. 55
Still Frame Capture ......................................................................................................... 55
Printing a Case Report .................................................................................................... 56
Finalizing a Case .............................................................................................................. 56
Electrophysiology ............................................................................................................ 57
IntelliVue Interface .......................................................................................................... 57
Philips TraceMaster Interface ......................................................................................... 59
GE MacLab Interface ....................................................................................................... 59

Extended Operation ......................................................................................................... 61
4522 170 25991 Xper Information Management System 2.3 Instructions for Use



ii Contents 

P
h

ili
p

s 
H

ea
lt

h
ca

re
Scheduling .......................................................................................................................61
Data Scrapers ..................................................................................................................63
Structured Reports ..........................................................................................................72
Registries .........................................................................................................................78
Security ...........................................................................................................................78
Inventory Management ..................................................................................................87
Query Wizard ................................................................................................................105
Kit Builder ......................................................................................................................107
List Management ..........................................................................................................109
Registry Lists ..................................................................................................................110
Menu Builder ................................................................................................................111
Arterial Tree Builder ......................................................................................................117
Custom Forms ...............................................................................................................119
Case Status ....................................................................................................................125
Room Status ..................................................................................................................125
Required Fields ..............................................................................................................126
Coding ...........................................................................................................................128
User Tables ....................................................................................................................130
Patient Billing ................................................................................................................137
Insurance Providers .......................................................................................................138
Case Report Configuration ............................................................................................140
Level of Consciousness/Level of Pain ............................................................................141
Patient Historical Links ..................................................................................................142
Modality Performed Procedure Step (MPPS) ................................................................142
Patient Assignment .......................................................................................................143
Repositories ..................................................................................................................143

Preventive Maintenance ................................................................................................ 145
Monitor Mounting Integrity ..........................................................................................145
Monthly Maintenance ...................................................................................................145

Messages and Troubleshooting ...................................................................................... 147
Full System Reset ..........................................................................................................147
Troubleshooting Power and Video Issues .....................................................................147
Troubleshooting Audio ..................................................................................................148
Troubleshooting Network Connection ..........................................................................148
Monitoring Control Screen ............................................................................................148

Product Disposal ............................................................................................................ 151
Introduction ..................................................................................................................151

Technical data ................................................................................................................ 153
System Description ........................................................................................................153
Specifications ................................................................................................................153

Appendices .................................................................................................................... 155
Network Safety, Security, and Privacy ..........................................................................155
Hemodynamic and Lab Value Conversion Calculations ................................................158
Xper Information Management System 2.3 Instructions for Use 4522 170 25991



Contents  iii
P

h
ili

p
s 

H
ea

lt
h

ca
re
Monitoring Site Abbreviation Definitions .....................................................................163
LaFarge Table ............................................................................................................... 166

Index .................................................................................................................................. I
4522 170 25991 Xper Information Management System 2.3 Instructions for Use



iv Contents 

P
h

ili
p

s 
H

ea
lt

h
ca

re
This page intentionally left blank.
Xper Information Management System 2.3 Instructions for Use 4522 170 25991



Introduction About the Xper Information Management System   1 

P
h

ili
p

s 
H

e
al

th
ca

re
1 Introduction

1.1  About the Xper Information Management System

The Xper Information Management System is used for acquiring, displaying, trending, storing 
and transmitting various types of data such as physiologic/hemodynamic, clinical, medical 
image and other related data. Its users, responsible to interpret the data provided, will be 
professional health care providers, such as physicians, registered nurses, cardiovascular 
technicians, radiology technicians, and other clinical health care providers. The system is 
capable of processing/analyzing information such as multi-channel ECG signals, displaying a 
graphical ST segment map and performing other data management functions such as creating 
reports. Data may be acquired from and/or sent to other devices such as physiological 
monitoring systems, information management systems, image acquisition/storage devices and 
other medical devices.

The Xper Information Management System also provides optional ancillary functions, such as 
scheduling, inventory control, patient billing, statistical reporting, and other non-clinical 
modules. Users of the ancillary functions may be health care providers, but may also be 
nonclinical users authorized by the facility.

NOTE
When this instructions for use refers to “Xper Information Management System”, it refers to 
the software only (which is a medical device in its own right). When this instructions for use 
refers to “Xper Information Management System Workstation”, it refers to a computer on 
which the Xper Information Management System software is installed together with a flat 
panel display.

1.2  About the Instructions for Use

This Instructions for Use is intended to assist users in the safe and effective use of the Philips 
software product described. The “user” is considered to be not only the body with authority 
over the software product but also those persons who use the software product.

This Instructions for Use does not describe the use of the IT equipment on which the Philips 
software product is installed. Refer to the documentation of the IT equipment concerned.

Before attempting to use this software product, you must read this Instructions for Use 
thoroughly, paying particular attention to all WARNINGS, Cautions, and Notes it contains. You 
must pay special attention to all the information given, and procedures described, in the 
chapter “Safety”. In addition you must pay special attention to On-screen Messages and 
ONLINE HELP information containing WARNINGS, Cautions, and Notes that may be related to 
the function being executed.
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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WARNING
WARNINGS are directions which if not followed could cause fatal or serious injury to a user, 
patient or other person, or could lead to clinical misdiagnosis, misinterpretation, and/or loss 
or damage of patient-related data.

CAUTION

Cautions are directions which if not followed could cause damage to the IT equipment on 
which the software product is installed and/or other equipment or goods, and/or cause 
environmental pollution.

NOTE
Notes are intended to highlight points of attention as an aid to users.

This Instructions for Use and the ONLINE HELP describe the most extensive configuration of 
the software product, with the maximum number of options. Not every function described 
may be available.

WARNING
The chapter “Safety” deals with safety aspects and should be read first, before operating this 
software product.

NOTE
The screen shots in the Instructions for Use can differ from the user interface screens on 
details.

1.3  Usage of the Product

This Philips software product is intended to be installed and used only in accordance with the 
safety procedures and instructions given in this Instructions for Use and for the purpose for 
which it was designed.

The purpose for which the software product is intended is given below. However, nothing 
stated in this Instructions for Use reduces users' responsibilities for sound clinical judgment 
and best clinical procedure.

Installation and use of this software product is subject to the law in the jurisdiction in which it 
is being used. Users must only install and/or use the software product in such ways as do not 
conflict with applicable laws, or regulations which have the force of law.

Use of the software product for purposes other than those intended and expressly stated by 
the Manufacturer, as well as incorrect use, may relieve the Manufacturer (or his agent) from all 
or some responsibility for resultant non-compliance, damage or injury.
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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1.4  Intended Use/Indications for Use

The Xper Information Management System is intended for use under the direct supervision of 
a healthcare practitioner for acquiring, displaying, trending, storing and transmitting various 
types of data, such as physiologic/hemodynamic, clinical, medical image and other related 
data. The system is capable of processing/analyzing information, such as multi-channel ECG 
signals, and performing other data management functions, such as creating reports. Data may 
be acquired from and/or sent to other devices, such as physiological monitoring systems, 
information management systems, image acquisition/storage devices, and other medical 
devices.

The system is indicated for use in the following areas: cardiology, cardiac catheterization, 
electrophysiology, radiology, invasive radiology, and surrounding areas where access to the 
information is needed.

The system consists of modules and may be entirely a software offering or a hardware/
software offering. It is intended for use on standard computer systems and does not require 
proprietary hardware. The solution is available as a single module or combination of modules, 
or may function as a standalone system.

The system is capable of receiving and displaying user-adjustable alarms (both visual and 
audible) available in the system, which alert the operator to anomalous occurrences and 
facilitate timely responses. Use of the system is not intended where unattended patient 
monitoring is desired, or in situations where arrhythmia detection is required.

The system provides the ability to transmit patient data files for storage, viewing and analysis 
at distributed locations via the intranet or Internet, or may function as a stand-alone device.

1.5  Contraindications

This software product should not be used if any of the following contraindications exist or are 
thought to exist: use of the Xper Information Management System is not intended where 
unattended patient monitoring is desired, or in situations where arrhythmia detection is 
required.

1.6  Limitations of Use

WARNING
Xper Information Management System must be operated in an environment where the 
minimum specified requirements for hardware and network performance are met.

1.7  Compatibility

The software product described in this Instructions for Use should not be used in combination 
with other software, equipment or components unless such other software, equipment or 
components are expressly recognized as compatible by Philips Healthcare. A list of such 
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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software, equipment and components is available on request from your local Philips 
Healthcare Representative, or the Manufacturer. Philips Healthcare is not responsible for 
running compatibility validation of non-supported third-party software.

Changes and/or additions to the software product should only be carried out by Philips 
Healthcare or by third parties expressly authorized by Philips Healthcare to do so. Such 
changes and/or additions must comply with all applicable laws and regulations which have the 
force of law within the jurisdictions concerned, and with best engineering practice.

Changes and/or additions to the software product that are carried out by persons without the 
appropriate training may lead to the Philips Healthcare warranty being voided.

Philips is not responsible for any malfunction of Xper Information Management System if Xper 
Information Management System runs on hardware that is not according to hardware 
specification.

If not supplied by Philips with the Xper Information Management System software, Philips is 
not responsible for any malfunction of the hardware used.

1.8  Compliance

This software product complies with relevant international and national standards and laws. 
Information on compliance will be supplied on request by your local Philips Healthcare 
Representative, or by the Manufacturer.

This software product must be installed on appropriate IT equipment that complies with 
relevant international and national laws and standards on EMC (Electro-Magnetic 
Compatibility) and Electrical Safety. Such laws and standards define both the permissible 
electromagnetic emission levels from equipment and its required immunity to 
electromagnetic interference from external sources.

1.9  Symbols Glossary

The following symbols may appear in the product documentation or on the labels attached to 
the product.

Symbol Symbol Name Symbol Description Standard Number & 
Name

Symbol Reference 
Number

Manufacturer Indicates the name 
and address of the 
Manufacturer.

ISO 15223-1:20121

EN 980:20082

5.1.1

5.12
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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Authorized 
Representative in 
the European 
Economic Area 
(EEA).

Indicates the 
Authorized 
Representative, 
responsible for the 
device in the 
European Economic 
Area (EEA).

ISO 15223-1:20121

EN 980:20082

5.1.2

5.13

Date of manufacture Indicates the date 
when the device was 
manufactured.

ISO 15223-1:20121

EN 980:20082

5.1.3

5.6

Batch code Indicates the full 
Software Release/
Version number.

ISO 15223-1:20121

EN 980:20082

5.1.5

5.4

Catalogue number Indicates the 
manufacturer's 
catalogue number 
so that the device 
can be identified.

ISO 15223-1:20121

EN 980:20082

5.1.6

5.10

Consult

instructions for

use

Indicates the need 
for the user to 
consult the 
instructions for use.

ISO 15223-1:20121

EN 980:20082

5.4.3

5.18

Caution

and/or

Warning

WARNINGS are 
directions which if 
not followed could 
cause fatal or 
serious injury to a 
user, patient or 
other person, or 
could lead to clinical 
misdiagnosis, and/or 
loss or damage of 
patient-related data.

Also: 

This symbol is used 
on the device label 
to highlight the fact 
that there are 
specific warnings or 
precautions 
associated with the 
device, which are 
not otherwise found 
on the label.

ISO 15223-1:20121

EN 980:20082

5.4.4

5.11

Symbol Symbol Name Symbol Description Standard Number & 
Name

Symbol Reference 
Number
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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1.10  Training

Users of this software product must have received adequate training on its safe and effective 
use before attempting to use the software product described in this Instructions for Use.

Training requirements for this type of software product will vary from country to country. It is 
for users to make sure that they receive adequate training in accordance with local laws or 
regulations which have the force of law. If you require further information about training in the 
use of this software product, please contact your local Philips Healthcare representative, or 
the Manufacturer.

1.11  Power Supply

It is advised to use an uninterruptible power supply (UPS), for example, to continue to provide 
power to the Xper Information Management System for a specified time after a power outage, 
and to allow automatic and controlled shutdown.

1.12  Workplace Design

To minimize the risk of computer-related disorders, ensure the workplace is properly designed 
and provides a good ergonomic working position (e.g., proper working height of chair and 
desk; screen setup). Observe good working practices; for example, take regular breaks and 
perform exercises. Alternate work periods at the computer with other kinds of work.

CE Marking of 
Conformity

Product meets the 
requirements of 93/
42/EEC for Medical 
Devices distributed 
in the European 
Economic Area 
(EEA).

(European)

COUNCIL DIRECTIVE 
93/42/EEC of 14 
June 1993 
concerning medical 
devices

Annex XII

Prescription Device 
in USA

Caution: Federal law 
restricts this device 
to sale by or on the 
order of a licensed 
healthcare 
practitioner.

21 CFR 
801.109(b)(1) 
Prescription Devices

Not applicable

1. ISO 15223-1:2012 Medical devices - Symbols to be used with medical devices labels, labeling, and information to be supplied - 

Part 1: General requirements.

2. EN 980:2008          Symbols for use in the labeling of medical devices.

Symbol Symbol Name Symbol Description Standard Number & 
Name

Symbol Reference 
Number
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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1.13  Other Instructions for Use

This Instructions for Use relates to the software product Xper Information Management 
System. However, if other software and/or equipment may be used with the software product, 
each will have its own Instructions for Use.

1.14  Errors in the information supplied with the product

If you suspect an error in the information supplied with the software product, for example, in 
this Instructions for Use, you should report the error to your local Philips Healthcare 
Representative or the Manufacturer, for analysis and, if applicable, for correction.

1.15  About Screen

To display the About Screen that displays labeling and product information, open the 
application, and click on the version number in the lower left corner of the home portal:

To close the About Screen, click anywhere on the About Screen.

NOTE
You can only open the About Screen from the home portal, and not from within a case.

1.16  Software Updates

Updates for this Philips software product can become available. Such updates are essential to 
keep the software product operating safely, effectively, and reliably.

1.17  Installation

Installation of the Xper Information Management System may be performed on site or 
remotely by Philips Healthcare Service Technicians.

1.18  General System Overview

The Xper Information Management System Workstation consists of Xper Information 
Management System software installed on a computer workstation with a flat panel monitor. 
Based on the specific configuration, the system could include an additional flat panel monitor, 
a printer, and a battery backup. Optional equipment includes an Xper Flex Cardio 
Physiomonitoring System in a procedure room or holding area, a Datacenter, and/or hospital 
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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interface broker. The system could be networked through a hub, switch, or router to the file 
server.
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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2 Safety

2.1  Important Safety Directions

All Philips Healthcare products are designed to meet stringent safety standards. To safeguard 
human safety, this software product requires proper installation, use and maintenance.

It is vital that you read, note, and where applicable, strictly observe all DANGER notices and 
safety markings on the outside of the IT equipment on which this software product has been 
installed. To help ensure the safety of both patients and users, it is vital that you strictly follow 
all directions under the heading SAFETY and all WARNINGS and Cautions given throughout this 
Instructions for Use and/or displayed on the user interface.

You must also note the following information.

2.1.1  Safety Awareness

WARNING 
Do not use this software product for any application until you have read, understood and 
known all the safety information and safety procedures contained in this SAFETY chapter. 
Use of this software product without a proper awareness of how to use it safely could lead 
to fatal or serious injury, clinical misdiagnosis, misinterpretation and/or loss/damage of 
patient-related data.

2.1.2  Adequate Training

WARNING 
Do not use this software product for any application until you have received adequate and 
proper training in its safe and effective use. If you are unsure of your ability to use this 
software product safely and effectively DO NOT USE IT. Use without proper and adequate 
training could lead to fatal or serious personal injury, clinical misdiagnosis, misinterpretation 
and/or loss/damage of patient-related data.

For information about training, please refer to Training in the chapter “Introduction” in this 
Instructions for Use.

2.1.3  Usage & Compatibility

WARNING 
Do not use this software product for any purpose other than that for which it is intended.

Do not use this software product with any equipment or software other than that which 
Philips Healthcare recognizes as compatible. Use of this software product for unintended 
purposes, or with incompatible software and/or equipment, could lead to fatal or serious 
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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personal injury, clinical misdiagnosis, misinterpretation and/or loss/damage of patient-
related data.

For information about intended use and compatibility, refer to the Intended Use and 
Compatibility sections in the chapter ‘Introduction” in this Instructions for Use.

2.1.4  Data Security

WARNING
For information about Data Security, please refer to “Network Safety, Security, and Privacy” 
on page 155.

2.1.5  Power Off

WARNING
Never switch the IT equipment off using the POWER ON/OFF switch while the software 
product is still running, as this may damage data integrity, which can lead to loss/damage of 
patient-related data. Always exit the software product before switching off the IT 
equipment.

2.1.6  Unsupported Software

WARNING
Do not install unsupported software on the Xper Information Management System 
Workstation as this could interfere with diagnosis, interpretation and/or cause loss of or 
damage to patient-related data, and/or introduce computer viruses.

2.2  Specific Safety Information

2.2.1  Hardware used together with the Xper Information Management System

Xper Information Management System may only be used with hardware that meets the 
minimum system requirements and also the requirements for the environment in which it is to 
be used.

2.2.2  Data Accuracy Responsibility

WARNING
Entering data into the wrong screen may result in erroneous displays.

The Xper Information Management System is comprised of multiple data entry and system 
action screens. Many screens support multiple data input methods via mouse, keyboard and/
or bar-code reader. Individual keyboard keys often support different system functions in 
different screens. So as to assure that desired and appropriate system functions are carried 
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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out, operators are responsible to be aware of which system screen is active before performing 
keyboard data entry. Likewise, patient diagnosis should not be based solely on results provided 
by Xper Information Management System. Clinical correlation is advised.

2.2.3  Computer Virus Protection

The Xper Information Management System is a software product and is therefore subject to 
attack by computer viruses. The threat of a computer virus is ever expanding as new viruses 
are introduced almost daily. The software required to prevent attack by a computer virus must 
therefore be constantly monitored and updated. McAfee VirusScan Enterprise antivirus 
software is installed on all Philips-provided Xper Information Management System 
Workstations. After installation, it is the responsibility of your biomedical department or 
hospital information systems staff to update virus definitions regularly and provide upgrades.

2.2.4  Off the Shelf Software

The Xper Information Management System Workstation may utilize the following off-the-shelf 
software products:

• Microsoft® SQL Server® 2014 Enterprise / Express

• Microsoft® Windows® 7 Pro Service Pack 1

• Microsoft® Windows® 10 Enterprise

• Microsoft® Windows® Server 2012 Service Pack 3

• VMware, Inc. VMWare Workstation

• VMware ESXi

• McAfee VirusScan Enterprise

• UltraVNC© Server and UltraVNC© Viewer

These tested and approved third-party software products or off-the-shelf software products 
are installed and configured by factory trained technicians on all computers provided by Philips 
Healthcare. Each software product is installed and configured using the “typical” installation 
method as specified by its manufacturer. Configuration and setup of these off-the-shelf 
software products should not be altered except to install periodic software patches as 
provided by their manufacturer.

With the exception of the abovementioned off-the-shelf products and third-party software 
products that have been explicitly tested and validated by Philips Healthcare, Xper Information 
Management System has not been tested for proper and safe operation in combination with 
any other off-the-shelf software products. Do not load any off-the-shelf software onto the 
hard drive. Loading any unauthorized off-the-shelf software products onto the hard drive may 
affect the safety and efficiency of the device, may lead to increased risk to users and patients, 
and will void any or all warranties and maintenance plans.

Licensed copies of all off-the-shelf software products used with the Xper Information 
Management System are provided to the end user during shipping and installation. It is the 
end user’s responsibility to maintain and protect this licensed software in a safe location.
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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Customers may provide their own personal computer hardware for Xper Information 
Management products that do not have direct patient contact, such as control room 
workstations, review stations and file servers. This hardware must meet or exceed Philips 
Healthcare’s minimum published specifications. Off-the-shelf software should be installed and 
configured using the manufacturer’s “typical” installation method.

2.2.5  Back-up for Disaster Recovery

Philips Healthcare recommends that the following directories on your server be backed up 
nightly to a separate device, to ensure quick recovery from a disaster, such as the loss of your 
server hard drive:

• \DATACENTER

• \DCCASES

• \MSSQLBACKUPS

• \XPERSHARE

2.2.6  Alternate Monitoring Source

The ACC/AHA Guidelines for Cardiac Catheterization Labs (JACC volume 18, No. 5) emphasize 
the importance of patient monitoring during cardiac catheterization procedures. In view of 
this, Philips Healthcare strongly recommends that redundant monitoring capabilities be 
available. When monitoring a patient attached to the Xper Flex Cardio Physiomonitoring 
System that is connected to the Xper Information Management System, the combined systems 
should not be the sole means of monitoring patients during cardiac catheterization 
procedures. Please refer to the Xper Flex Cardio Physiomonitoring System Instructions for Use 
for more information on patient monitoring.

2.3  Network Safety, Security and Privacy

2.3.1  Customer Role in the Product Security Partnership

We recognize that the security of Philips Healthcare products is an important part of your 
facility’s security-indepth strategy. However, these benefits can only be realized if you 
implement a comprehensive, multi-layered strategy (including policies, processes and 
technologies) to protect information and systems from external and internal threats.

Following industry-standard practice, your strategy should address physical security, 
operational security, procedural security, risk management, security policies, and contingency 
planning. The practical implementation of technical security elements varies by site and may 
employ a number of technologies, including firewalls, virus-scanning software, authentication 
technologies, etc.

As with any computer-based system, protection must be provided such that firewalls and/or 
other security devices are in place between the medical system and any externally accessible 
systems. The USA Veterans Administration has developed a widely used Medical Device 
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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Isolation Architecture for this purpose. Such perimeter and network defenses are essential 
elements in a comprehensive medical device security strategy.

For our product security policy statement and additional information, see the Philips 
Healthcare product security website at:

http://www.philips.com/security

2.4  Getting More Information

2.4.1  Information you need

More information about using the Xper Information Management System is available from the 
following sources:

• Documentation

• Technical support

Documentation

Consult the following documentation for additional information about using the Xper 
Information Management System:

• Xper Information Management System - System Administrator Guide. This manual 
describes activities that system administrators must complete to maintain the Xper 
Information Management System, including the assignment of users and permissions to 
workgroups. IMPORTANT: This guide is only available to system administrators (not all 
users).

• Xper Information Management System - Release Notes. This document provides an 
overview of the system new features, improvements, and/or resolved issues. 
IMPORTANT: it does not replace this Instructions for Use.

• Xper Information Management System - Quick Reference Guides. These guides provide 
overview of Xper Information Management System menus and modules. IMPORTANT: 
they do not replace this Instructions for Use.

Technical Support

Should you encounter difficulty using the Xper Information Management System, refer to 
“Specifications” on page 153 for basic information about the system and follow the guidelines 
below to locate the relevant source for information and assistance.

• Configuration Settings—Configuration includes the assignment of user permissions and 
the content of various lists used in the applications. For questions in these areas, consult 
a hospital Xper Information Management System system administrator or refer to the 
Xper Information Management System - System Administrator Guide.

• Technical Issues—These issues include backup schedules, network connectivity, and 
workstation operation. Start by contacting a hospital Xper Information Management 
4522 170 25991 Xper Information Management System 2.3  Instructions for Use
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System system administrator or refer to the Xper Information Management System - 
System Administrator Guide.

If you cannot resolve your problem, contact the Philips technical support group serving your 
area. To obtain contact information for this group, ask your local Philips Healthcare 
representative.

When contacting Philips technical support, please have the following information available:

• Caller name, customer organization name, and location.

• Site number, if applicable.

• Detailed description of the problem, including any history of troubleshooting efforts 
completed before or after the problem first occurred.
Xper Information Management System 2.3  Instructions for Use 4522 170 25991
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3 Operation

3.1  Admitting Patients

3.1.1  Admitting a Patient Manually

1 To admit a patient, click ADMIT, then click MANUAL ADMIT. A new Case Details screen 
opens. You can begin filling in the patient’s demographic, procedure, and lab data. Last 
Name, First Name, and Medical Record Number are required.

2 When you are ready to begin recording hemodynamic data, click Start Case.

Click the SWITCH button to be able to view the monitoring screen.

3.1.2  The Case Details Screen

The Case Details screen contains a patient’s demographic data, information about the staff 
and procedural data, and lab values. The data may be entered manually, or the fields may be 
completed by the ADT interface admission process. You may also build data scrapers to 
complete some fields. The following tables list the fields and descriptions of their functions. 

Patient Information.

Field Description

Last Name Patient’s last name (required)

First Name Patient’s first name (required)

MI Patient’s middle initial

Suffix Indicates whether patient is a Jr., III, IV, etc.

Height (cm) Patient’s height in centimeters

Height (In.) Patient’s height in inches

Weight (Kg) Patient’s weight in kilograms

Weight (Lb.) Patient’s weight in pounds

BSA Patient’s body surface area in square meters

BMI Body Mass Index in kilograms/square meter

Date of Birth Patient’s date of birth

Age Patient’s current age

Gender Patient’s gender

Nationality/Ethnicity Patient’s nationality or ethnicity

Allergies Patient’s allergies

Medical Record Number Patient medical record number (required)
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Case Information

Demographics

Field Description

Procedure Date Date procedure was performed

Admit Date Date of patient’s admission or registration to the facility

Pre-Admit Date Date the patient was pre-admitted

Finalized Date Date the study was finalized

Patient In Time the patient arrived in the procedure room

Setup Done Time the patient was ready to undergo a procedure

Phys Paged Time the attending physician was paged

Phys Arrived Time the attending physician arrived in the lab

Begin Time Time the procedure began

End Time Time the procedure ended

Patient Out Time the patient left the procedure room

Room Procedure room

Field Description

Account Number Patient’s account number

Case Number A system-generated index number

EMPI Enterprise Master Patient Index (US only)

Accession Number A unique procedure identifier

Social Security Number Patient’s social security number

Patient ID Optional ID number for internal departmental use

Legacy Name Combination of patient’s Last Name, First Name and MI (middle initial). 
Used in Query and Transcription. Example: Doe, John A. 

Address 1 Address field

Address 2 Additional address data

City City in which the patient lives

State State in which the patient lives

Zip Code Zip or postal code

Country Country in which the patient lives

Phone 1 Patient’s phone number

Phone 2 Additional contact number

Insurance Name Patient’s insurance

Insurance Group Number Patient’s insurance group number

Ins Subscriber ID Patient’s insurance ID number

Ordered Reason for Study Code Code for reason the study was ordered
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Resources and Procedures

You can add, delete, or change resources and procedures.

To add resources to a procedure:

1 Click Add above the Resources list to open the list of staff. 

You may sort the list alphabetically or by staff role (e.g., Circulate, Physician, Scrub, etc.). 

2 Click the + (plus symbol) beside any name to display a list of sub-specialties for that 
resource (e.g., Diagnostic Physician, Interventionalist, Certified Registered Anesthetist, 
etc.).

3 Double-click any resource to add it to the Resources list.

4 Select the Show with access check box to display only users who have access to the 
repository in which you’ve admitted the case.

5 Close the Resources list.

To add procedures:

1 Click Add above the Procedures list.

2 Double-click the procedures you want to add. 

You may sort the list alphabetically.

3 Close the Procedures list.

To delete resources or procedures:

1 Click on a resource or procedure in the list to select it.

2 Click Delete above the resources window.

The procedure is deleted from the Procedures list.

To change the order of resources or procedures lists on the Case Details screen:

Ordered Reason for Study 
Description

Description of reason the study was ordered

Non-Finalized Indicates the study has not been finalized

Legacy Case Combination of Station ID and Case Number. Used in Query and 
Transcription.

Case Finalized Indicates the study has been finalized

Hidden Indicates that the study is hidden 

On Waiting List Checked when a pre-admitted case is opened

Field Description

Resources List of staff, physicians, fellows and referring physicians associated with the 
procedure

Procedure(s) List of procedure(s) performed

Field Description
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1 Click on a resource or procedure to select it.

2 Use the UP or DOWN arrows to change the order.

Resource Specialties

Resources may have one or more specialty associated (e.g., Diagnostic Physician, 
Interventional Physician, Holding Area Nurse, etc.). 

1 To assign a resource with a specialty, click the + (plus symbol) next to the resource you 
want to add.

This will expand the list.

2  Double-click the specialty you want to assign (see “Resource Types” on page 136).

Assigning procedures to multiple physicians

If you have assigned more than one physician to a case, any procedures you assign will be 
automatically attributed to the first physician. 

To attribute a procedure to a different physician:

1 Click on the physician name next to the procedure to highlight it.

2 Click on the end of the field to the right of the physician name. 

This will open a drop-down list containing all the physicians assigned to the case (there will 
be a short delay before the list displays). 

3 Select a different physician to assign to the procedure.

3.1.3  Labs/Procedure Data

In Xper Information Management System 2.3, labs and procedure data can be configured by 
station in the system configuration in two ways: legacy labs and lab series. If you admit a new 
case, the lab configuration determines how the labs will be saved. For example, if the system 
configuration is set for legacy labs, you will see the legacy labs (historical labs) screen. If a case 
is admitted on a station with the lab series system configuration, the station will show the lab 
series screen whenever the case is opened.

NOTE
Lab series configuration is only available for Xper Information Management System 2.1 and 
higher.

Legacy Labs (Historical labs view)

The Labs/Procedure Data tab with legacy labs contains lab results for the patient, including 
procedure information displayed in the historical view. Lab values are expressed in standard US 
units and, where appropriate, in international standard units. All results are available in case 
details and transcription reports.

If values are entered in either field (US or international), Xper Information Management 
System will convert the data and automatically populate the corresponding fields. For 
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example, if you enter a value in HGB (g/dl), Xper will automatically calculate and populate the 
HGB (g/l) field with the correct value.

The data may be entered manually, or the fields may be completed by the ADT interface 
process. You may also build data scrapers to complete some fields (see “Data Scrapers” on 
page 63). The specific fields and their functions are listed in the following table:

Field Description

HGB (g/dl) Hemoglobin (standard US units)

HGB Date Date of HGB lab result

PTT Partial Thromboplastin Time (standard US units)

PTT Date Date of PTT lab result

HCT Hematocrit (standard US units)

HCT Date Date of HCT lab result

GLU Glucose (standard US units)

GLU Date Date of GLU lab result

WBC White Blood Cells (standard US units)

WBC Date Date of WBC lab result

K+ Potassium (standard US units)

K+ Date Date of K+ lab result

PLT Platelets (standard US units)

PLT Date Date of PLT lab result

NA+ Sodium (standard US units)

NA+ Date Date of NA+ lab result

PT Prothrombin Time (standard US units)

PT Date Date of PT lab result

BUN Blood Urea Nitrogen (standard US units)

BUN Date Date of BUN lab result

INR International Normalized Ratio (standard US units)

INR Date Date of INR lab result

CREAT Creatinine (standard US units)

CREAT Date Date of CREAT lab result

HGB (g/l) Hemoglobin (international standard units)

HGB (mmol/l) Hemoglobin (international standard units)

HCT (SI) Hematocrit (international standard units)

GLU (mmol/l) Glucose (international standard units)

K+ (mmol/l) Potassium (international standard units)

NA+ (mmol/l) Sodium (international standard units)

BUN (mmol/l) Blood Urea Nitrogen (international standard units)
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Lab Series

The lab series screen displays lab results and lab ranges. All legacy lab values and procedures 
are available for each patient, including imported data from external sources, and multiple 
values are allowed for each lab result. The lab series grid displays normal ranges and highlights 
abnormal values with yellow to alert the clinician of an abnormal lab result.

The lab series screen can be refreshed to bring in new updates. Otherwise, refresh occurs 
automatically at a specified interval set in the system configuration for lab series. The grid can 
be configured to display either US or international values. Once a case is admitted with lab 
series system configuration, the case will start polling the interface for lab results. The values 
received are related to the period of 30 days before the current date. Clinicians can select the 
Hgb or Creatinine value to be used in calculations. For accounts that do not have a lab 
interface, or in the event of network failure, clinicians can enter lab results manually.

To view a lab series for a specific patient:

1 Open a patient case.

2 Click on the Labs/Procedure Data tab.

NOTE
Incoming labs which are not recognized by the system or labs which contain invalid characters 
will be displayed in a grid below the lab series results.

NOTE
Labs highlighted in yellow indicate results that are out of the normal range.

To add a new lab series:

1 Click New.

2 Select the date and time.

3 Select the Lab Label.

4 Type a Value in the text box and click OK.

To edit a lab series:

1 Click on a Lab to select it and click Edit.

2 Type the new value in the text box and click OK.

NOTE
Only manually entered lab values can be changed. A lock icon will indicate values which were 
imported via the interface. These values cannot be changed, only deleted.

NOTE
When the End Time on the Case Details tab is filled in, the study does not receive more Lab 
Series information performed after the time set.

CREAT (umol/l) Creatinine (international standard units)

Field Description
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Other functions:

• Refresh—Updates labs on demand, rather than at the automatic polling interval. 

• Select—Used to select values for calculations (HGB and CREAT only).

• Delete—Deletes the selected lab result.

NOTE
All changes are tracked and shown on the Audit tab.

NOTE
To set lab ranges, see “Lab Ranges” on page 132. A case cannot be open while setting lab 
ranges.

NOTE
Lab ranges are optional. Unless lab ranges are configured for the repository, notification of 
abnormal values will not display in the lab series list in a study.

Procedure Data

Status

The Status tab is used to send messages to the Patient Status Viewer. See “Patient Status 
Viewer” on page 27 for more information.

History

The History tab contains a list of all of a patient’s previous Xper Information Management 
System studies. From the History tab, you can double-click to open a previous study in read-
only mode. When you close the historical case, the current case will still be open. For 
information on establishing historical links, see “Patient Historical Links” on page 142

Field Function

Contrast Type 1 First type of contrast used during procedure

Contrast Type 2 Second type of contrast used during procedure (optional)

Patient Class Indicates whether a patient’s status is Inpatient or Outpatient

Contrast Total Max Total maximum contrast that may be administered to the patient

Contrast Limit Manufacturer’s suggested contrast limit per kg of body weight

Used #1 (ml) Total amount of first contrast used

Used #2 (ml) Total amount of second contrast used

Total (ml) Total of Used #1 and Used #2

Creat Clearance (ml/min) Indicator of patient’s kidney function (standard US units)

Creat Clearance (ml/s) Indicator of patient’s kidney function (international standard units)

Fluoro (min) Fluoro time

Fluoro Dose (Gycm2) Fluoro dose
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The Links section of the History tab will display links to a patient’s previous ECG studies when 
you have an interface with the Philips TraceMasterVue system. For more information, see 
“Philips TraceMaster Interface” on page 60.

Documents

The Documents tab contains a list of signed transcription documents and case reports that 
were created during the study. Any scanned documents saved as a PDF will also be included. 
You can print a single document from this screen, or use standard Microsoft Windows 
keyboard functionality to select multiple documents to be printed. To Print, do one of the 
following:

• To print a single document, click on the document to highlight it and then click Print 
Docs. To select documents throughout the list, hold down the Ctrl key while clicking on 
documents.

Or:

• To print a range of documents, click on the first document in the range, hold down Shift, 
and click on the last document in the desired range, then click Print Docs. To remove 
individual documents from the range, or to add documents, use the Ctrl key.

Additional Data 

The Additional Data tab contains several fields in which users can enter information. The fields 

and descriptions of their definitions are listed below:.  

Field Description

Reason for Study Automatically added, but may be manually populated from the list or 
edited.

Description Automatically populates  based on the reason for study selected.

Coding System Identifies the coding system, version, Catalog year, and activation date.

Diagnosis Codes Physicians will be able to assign diagnosis codes based on the 
procedures performed. 

FFR Allows a user to enter a Fractional Flow Reserve value.

Elapsed Time Displays the amount of time elapsed between Start and End times of a 
procedure.

Completion (days) The number of days elapsed between the date on which a case was 
added to the Waiting List and the date on which the procedure was 
performed.

Date Signed The date on which the most recent electronic signature was applied to 
a transcription document.

Signed By The person who last applied an electronic signature to a transcription 
document.

Health Insurance Allows user to select an insurance provider, which will generate patient 
charges based on information entered in the Procedures table and in 
Inventory for that provider. For more information, see “Insurance 
Providers” on page 138. 
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MPPS

The MPPS (Modality Performed Procedure Step) tab displays information from an MPPS 
interface with your DICOM x-ray system, if available. MPPS requires an Xper Connect or 
IntelliBridge Enterprise interface. For information on configuring MPPS, see “Modality 
Performed Procedure Step (MPPS)” on page 142.

If MPPS data has been transferred during a study, you can import the data into a charting 
menu. This will enable the data to be scraped to other fields or to transcription reports. 

To import the data into a charting menu:

1 Click Transfer to Menu. 

2 You may then scrape or query the data as you would any other menu.

NOTE
Data can be transferred to a charting menu one time only. Do not perform this operation until 
you are sure the data is complete.

Audit

The Audit tab displays events, User ID, date, and details of changes of additions.

3.1.4  Admitting a Patient through an ADT interface

If you have an Xper Connect or IntelliBridge Enterprise interface to your facility’s ADT system, 
you can admit patients through this interface. To admit a patient using the interface:

1 From the Admit menu, click ADT ADMIT. 

This will open the Patient Admit Search window. You have the option to search for patients 
based on MRN (medical record number), SSN (social security number), Account Number, 
Accession Number, Last Name, or DOB (date of birth).

2 Select the search method; then enter the data to search for in the Input Patient Identifier 
field. 

3 Click Search to begin searching through the current hospital admissions for your patient.

The application will return a list of matching patients.

4 Highlight the patient and double-click Admit.

This will open a Case Details screen that will contain as much information as is available 
from the ADT interface. You may then complete the remaining fields manually or by using 
data scrapers.

Referred for Surgery Can be checked by a user to indicate that the patient was referred for 
open heart surgery.

Date Referred Enter the date on which a patient was referred for open heart surgery.

Field Description
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5 Click Start Case to begin recording hemodynamic data.

Click the SWITCH button to be able to view the monitoring screen.

If your system is configured for a DICOM Worklist, you may admit patients from this list. To 
admit a patient from the DICOM Worklist:

1 Click ADMIT > WORKLIST ADMIT. 

This will open the Worklist Manager screen. You have the option to search for patients 
based on name, patient ID, accession number, scheduled station, station AE title, modality, 
or start and end date.

2 Type the data to search for in the appropriate field. 

3 Click Query to begin searching the worklist for your patient. 

The application will return a list of matching patients.

4 Double-click the patient.

This will open a Case Details screen that will contain as much information as is available 
from the worklist. 

5 Complete the remaining fields manually or by using data scrapers.

6 Click Start Case to begin recording hemodynamic data.

Click the SWITCH button to be able to view the monitoring screen.

NOTE
If the patient admitted has study data recorded in Epic Cupid, that medical record is loaded to 
the Charting screen in the previously configured Charting Menu (see “Menu Builder” on 
page 111).

3.1.5  Admitting a Patient from the Study Scheduler

You may admit patients from the Study Scheduler. To do so:

1 Find the patient’s study on the schedule and right-click on the study.

2 Select Admit to open a Case Details screen.

This will contain all available information from the scheduled event (name, medical record 
number, procedures, and staff). 

3 Complete the remaining fields manually or by using data scrapers.

3.1.6  Admitting a Patient from Allura

To admit a patient to the Xper Information Management System from an Allura X-ray system, 
you must first create the study on the Allura system. 

After entering the patient data on the Allura system:
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1 Click ADMIT > ADMIT FROM ALLURA on the Xper Information Management System 
Workstation.

A new study will be created with any available data from the Allura system populating the 
matching fields. 

2 The following data elements must be completed in the Allura system in order to 
successfully admit a study into Xper Information Management System:

• First name

• Last name

• Patient ID

This will populate the MRN in Xper Information Management System. Date of birth, height, 
and weight can be added at a later time.

NOTE
The Xper Information Management System Workstation requires configuration in order to use 
the Admit from Allura function. For assistance in configuring your workstation, contact 
Customer Support.

3.1.7  Allura – Xper Information Management System Patient Mismatch

When a study selected on the Allura system does not match the study opened in Xper 
Information Management System, you will receive a notification at the bottom of the Case 
Details screen:

“[Patient Name] ALLURA-CIS PATIENT MISMATCH!”

If you receive this notification, you should verify that the correct patient study is selected on 
each station, Allura and Xper Information Management System, before proceeding. You should 
receive this notification only if the patient has been admitted on each system independently. If 
you are admitting a study from Allura to Xper Information Management System, you should 
not receive this notification, as the patient data should match up automatically.

3.1.8  Pre-admission to Waiting List

You can manually pre-admit patients to a Waiting List, or you can pre-admit patients through 
your ADT interface. Patients who have been pre-admitted can be placed on the schedule, or 
can be admitted directly from the Waiting List when they arrive for their procedures.

To pre-admit a patient manually, 

1 Click ADMIT > PRE-ADMIT > MANUAL PRE-ADMIT to open a blank Case Details screen. 

2 Type any demographic and lab data (minimum required is first and last names and medical 
record number).

3 If known, type the scheduled Procedure Date.

4 Click Pre-Admit Case.

5 Click Cancel to abort the operation.
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To pre-admit a patient from the ADT interface:

1 Click ADMIT > PRE-ADMIT > PRE-ADMIT ADT to open the Search Patient Admissions 
screen. 

You have the option to search for patients based on MRN (medical record number), SSN 
(social security number), Account Number, Accession Number, Last Name, or DOB (date of 
birth).

2 Select the search method; then type the data to search for in the Input Patient Identifier 
field. 

3 Click Search to begin searching through the current hospital admissions for your patient.

The application will return a list of matching patients.

4 Double-click on the patient you want to pre-admit to open a Case Details screen that will 
contain as much information as is available from the ADT interface. 

5 Complete the remaining fields manually or by using data scrapers.

6 Click Pre-Admit Case.

7 Click Cancel to abort the operation.

After pre-admitting, you may chart the patient’s pertinent history, import historical arterial 
trees, add the physician and referring physician, the scheduled procedures, or enter any other 
data you may have. You cannot initiate monitoring, record pressures, vitals or full disclosure.

Pre-admitted patients will be available on the Waiting List tab in the Study Scheduler (see 
“Scheduling” on page 61). There is also a Waiting List pane that can be incorporated into user 
roles in the Portal Designer (see “User-Centric Navigation” on page 78).

When the patient arrives for the procedure, you can double-click on the patient in the Waiting 
List, or right-click on the event in the Study Scheduler and select Admit. When the case opens, 
click Start Case and proceed normally.

Click the SWITCH button to be able to view the monitoring screen.

To pre-admit a patient from the Study Scheduler:

1 Click on the Pre-Admit tab.

2 Type the desired search criteria and click Search Now.

3 Double-click on the historical case you want to use for pre-admission. A new Case Details 
screen, populated with available data from the historical case, will open.

After pre-admitting, you may:

• Chart the patient’s pertinent history

• Import historical arterial trees

• Add the physician and referring physician

• Add the scheduled procedures

• Enter any other data you may have. 
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You cannot initiate monitoring, record pressures, vitals or full disclosure. If the historical 
case contained any post-procedure arterial trees (see “Arterial Trees” on page 48), the 
trees will automatically be transferred to the new study and be marked as Pre-Procedure. 

After you have entered data:

1 Close the study to place it on the Waiting List. 

2 Click on the Waiting List tab and then click Refresh to update the list with the new entry.

If your search returns no results, Manual Pre-Admit and Pre-Admit from ADT become active, 
allowing you to pre-admit your study using one of those methods.

3.1.9  Readmit

New studies may be created for patients who were previously admitted into Xper Information 
Management System by using the Study Readmit function. This function is most frequently 
used to create a new interventional study for a current patient who has undergone a 
diagnostic procedure, but whose intervention will be performed by a different physician; 
however, any patient may be readmitted. To readmit a patient:

1 Click HEMODYNAMICS > CASE TOOLS > STUDY READMIT.

You will be prompted to close the current case and readmit for a new procedure.

2 Select the INCLUDE LABS and/or INCLUDE STAFF check boxes if you want the lab results 
and staff from the currently opened case to populate the new case.

3 Select the PRE-ADMIT check box if you want to admit the study to the Waiting List (see 
“Pre-admission to Waiting List” on page 25).

4 Click OK to continue, or Cancel to abort the operation.

If you click OK, you will be prompted to print a case report. 

5 Select a report configuration and print option, and click OK to continue, or click Cancel to 
skip printing and proceed with the readmit procedure.

The current case closes, and a new study opens. If you chose to include labs or staff, that 
data will be present in the new study. Any menus that were designated as History (see 
“Building and Editing Menus” on page 112) are populated with the charting done in the 
previous study.

6 If you have chosen to admit the study to the Waiting List, you can type any additional data 
and close the study, which will then appear on the Waiting List.

3.1.10  Patient Status Viewer

The Patient Status Viewer is an optional feature that displays a patient’s location and 
procedure status (to configure status messages, see “Case Status” on page 125), and can also 
display optional messages about a patient or procedure. 
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1 To update a patient’s status to the Patient Status Viewer, click the Status tab on the Case 
Details screen. The controls and descriptions of their functions are listed in the following 
table.

The Patient Status Viewer contains four sections: 

• Pre-procedure Holding

• Procedure Room

• Post-Procedure Holding

• Message Board

You can update the status of a patient so that family and Holding Area staff can keep track of 
the patient’s location.

Note
Only the first three letters of the patient’s surname and the first letter, followed by three 
asterisks, of the first name are displayed, protecting the patients’ identity.

To update the status of a procedure:

1 Double-click a status message from the Update Case Status list. 

The patient’s status will be displayed in the appropriate window on the Patient Status 
Viewer, and in the Current Status window on the screen. 

2 Select the appropriate patient status.

The available status selections are: 

• Patient In

Control Function

Case Status window Displays all posted status messages and the time each message was sent 
to the Patient Status Viewer.

Clear Clears the message board window.

Display for The length of time (in seconds) that a message will be displayed on the 
selected Patient Status Viewer.

Message Board window Type message text to post to the Patient Status Viewer message center.

Send Sends the message to the selected Patient Status Viewer.

Timestamp Allows a user to edit the time stamp of a message to be sent to the 
Patient Status Viewer.

Update Case Status To Allows a user to select a procedure status message to post to the 
Patient Status Viewer.

Patient Status Viewer Allows a user to send a message to a specific Patient Status Viewer 
location.

Remove from Whiteboards Allows a user to remove the Case Status set to the whiteboard.

WhiteBoard Allows a user to send a message to a specific Patient Status Viewer 
location.
Xper Information Management System 2.3  Instructions for Use 4522 170 25991



Operation Document Scanning   29 

P
h

ili
p

s 
H

e
al

th
ca

re
• Patient Ready

• Procedure Begin

• Procedure End

• Patient Out

You can also build scrapers that will automatically send status messages to the Patient Status 
Viewer when certain data is charted. For more information, see “Data Scrapers” on page 63.

You may also post a message to the Patient Status Viewer (e.g., asking family members to 
report to a conference room, requesting the next patient be brought to the procedure room, 
etc.). 

To post a message to the Patient Status Viewer:

1 Type the message you wish displayed in the Message Board window.

2 Select the appropriate Patient Status Viewer on which you want it to display.

3 Select a length of time for the message to be displayed.

4 If you wish, change the time/date of the message.

NOTE
If you click Send without changing the time/date of the message, the stamp will set to the 
current time and date. To clear the message window, click Clear.

5 Click Send.

The message will be displayed on the selected Patient Status Viewer for the length of time 
you specified. 

To remove a patient from the Patient Status Viewer: 

• Click Remove from Whiteboard on the Case Status screen.

3.2  Document Scanning

Xper Information Management System Workstations support the scanning of external 
documents (history and physical, reports from previous studies, etc.) into a patient record in 
PDF format through a USB document scanner. 

Recommended models:

• Canon CanoScan LiDE 35

• Fujitsu fi-6130

• Hewlett Packard ScanJet Professional 3000

• Hewlett Packard ScanJet N6010

• Visioneer Strobe XP 300

• Visioneer RoadWarrior 

To scan a document:
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1 Ensure that the scanner is attached and powered on.

2 Open the patient study to which the document will be scanned (if the study is already 
opened, skip this step).

3 From Hemodynamics, select Case Tools.

4 From the Case Tools menu, select Scan Documents and then Show User Interface to 
display the scanner interface dialog. 

This allows you to set options such as 2-sided, color, paper size, etc. (If you do not want to 
set any options, skip this step.)

5 Click Acquire to scan the document.

You may then save the document in one of two file formats: JPEG or PDF. To save the 
document as a PDF file:

1 Click Save as PDF.

2 If there are multiple pages to be included, press Ctrl and click on each page you want to 
select.

3 Rename the document, if desired.

4 Click OK. 

The document will be available for viewing as a PDF on the Documents tab.

To save the document as a JPEG file:

1 Set the desired compression (100 = no compression).

2 Click Save as JPEG. 

The document will now be available under HEMODYNAMICS > IMAGING > STILL FRAMES 
and may be included in transcription reports.

NOTE
Scanners must be connected to Xper Information Management System Workstations only.

3.3  Entering Procedural Data

3.3.1  Charting a Procedure

The application allows you to quickly and easily chart a procedure. Because you can create 

custom menus in the Menu Builder, you can ensure the accuracy and thoroughness of your 
patient records. Procedural charting is integrally connected to transcription and statistical 
reports, as well as other modules throughout the application. In addition, entries and 
modifications to charting are tracked, so that you can perform audits in the event 
discrepancies arise.

Once you have a study open, access the charting module by clicking HEMODYNAMICS > 
CHARTING. This opens the Charting Menus window.

The Charting Menus window consists of four sections:
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• Main Menus—charting is arranged into menus, or categories, such as History and 

Assessment, Complications, Findings, etc. The menu selection you see depends on the 
modality of the study you’re charting.

• Menu tree—these are the statements from which you chart your procedure.

• History—in this section, the actual charting of a procedure is displayed. As you chart 
statements, they appear here, along with information about who charted the 
information and whether modifications or deletions were made, when they were made, 
and who made them.

• Edit Entry—this window allows you to correct errors in charting, as well as permitting a 
user to type notes directly, rather than selecting from the menu entries.

3.3.2  Charting in Xper Information Management System

To chart:

1 Select a menu from the list on the left, and then point and click through the menu tree 
items on the right. 

• Menu items that have associated sub-level choices will be indicated by a + (plus sign). As 
you click on the item, the sub-levels will expand, allowing you to make your selection. 

• Once you have gone through all the levels, the finished statement appears in the History 
window, along with the time and date the line was charted and the user who charted it. 

• As you switch menus, the History window will refresh with items charted in the menu 
you select.

2 To make several entries from the same sub-list, press and hold the Shift key and click on 
the level you want to expand. 

• That level will then be marked with a padlock icon. It will remain expanded, allowing you 
to make additional selections without having to constantly click on the “parent” level in 
order to chart. 

• When you want to close the level, press and hold the Shift key and click on the 
padlocked item.

Some menu items have a variable entry tag associated with them. This means that keyboard 
entry is required to chart an item. 

For menu items that require an entry, click on a variable entry item. The Variable Item window 
will open, prompting you to enter the required data. 

Some variable items may have a unit type associated with them. The unit type for a specific 
item is set when the menu is created, but you can select a different unit type from the Unit 
Type drop-down list before clicking OK. Clicking Cancel closes the window without charting an 
entry.

Once you have entered the required data, you can click OK to save the data and move on to 
the next selection, or press Enter on the keyboard. You can use the keyboard to chart if you 
like, by typing the corresponding letter next to the item you want to chart (A, B, C, D…).
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Inventory items are also a special function in charting. Inventory items are marked with a 
special icon. When you click on a particular inventory item, a window opens containing a list of 
items belonging to that inventory category. You can select an item from the list, or you can use 
the barcode reader to scan the item into your procedure. You can filter the list by clicking into 
a field (e.g., Item Name) and typing a few characters.

Inventory items may also be entered by scanning their barcodes. To scan a single barcode, hit 
Ctrl+B on the keyboard. To scan multiple barcodes, hit Ctrl+D. Both methods open a window 
that allows you to scan the item barcode into your procedure, but if you hit Ctrl+B, the window 
closes automatically after scanning. If you hit Ctrl+D, the window remains open until you click 
the X to close it.

In addition, if an item has been marked as Implantable (see “Inventory Maintenance” on 
page 91), upon scanning the item barcode, depending on the type of barcode, you will be 
prompted to enter the lot number, serial number, and expiration date of the item. If your item 
has a separate barcode containing these attributes, you can scan the attribute barcode into 
the Attribute Bar Code field, and the information is automatically charted, as well (see 
“Inventory Overview” on page 87).

If the expiration date of the implantable item you have charted has expired, you will receive a 
prompt to verify the expiration date. You will be prompted to confirm the date. If the item has 
expired, click Yes to cancel the charting. If the item has not expired, or if you want to chart it 
anyway, click No.

If an inventory item must be credited to the patient’s account, click the item, then click Credit. 
The item is marked as credited, it is not billed, but it is decremented from inventory. Similarly, 
if an item has been wasted, click the item, then click Waste. The item is marked as wasted and 
it is not billed, but it is decremented from inventory.

You can duplicate a charted entry by clicking on the entry, then clicking Re-chart. The line is 
charted again into the menu, but with the current date/time. It is also marked with a 
RECHARTED icon. If you rechart an inventory item, it is marked REUSED, it is not deducted from 
inventory, and no charge is generated. It is assumed that the same item is being reused.

Charting kits allow you to chart multiple items with one click (see “Kit Builder” on page 107 
and “Menu Builder” on page 111). To chart a kit, simply click on the kit name in your menu. 
The items associated with the kit are inserted into the procedure record. Any inventory items 
included in a kit are automatically decremented, and if there are charges associated with 
them, the patient is billed. Procedures associated with a kit appear on the Case Details screen.

Once entries have been charted, you may find it necessary to make changes or additions to the 
text, or you may want to enter a note (free text) into the procedure log. The Edit Entry section 
lets you do both.

To edit a previously charted item, simply double-click on the line in the History section, make 
the necessary changes, and click Confirm. The newly edited line appears in the History section. 
The previously charted item remains in the History section, but it is struck through and marked 
“Modified.” The edited item has the same time and date stamp as the modified item to 
preserve the procedural flow, but a notation appears with the time and date of modification, 
along with the user who performed the modification.
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To enter a free text item, click Free Text. Click into the Edit Entry window, type your note, and 
click Chart to enter the note into the procedure log. Free text entries are marked with a 
^FreeText^ tag at the end of the line.

The Given By marker enables you to mark any line with the name of a staff person or physician 
who participated in the procedure. Its intended use is for medication administration, but you 
can mark any charted item with the Given By tag. It is important to remember that only staff 
and physicians who appear on the Case Details screen are available in the drop-down list, so if 
you do not see the person whose name you are searching for, you have to add it in the 
Resources list.

You may hide deleted and modified entries in the charting history by checking the “Hide 
Deleted Entries” or “Hide Modified Entries.”

3.3.3  Charting in Xper Information Management System with Epic Cupid data

With the Epic Cupid to Xper Information Management System interface, data charted in Epic 
Cupid becomes available for clinical, procedural, registry and statistical reporting in Xper 
Information Management System. The intent is to streamline the workflow by preventing 
duplicate entry of information and associated potential information entry errors.

The intended users of this workflow are the Cath Lab nurses or monitors that log the patient 
medication, staff in/out times and events. 

Cases are synchronized between Epic Cupid and Xper Information Management System.

The following data elements charted in Epic for a case are imported into Xper Information 
Management System for that same case:

• Medications

• Staff in/out times

• Events

Epic Cupid has triggers to send a message stream with the above data – such as “log complete” 
and “log addendum”.

Upon importing of the data elements from the incoming message stream into Xper 
Information Management System’s Charting module (see “Menu Builder” on page 111), the 
data becomes integral part of Xper Information Management System’s structured data readily 
available for:

• reporting

• scraping 

• querying 

The most recent incoming message stream for a case always contains all the data elements 
(not just the delta) and replaces any previously imported data. The case must be open(ed) in 
Xper Information Management System to process updates from Epic into the case’s charting 
module in Xper Information Management System.
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To access the Epic Cupid patient’s data, click HEMODYNAMICS > CHARTING and select from the 
main menus one of the Epic’s options: Medications, Staff and Events.

NOTE

The menus information is recorded through the Charting Menu, from where it is available to 
be accessed via scraper. This information does not generate user registration such as Case 
Resources. So, in order to sign a document or finalize a study, the user must be manually 
assigned (see “User Administration” on page 82).

Medications

This information is composed by the definition previously configured on the XML Integration 
screen for the Menu Attribute EPIC Medications.

On the following example, the information was imported containing: prefix “Meds” 
medication name, dose, route, dose unit, 'given by' first name, 'given by' last name, 'ordered 
by' first name and 'ordered by', last name and the suffix “^EPIC^”.

The Date Stamp column shows the date and time as configured on the XML Integration screen. 
If this information was not configured or if the XML file does not have this information, the 
date and time when the XML file was imported is shown. 

NOTE
The medication entry can have duplicated entries if there is more than one administration per 
medication. In that case, information that is not related to the administration repeats as many 
times as there is administration information.

Staff

This information is composed by the definition previously configured on the XML Integration 
screen for the Menu Attribute EPIC Staff.

On the following example, the information was imported containing: prefix “Staff:”, role, last 
name, first name, the date time in or date time out, and the suffix “^EPIC^”.

The Date Stamp column shows the date and time as configured on the XML Integration screen. 
If this information was not configured or if the XML file does not have this information, the 
date and time when the XML file was imported is shown.
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NOTE
The staff entry may have duplicated entries if there is more than one active time per staff 
member. In that case, the staff information repeats as many times as there is active time 
information.

Events

This information is composed by the definition configured on the XML Integration screen for 
the Menu Attribute EPIC Events.

On the following example, the information was imported containing: prefix “Event:”, Epic 
Event description, date and time and the suffix “^EPIC^”. 

The Date Stamp column shows the date and time as configured on the XML Integration screen. 
If this information was not configured or if the XML file does not have this information, the 
date and time when the XML file was imported is shown.

3.3.4  Charting in the Patient Care Console

The Xper Flex Cardio Physiomonitoring Patient Care Console (FC2020) is a single display 
system, which means that physiomonitoring and procedural charting are displayed side by side 
on the same monitor. When you click on a menu, you see the same tree view and chart and 
edit the procedure just as you would on a Physiomonitoring 5 system.

3.3.5  Lesion Markers

Lesion markers (L1L9) are indicators that flag a charted entry for use by scrapers to transfer 
data from charting to the ACC and ICD data collection screens, or to a transcription report. You 
may manually mark any charted entry by right-clicking on the entry and selecting the desired 
lesion number from the marker list. The marker appears in French brackets at the end of the 
charted item (e.g., {L1}, {L2}, etc.).

You may apply multiple lesion markers to a charted entry, or remove a marker from an entry in 
the same way. To add additional markers, right-click the entry, then select the additional 
marker to be added. To remove a marker, right-click the entry and select the marker you want 
to remove.

In Lesion menus, you may activate a function called Auto Lesion Numbering, which 
automatically attaches a lesion marker to each entry as you chart. To activate Auto Lesion 
Numbering in a menu with the Lesion attribute:

1 Click Auto Lesion #.

2 Select the marker you want to use (L1L9).

3 Click OK.
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As you chart, each entry in the menu is marked with the designated lesion number. The button 
label indicates the selected marker (e.g., AUTO LESION {L1}). To disable lesion marking, click 
the button Auto Lesion #, select OFF, and click OK.

NOTE
Auto lesion marking is available only in menus that have the Lesion attribute assigned. In 
menus that do not have the attribute, the Auto Lesion # button is disabled. For more 
information, see “Building and Editing Menus” on page 112.

3.3.6  Procedure Log

The procedure log is the chronological report of your charted items from all menus. As you 
add, modify and delete entries in charting, the log is automatically updated so that you have a 
concise report that you can refer to at any time. To view the procedure log during a study, click 
HEMODYNAMICS > PROCEDURE LOG. 

The procedure log can help you move quickly to a charted item you need to modify or delete. 
Simply double-click the entry in the log, and the application opens the menu in which that 
item was charted. You can choose to display any recorded vitals in the log by clicking the Show 
Vitals check box.

The procedure log can be digitally signed at the end of a procedure. To sign a procedure log:

1 Click Sign.

2 Enter your user name and signature password.

3 Click OK.

When the procedure log is printed, the name and title of the person signing appears at the end 
of the log, as well as the time and date the signature was applied.

NOTE
The procedure log may be signed by up to ten (10) users. The digital signature appears in the 
log at the time the signature was applied, and at the end of the printed report.

You have the option to include the Given By and Entered By information on the procedure log 
printout. For assistance with activating these features, please contact Customer Support.

3.3.7  Changing Users During a Procedure

During a procedure, it is possible that the person recording the study may be relieved by 
another staff member. To change the logged in user during a procedure, click on the user name 
in the lower right corner of the screen. A Change User window appears, allowing the next user 
to enter a username and password without closing the case. Monitoring, vitals capture and full 
disclosure recording continue without interruption. You may change users during a procedure 
as often as is necessary.
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3.3.8  Locking a Case

A case may be temporarily locked to protect case data integrity, in the event that a user must 
step away from the computer. To lock a case, click on the user name in the lower right corner 
of the screen and click Lock. The case locks. No charting or editing may be performed while a 
case is locked, although monitoring, vitals capture and full disclosure recording continue. To 
unlock a case, enter your user name and password and click Unlock. You will then be able to 
proceed normally. You may also use this process to change users during a procedure, if you are 
relieving a fellow staff member.

3.4  Hemodynamics Screen

The Hemodynamics screen contains all the invasive pressure and cardiac output data that is 
collected during a procedure. The collected data is used to perform calculations, such as 
vascular resistance, intracardiac shunting, and valve stenosis. The calculations are performed 
automatically as samples are captured, and is recalculated when you edit samples using the 
Waveform Review screen. You also enter oxygen saturation data into the Hemodynamics 
screen.

Hemodynamics screens correspond to monitoring conditions. When you record an initial 
pressure sample in a condition on the monitoring screen, a hemodynamics screen is created to 
match that condition. Any data from subsequent samples taken in that condition is recorded 
on the corresponding hemodynamics screen.

The hemodynamics screen is divided into several sections to organize the data:

• General controls,

• Ventricular data,

• Valve data table,

• Cardiac outputs,

• Oxygen uptake data,

• Heart diagrams and oxygen saturations,

• Hemodynamic data tables and controls,

• Vascular resistance data, and

• Oxygen content data.

The fields and their functions are specified in the following tables:

Ventricular Data

Field Description

LV Dias Left ventricular diastolic volume calculated by image analysis.

LV EF% Left ventricular ejection fraction.

LV RF% Left ventricular regurgitant fraction.

LV Syst Left ventricular systolic volume calculated by image analysis.
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RV Dias Right ventricular diastolic volume calculated by image analysis.

RV EF% Right ventricular ejection fraction.

RV Syst Right ventricular systolic volume calculated by image analysis.

Note: See “Hemodynamic and Lab Value Conversion Calculations” on page 158 for formulas used in 
calculations.

Valve Data

Field Description

Aortic b/m Heart rate used in calculating aortic valve data.

Aortic cm2 Aortic valve area (in cm2).

Aortic ind Aortic valve index.

Aortic mn Mean aortic valve gradient.

Aortic ms Interval in milliseconds that the aortic valve was open.

Aortic note Accepts limited user entry.

Aortic p-p Peak to peak aortic valve gradient.

Mitral b/m Heart rate used in calculating mitral valve data.

Mitral cm2 Mitral valve area (in cm2).

Mitral ind Mitral valve index.

Mitral mn Mean mitral valve gradient.

Mitral ms Interval in milliseconds that the mitral valve was open.

Mitral note Accepts limited user entry.

Mitral p-p Peak to peak mitral valve gradient.

Other b/m Heart rate used in calculating other gradients.

Other cm2 Other area (in cm2).

Other ind Other index.

Other mn Mean other gradient.

Other ms Interval in milliseconds.

Other note Accepts limited user entry.

Other p-p* Peak to peak other gradient.

Pulmonic b/m Heart rate used in calculating pulmonic valve data.

Pulmonic cm2 Pulmonic valve area (in cm2).

Pulmonic ind Pulmonic valve index.

Pulmonic mn Mean pulmonic valve gradient.

Pulmonic ms Interval in milliseconds that the pulmonic valve was open.

Ventricular Data

Field Description
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NOTE
“Other” refers to gradients calculated from sites other than valves, such as femoral 
compensation. Some fields may not be completed if data is not appropriate.

Pulmonic note Accepts limited user entry.

Pulmonic p-p Peak to peak pulmonic valve gradient.

Tricuspid b/m Heart rate used in calculating tricuspid valve data.

Tricuspid cm2 Tricuspid valve area (in cm2).

Tricuspid ind Tricuspid valve index.

Tricuspid mn Mean tricuspid valve gradient.

Tricuspid ms Interval in milliseconds that the tricuspid valve was open.

Tricuspid note Accepts limited user entry.

Tricuspid p-p Peak to peak tricuspid valve gradient.

Note: See “Hemodynamic and Lab Value Conversion Calculations” on page 158 for formulas used in 
calculations.

Cardiac Outputs

Field Description

(blank) Cardiac output calculation method may be entered by the operator.

Angio CI Cardiac index calculated from angiography.

Angio CO Cardiac output calculated from angiography.

Angio SV Stroke volume calculated from angiography.

CI Cardiac index may be entered by the operator.

CO Cardiac output may be entered by the operator.

Fick CI Cardiac index calculated using the Fick method.

Fick CO Cardiac output calculated using the Fick method.

Fick SV Stroke volume calculated using the Fick method.

SV Stroke volume may be entered by the operator.

Thermal CI Cardiac index calculated using thermodilution.

Thermal CO Cardiac output calculated using thermodilution.

Thermal SV Stroke volume calculated using thermodilution.

Note: See “Hemodynamic and Lab Value Conversion Calculations” on page 158 for formulas used in 
calculations.

Valve Data

Field Description
4522 170 25991 Xper Information Management System 2.3  Instructions for Use



40  Hemodynamics Screen Operation

P
h

ili
p

s 
H

e
al

th
ca

re
Oxygen Uptake Data

Field Description

Act O2 Actual oxygen consumption of the patient.

BSA Body surface area, populated from the Case Details screen.

Est O2 Estimated oxygen consumption of the patient.

Hgb (g/dl) Hemoglobin, populated from the Labs/Procedure Data screen.

Hgb (g/l) Hemoglobin in standard international units.

Hgb (mmol/l) Hemoglobin in millimoles per liter

KO2 A constant used to calculate estimated oxygen consumption. The default value is 
133.

L>R Shunt Left to right shunt flow (L/min).

L>R Shunt % Left to right shunt flow percentage.

LOAD button Used to load a constant value from the LaFarge table based on heart rate, age 
and gender of the patient (see “LaFarge Table” on page 166).

LR Threshold Operator-defined L>R shunt threshold

PV-PA (VA) Pulmonary O2 difference (ml/min).

PV-SV (VV) Venous O2 difference (ml/min).

Qe Effective flow (ml/L).

Qei Effective flow index.

Qp Pulmonary flow (ml/L).

Qp/Qs Pulmonary/systemic flow ratio.

Qpi Pulmonary flow index.

Qs Systemic flow (ml/L).

Qsi Systemic flow index.

R>L Shunt Right to left shunt flow (L/min).

R>L Shunt % Right to left shunt flow percentage.

RL Threshold Operator-defined R>L shunt threshold

SA-SV (AV) Systemic O2 difference (ml/min).

Note: See “Hemodynamic and Lab Value Conversion Calculations” on page 158 for formulas used in 
calculations.

Vascular Resistance Data

Field Description

PAm Mean The mean pressure used as pulmonary arterial pressure.

PAm Site Pressure sample used as pulmonary arterial pressure site.
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PVm Mean The mean pressure used as pulmonary venous pressure.

PVm Site Pressure sample used as pulmonary venous pressure site.

PVR Pulmonary vascular resistance

PVR/SVR Pulmonary/systemic vascular resistance ratio

PVRI Pulmonary vascular resistance index

SAm Mean The mean pressure used as systemic arterial pressure.

SAm Site Pressure sample used as systemic arterial pressure site.

SVm Mean The mean pressure used as systemic venous pressure.

SVm Site Pressure sample used as systemic venous pressure site.

SVR Systemic vascular resistance

SVRI Systemic vascular resistance index

TPVR Total pulmonary vascular resistance

TPVR/TSVR Total pulmonary/total systemic vascular resistance ratio

TPVRI Total pulmonary vascular resistance index

TSVR Total systemic vascular resistance

TSVRI Total systemic vascular resistance index

Use HRU When checked, calculates vascular resistance values in Woods hybrid 
resistance units. The default is Dynes units.

Note: See “Hemodynamic and Lab Value Conversion Calculations” on page 158 for formulas used in 
calculations.

Oxygen Content Data

Field Description

PA_O2 Hgb g/dl Hemoglobin, populated from the Case Details screen.

PA_O2 Hgb g/l Hemoglobin in standard international units.

PA_O2 O2 Pulmonary arterial oxygen content.

PA_O2 PO2 Partial pressure oxygen, entered by the operator

PA_O2 Sat Pulmonary arterial saturation value.

PA_O2 Site Site used for pulmonary arterial oxygen content calculation.

PV_O2 Hgb g/dl Hemoglobin, populated from the Case Details screen.

PV_O2 Hgb g/l Hemoglobin in standard international units.

PV_O2 O2 Pulmonary venous oxygen content.

PV_O2 PO2 Partial pressure oxygen, entered by the operator

PV_O2 Sat Pulmonary venous saturation value.

PV_O2 Site Site used for pulmonary venous oxygen content calculation.

Vascular Resistance Data

Field Description
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3.4.1  The Heart Diagram

In the center of the page, there is a heart diagram with data boxes located in each of the major 
vessels and chambers. There are 68 congenital anomaly diagrams in addition to the Normal 
Heart. You can select an alternate diagram by selecting it from the drop-down menu 
immediately above the heart diagram. 

The data boxes display either pressure data (mean/edp) or oxygen saturations. To control 
which type of data is displayed, click either the Saturation or Pressure tab located to the top 
right of the heart diagram. Pressure data are automatically populated from samples obtained 
during the case. 

Oxygen saturation data must be entered manually. To enter saturation data, click the box that 
represents the site from which the sample was obtained, enter the value with the keyboard 
and press Enter. You can also select sites from the drop-down list at the bottom left corner of 
the heart diagram. You can save multiple saturation values for each site by typing them in the 
(F4) Other Sat boxes located just below the heart diagram. You can average the values by 
affixing a number to each site to differentiate it from the others. For example:

1 Type RA1 in the first box, type a value of 50 in the second box, and then press Enter.

2 Do the same for RA2 (value 70) and RA3 (value 75).

Notice that each site and value is inserted in the Sample Display Window as soon as you press 
Enter, and an average value is calculated and placed at the top of the list.

The average value is also inserted in the appropriate site box in the heart diagram.

SA_O2 Hgb g/dl Hemoglobin, populated from the Case Details screen.

SA_O2 Hgb g/l Hemoglobin in standard international units.

SA_O2 O2 Systemic arterial oxygen content.

SA_O2 PO2 Partial pressure oxygen, entered by the operator

SA_O2 Sat Systemic arterial saturation value.

SA_O2 Site Site used for systemic arterial oxygen content calculation.

SV_O2 Hgb g/dl Hemoglobin, populated from the Case Details screen.

SV_O2 Hgb g/l Hemoglobin in standard international units.

SV_O2 O2 Systemic venous oxygen content.

SV_O2 PO2 Partial pressure oxygen, entered by the operator

SV_O2 Sat Systemic venous saturation value.

SV_O2 Site Site used for systemic venous oxygen content calculation.

Use Flamm’s for systemic 
venous

When checked, uses the Flamm formula for systemic venous calculation.

Note: See “Hemodynamic and Lab Value Conversion Calculations” on page 158 for formulas used in 
calculations.

Oxygen Content Data

Field Description
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You can also identify multiple sites in other ways (e.g., by location). If you took readings at the 
upper, middle, and lower portions of the right atrium, for example, you might identify the 
readings as high RA (HRA), mid RA (MRA), and low RA (LRA). As you enter them, the sites and 
values are inserted into the Sample Display Window, but they are not averaged. To average 
your values, you must use numbers. You must select a value to use for the main saturation 
value and enter it into the heart diagram site box.

Blood Gases Worksheet

The blood gases worksheet is used to enter complete blood gas data in addition to oxygen 
saturations. Open the worksheet by clicking the Blood Gases tab at the very bottom left corner 
of the Hemodynamics screen. To enter data:

1 Click Insert.

2 Choose the desired site from the drop-down list, and manually enter the data in the 
remaining fields. You do not have to select the time or date. This information will populate 
automatically when you save the data. You may enter it if desired.

3 Click OK to save or Cancel to abort.

To delete a blood gas sample, highlight it and click Delete.

If desired, you may dock the Blood Gases screen by clicking the push-pin icon in the upper 
right corner.

Sample Display Window

This window displays all manually entered oxygen saturation data, and all data obtained from 
the patient (pressures, thermal cardiac outputs, valve gradients, etc.). Only one data 
parameter is displayed at a time. Toggle between the data elements by clicking one of the tabs 
labeled Saturation, Pressure, Therm, Grads or FFR located above the data window. Each 
element is described in detail below.

NOTE
Definitions for all site abbreviations used with Xper Information Management System are 
listed in “Monitoring Site Abbreviation Definitions” on page 163.

Oxygen Saturation Data

• View data by clicking the Saturation tab.

• Saturations are entered manually as described above.

• To delete specific saturation values, click DEL, then select the value.

• To exclude specific saturation values from calculations click X, then select the value. A 
dash will replace site labels with excluded values.

• For calculation purposes, Xper Information Management System assigns specific 
saturation data to represent systemic arterial, systemic venous, pulmonary arterial, and 
pulmonary venous values. Algorithms are in place to ensure that the best match is made 
for each of the variables. You can override the assigned selections by clicking SA, SV, PA, 
or PV, then clicking on the sample you wish to assign to that variable.
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Invasive Pressure Data

• View data by clicking the Pressure tab.

• To view the waveforms used to derive pressure data, click the desired sample. This 
opens the waveform review screen on a separate tab.

• To delete specific pressure samples, click DEL, then select the value.

• To exclude specific pressure values from calculations click X, then select the value. A 
dash will replace site labels with excluded values.

• For calculation purposes, Xper Information Management System assigns specific 
saturation data to represent systemic arterial, systemic venous, pulmonary arterial, and 
pulmonary venous values. Algorithms are in place to ensure that the best match is made 
for each of the variables. You can override the assigned selections by clicking SA, SV, PA, 
or PV, then clicking on the sample you wish to assign to that variable.

Thermal Cardiac Output Data

• View data by clicking the Therm tab.

• To view the waveforms used to derive thermal cardiac output data, click the desired 
sample. This opens the waveform review screen on a separate tab.

• To delete specific thermal cardiac output samples, click DEL, then select the value.

Valve Gradient Data

• View data by clicking the Grad tab.

• To view the waveforms used to derive valve gradient data, click the desired sample. This 
opens the waveform review screen on a different tab.

• To delete a specific valve gradient, click DEL, then select the item.

• By default, the first gradient of each valve will print on the case report. To select a 
different valve gradient for the printed report, click Valve, then select the gradient. The 
data will be printed in the valve gradients section of the Hemodynamic Page.

FFR Data

• View data by clicking the FFR tab.

• To view the waveforms used to derive FFR data, click the desired sample. This opens the 
waveform review screen on a separate tab.

• To delete specific FFR samples, click DEL, then select the value.

Sample Display Window Function Controls

With the nine controls located at the top right corner of the Hemodynamics page, you can 
select samples in the display window for various operations. The controls and their functions 
are listed in the following table.

Control Description

DEL Deletes a selected hemodynamic value.
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Vascular Resistance

The vascular resistance section is located below the sample display window. It contains 
resistance values that are automatically populated as necessary data are entered or sampled 
during procedures (see “Hemodynamic and Lab Value Conversion Calculations” on page 158 
for calculation formulas). Site and mean pressure data are displayed for each of the variables 
(SA, SV, PA, and PV). For patients whose cardiac output data (thermal or Fick) are available, 
total resistance values are displayed in either Dynes (D/S, D/S/cm-5) or hybrid resistance 
(Woods) units. Check the HRU box if you want to use hybrid resistance. Leave it unchecked if 
you want to use D/S. 

O2 Content

The O2 content section is located at the bottom right of the screen. It contains oxygen-related 
values that are automatically populated as necessary data are entered or sampled during 
procedures (see “Hemodynamic and Lab Value Conversion Calculations” on page 158 for 
calculation formulas). For each of the variables (SA, SV, PA, and PV), the following information 
is displayed: site, saturation, hemoglobin, and oxygen content. PO2 data (from blood gas 
results) can be entered manually for each variable. If you would rather not use the 
automatically posted data assigned by Xper Information Management System, delete them by 
clicking X next to the respective item. Click the checkbox at the bottom of the section to 
calculate systemic venous from IVC and SVC samples using Flamm’s equation.

To enter specific saturation pressure location values, click the appropriate label across the top 
(SA, SV, PA, or PV), and click the desired value. The O2 content section updates with the 
selected value.

O2 Uptake, Differences, Flows, and Shunts

This section is located at the lower left portion of the screen. It contains several variables that 
are automatically populated as necessary data are entered or sampled during procedures (see 

PA Designates a selected pressure or oxygen saturation as a Pulmonary Arterial 
value to be used in calculations.

PV Designates a selected pressure or oxygen saturation as a Pulmonary Venous 
value to be used in calculations.

SA Designates a selected pressure or oxygen saturation as a Systemic Arterial value 
to be used in calculations.

SV Designates a selected pressure or oxygen saturation as a Systemic Venous value 
to be used in calculations.

T Indicates a hemodynamic value to be included in transcription (default is first 
recorded).

TM Allows a user to edit the time stamp of a selected sample.

Valve Allows a user to select a valve gradient to be used as the reported value (default 
is first calculated).

X Allows a user to select a hemodynamic value to be excluded from calculations.

Control Description
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“Hemodynamic and Lab Value Conversion Calculations” on page 158 for calculation formulas). 
The variables are described below.

K Variable

KO2 is used to calculate estimated oxygen consumption. The default value is 133. You may also 
load an alternate value from the LaFarge table, which bases the estimated oxygen 
consumption on the gender, age, and heart rate of the patient. To select a value from the 
LaFarge table (see “LaFarge Table” on page 166), click Load in the O2 Uptake section of the 
page. The correct value is inserted, based on your patient’s information.

Alternately, you may manually enter the desired value in the KO2 field, if your patient falls 
outside of the age range specified in the table.

Specify the O2 consumption field (Act or Est) used for calculations by clicking the appropriate 
box at the top right of the section. If your facility uses an oxygen consumption monitor, you 
can manually enter the actual oxygen consumption data into the Act O2 box.

BSA and Hgb Variables

BSA and Hgb are populated from the Case Details and Labs/Procedure Data screens.

SA-SV, PV-PA, and PV-SV Variables

These variables for O2 difference data are automatically populated (see “Hemodynamic and 
Lab Value Conversion Calculations” on page 158 for calculation formulas).

Qs, Qsi, Qp, Qpi, Qe, Qei, and Qp/Qs Variables

These variables for flow data are automatically populated (see “Hemodynamic and Lab Value 
Conversion Calculations” on page 158 for calculation formulas). The values will differ 
depending on whether estimated or actual oxygen consumption data are used, and whether 
Fick or thermal cardiac output data are used.

Shunt L>R and R>L Variables

Variables for shunts are automatically calculated only if Fick cardiac output data are available 
and a significant oxygen saturation step-up is present (see “Hemodynamic and Lab Value 
Conversion Calculations” on page 158 for calculation formulas). Shunt type (L>R and R>L) is 
defined. Blood flow across the shunt in liters per minute, as well as the total percentage of 
cardiac output, is displayed.

Cardiac Outputs

Located at the lower left-hand side of the screen, this section contains cardiac output values 
that are automatically populated as necessary data are entered or sampled during procedures 
(see “Hemodynamic and Lab Value Conversion Calculations” on page 158 for calculation 
formulas). For each of the variables (Fick, Thermal, Angiographic, and User-defined), stroke 
volume, cardiac output, and cardiac index data are displayed. Data displayed in other sections 
of the page are often influenced by the cardiac output data used during calculations. You can 
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control which calculation data are used by clicking the radio button next to the desired cardiac 
output value. The four cardiac output variables are described below.

Fick Variables

Fick cardiac output is calculated only if proper oxygen saturation data have been entered into 
the system. The Fick variable may be estimated or actual, based on which oxygen consumption 
field is activated.

Thermal Variables

Thermal cardiac output is a calculated average from all thermal samples performed during a 
procedure. As samples are added or deleted, the average will change accordingly.

Angiographic Variables

Angiographic cardiac output is calculated from ejection fraction functions in the Image 
Analysis module. It can also be calculated by manually entering diastolic and systolic volumes.

User-Defined Variables

User-defined cardiac output may contain data from devices such as green dye monitors. The 
data must be entered manually.

Valves

Located at the mid-left-hand side of the screen, this section contains valve-related values that 
are automatically populated as necessary data are entered or sampled during procedures (see 
“Hemodynamic and Lab Value Conversion Calculations” on page 158 for calculation formulas). 
For each of the valves (Aortic, Mitral, Pulmonic, Tricuspid, and Other) the following 
information is displayed: peak and mean gradient, filling period, heart rate, valve area, and 
valve index data. Valve area and index data will be populated only if cardiac output data are 
present. You can enter free text comments regarding each valve into the box labelled Note. If 
you would rather not use the automatically posted data for particular valves, delete them by 
clicking X under the respective item.

Ventricles

Located at the top left of the screen, this section contains ejection fraction-related values that 
can be manually populated by the system user based on data from the X-ray or Imaging 
functions system (see “Hemodynamic and Lab Value Conversion Calculations” on page 158 for 
calculation formulas). For each ventricle, the system displays diastolic and systolic volumes, 
ejection fraction percentages, and regurgitant fraction percentages.

Miscellaneous Controls

Miscellaneous controls and their functions are listed in the following table.

Control Description

- Delete Allows a user to delete a hemodynamic condition.
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3.4.2  Arterial Trees

The Arterial Trees module allows a physician to create a graphic representation of a patient’s 
cardiac or peripheral arterial anatomy. The arterial trees allow you to indicate areas of disease, 
collaterals and bypass grafts, interventions performed, and other diagnostic data, such as 
anatomical aberrations. The data from the tree is automatically placed in the appropriate 
charting menu and can be included in a report or queried at a later time. Operators may use 
the provided templates or replace any or all of them with a preferred set. The templates 
include:

• Right dominant coronary anatomy,

• Left dominant coronary anatomy,

• Co-dominant coronary anatomy,

• Upper peripheral arterial anatomy,

• Lower peripheral arterial anatomy,

• Brachial arterial anatomy,

• Pulmonary arterial anatomy,

• Renal anatomy, including the abdominal aorta and kidneys,

• Carotid arterial anatomy,

• Cranial arterial anatomy,

• Hepatic arterial anatomy, and

• Cardiac mapping for electrophysiology studies.

Creating an Arterial Tree

To create an arterial tree for a procedure, click on HEMODYNAMICS > ARTERIAL TREE > NEW, 
and select a template from the list. The selected template will be displayed. The Functions tab 
on the right contains the tools you will use to customize your tree.

If you place the mouse cursor over a vessel on the tree, you will notice that the vessel and 
segment labels (e.g., LAD Mid) appears at the bottom left of the screen. If you move the 
mouse cursor around the tree, the label will change as you pass over the different vessels and 
segments.

+ Add Allows a user to create a new hemodynamic condition.

< (Prev Condition) Navigates to the previous hemodynamic condition screen.

> (Next Condition) Navigates to the next available hemodynamic condition screen.

Condition drop-down list Allows a user to select a hemodynamic condition to display on screen.

Print Prints the current hemodynamic condition screen.

Update Refreshes the hemodynamic condition data.

Control Description
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To enter a lesion on the tree, simply click on the proximal starting point in the target vessel, 
then click again at the distal point, defining the length of the lesion within the vessel. You are 
then prompted to define the primary type of lesion and select a secondary type, if desired:

• Generic

• Diffuse

• Luminal irregularity

• Tubular

• Discrete

• Complex

• Thrombus

• Calcified

• Eccentric

• Aneurysmal

• In-stent restenosis

• Ectasia

There are also Unvisualized, Visualized, <A>, <B> and <C>. These are special types that will be 
described later.

Once you have selected a primary lesion type, and a secondary type, if desired, click OK. A 
graphical representation of the lesion appears at the point you selected. You will be prompted 
to adjust the amount of stenosis using the scrollbar on the Functions tab. Scroll up to increase 
the percentage of stenosis, or down to decrease. The inner set of arrows increase or decrease 
by increments of one (1). The outer arrows increase or decrease by increments of five (5). If 
you set the stenosis to 100%, the vessel and any branches distal to the lesion collapse. Click 
into the black area around the tree to set the lesion. Repeat the process as many times as is 
necessary.

The Unvisualized type is used to collapse a section of vessel when the type of lesion cannot be 
determined. The Visualized type is used to open a segment of vessel within a collapsed area. 
<A>, <B>, and <C> are lesion type designations required by the American College of Cardiology.

Once you have entered a lesion, you can indicate whether an intervention was performed or 
add notes using the Annotation Functions.

Annotation Functions

Control Description

Arrow Used to draw directional arrows from one point to another.

DA Indicates directional atherectomy performed on a lesion.

Note Used to create and place notes on a tree.

PTA Indicates a percutaneous transluminal angioplasty performed in a peripheral vessel.

PTCA Indicates a percutaneous transluminal coronary angioplasty performed on a lesion.

ROTA Indicates a rotablation performed in a vessel.
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To indicate that a vessel has no disease, click WNL and then click to position the WNL (within 
normal limits) marker on the tree.

To indicate that an angioplasty was performed on a lesion, click PTCA. You will be prompted 
first to click to position the note on the tree near the lesion. Next, use the scrollbar to adjust 
the residual stenosis (the default value is 0%). Last, you will be prompted to click into the area 
of stenosis to position an indicator arrow. Be sure that you click into the lesion, not into the 
area around it.

You will use the same process for the other types of intervention (DA, PTA, ROTA). If you are 
indicating a stent placement, you will be prompted to indicate the proximal and distal points of 
the stented segment after you have placed the arrow. When drawing overlapping stents, click 
the distal end of the second (and any subsequent stents) first, then click on the proximal end.

You may also want to place additional notes or arrows on a tree. To place a note, click Note. A 
window opens to allow you to enter text, then click OK. You will then be prompted to click into 
the tree to position the text. Be careful not to place the text where it obscures vessels or other 
notes.

To create a directional arrow, click Arrow. Click in the tree to indicate the starting point, then 
click to indicate where you want the arrow to point.

Editing an Arterial Tree

There are a number of tools that can be used to edit an arterial tree so that you can more 
closely approximate a patient’s anatomy. You can add vessels, delete vessels, change the 
diameter or location, or redraw existing vessels to demonstrate length or tortuosity. The 
editing controls and their functions are listed in the following table:

Scrollbar Allows the operator to adjust the percentage of stenosis, or the diameter of a vessel 
(see text on changing vessel size on page 52).

STENT Indicates a stent placement in a vessel.

WNL Marks a vessel as being within normal limits.

Procedure Status

Control Description

Copy Allows the operator to copy the pre-procedure tree to post-procedure status.

None Default status for arterial trees.

Post-Procedure Designates an arterial tree as post-procedure.

Pre-Procedure Designates an arterial tree as pre-procedure.

Annotation Functions

Control Description
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Tree Editing Functions

Control Description

ACC Lesion # Allows the operator to assign a number to a lesion when reporting to the 
American College of Cardiology.

Art Label Allows the operator to change the display label (top right corner) of a vessel.

Cusp Structure Used when creating new templates to draw non-artery structures, such as the 
aortic cusp or kidneys.

Delete Used to delete vessels, grafts, collaterals, and notes.

Lesion Side Allows the operator to switch an eccentric lesion from one side of a vessel to 
another.

Termination Used when creating an arterial template.

Undo Allows the operator to undo the previous ten (10) operations.

Vessel Size Allows the operator to adjust the diameter of a vessel.

Move Functions

Control Description

Move Artery Allows the operator to change the location of a vessel.

Move Lesion Allows the operator to change the location of a lesion.

Move Note Allows the operator to change the location of a note.

Vessel Functions

Control Description

Collateral Used to draw collateral vessels on a tree.

Graft Used to draw bypass grafts on a tree.

Position Used to change the position markers (proximal, mid, or distal) within a vessel.

Seq Graft Used to draw sequential grafts on a tree.

Vessel Artery Used to insert arteries into a template or tree.

Y Graft Used to draw Y grafts on a tree.

Tree Functions

Control Description

Menu Opens the designated coronary or peripheral menu (see “Building and Editing 
Menus” on page 112)
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To add a vessel, click Vessel Artery. You will be presented with a list of vessels appropriate to 
the type of arterial tree you selected. Coronary trees have a list of coronary vessels, while the 
peripheral trees have the appropriate list of vessels for that system. Choose the type of vessel 
you wish to draw, or type in your own label and click OK. You are then prompted to click on the 
point of origin of the new vessel. Draw the path of the new vessel, then click on the end point 
to complete the drawing.

NOTE
When drawing any object (i.e., vessel, graft, arrow, etc.), do not hold down the mouse button. 
Click once and release, draw the path of the vessel or object, and click a second time to 
complete the process.

To delete a vessel, lesion or note, click Delete, then click on the object you wish to delete. If 
you wish to delete a note, click on the first character of the text.

The Undo control reverses up to ten (10) previously performed functions, such as drawing 
lesions or grafts, moving vessels, or adding notes.

You may increase or decrease the diameter of a vessel by clicking Vessel Size. You will be 
prompted to select the vessel you wish to change, then use the scrollbar to increase or 
decrease the diameter.

NOTE
If you wish to change the length or tortuosity of a vessel, you must delete it before redrawing 
it.

An eccentric lesion extends from the right or left side of a vessel. If you draw an eccentric 
lesion in a vessel and wish to switch it to the opposite side, click Lesion Side, then click on the 
lesion you wish to change.

You may move an artery, note or lesion to a different location on the tree. To move an artery, 
click Move Artery. Click on the artery you wish to move, then click on the position from which 
the vessel should originate. To move a lesion, click Move Lesion, select the lesion, and click on 
the new location within a vessel or graft. 

Notes are the white text on a tree. They can be vessel labels or annotation added by a 
physician. To move a note, click Move Note. Click on the first character of the note you wish to 
move, then click on the new location. Be careful not to move a note to a location that obscures 
a vessel or lesion, or another note.

The vessel label is the green text that appears in the top right corner when you move your 
mouse cursor over the tree. You may change the vessel label by clicking Artery Label. Click the 
vessel you wish to relabel, then select from the list or type in a new description and click the 
vessel. Move your mouse cursor over the vessel to confirm the change.

Print Tree Prints the displayed tree.

Tree Functions

Control Description
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You may indicate bypass grafts and collaterals on the tree. To add a graft, click Graft on the 
Functions tab. Click once at the start of the graft (do NOT hold down the mouse button), drag 
the mouse to the other end of the graft, and click a second time. The starting point determines 
the type of graft drawn. If you begin drawing your graft inside the aortic structure, Xper 
Information Management System labels it as a saphenous vein graft (SVG). If you begin 
drawing your graft in the black area to the right of the aorta, you get a LIMA (left internal 
mammary artery) graft, and if you begin drawing to the left of the aorta, you get a RIMA (right 
internal mammary artery graft). If you are using a template other than the coronary anatomy, 
the graft is labelled simply as “Graft.” Once you have placed a graft, you can pass your mouse 
cursor over it to see the label.

There are two other types of grafts you may include on an arterial tree, sequential grafts, and 
Y-grafts. To draw a sequential graft, click Seq Graft and draw the first segment from the aorta 
to the target vessel. Click Seq Graft a second time, and draw the second segment from the 
exact point of termination of the first segment to the second target vessel.

To draw a Y graft, click Y Graft and draw the first segment from the aorta to the target vessel. 
Click Y Graft a second time and draw the second segment from any point on the first segment 
to the second target vessel.

NOTE
Always make sure that any graft terminates inside the lines of a vessel.

Drawing collaterals is similar to drawing a graft. Click Collateral, then click at the starting point 
within a vessel. Draw a line in the direction of the flow to the end point and click a second 
time. Collaterals must begin and, like grafts, terminate within the lines of a vessel.

Pre- and Post-Procedure Trees

You may choose to show your pre-procedure findings and post-procedure results as separate 
trees. To create a pre-procedure tree, select a template as usual. When the diagram opens, 
select PRE-PROCEDURE from the upper right, then proceed to place lesions and other findings.

When you are ready to create your post-procedure tree, click Copy. You will be prompted to 
copy the pre-procedure tree to a new diagram. Click Yes to continue. A new copy of the tree 
will appear, designated POST-PROCEDURE, containing all the data you had already inserted 
onto the pre-procedure tree. You may now indicate intervention results, such as stent or 
directional atherectomy, on the post-procedure diagram.

Historical Tree

The Historical Tree function allows a user to import an arterial tree from a previous study in 
Xper Information Management System. Click HEMODYNAMICS > ARTERIAL TREE > 
HISTORICAL. A list of trees created in the patient’s previous studies will be presented. The user 
may select from the list and import, then proceed to update the tree with new findings.
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3.4.3  Patient Charges

Patient Charges can be accessed from within a case. The billing code is automatically inserted 
when the procedure is added on the ID Screen but you must manually add a modifier.

1 From the Hemodynamics menu, select Case Tools, then select Patient Charges.

2 Click on the ellipsis (three-dot) (...) button in the Mod column for the procedure you want 
to work with. A list of Procedural Modifiers will open.

3 Select the check boxes for modifiers you want to add and click OK.

4 Click Preview to view the list of patient charges, or click Print to print it.

NOTE
If a charge has been processed, you can also Credit or delete the charge from this screen.

3.4.4  Custom Forms

To utilize custom forms during a study, click Screens and select the form you wish to complete 
(see “Custom Forms” on page 119 for information on creating and deploying custom form). 
You may enter the data manually, or you may create scrapers (see “Data Scrapers” on page 63) 
that will populate the fields automatically as you chart.

During review of a custom form, you may chart additional data that can be scraped to the 
form. In order to activate the scrapers, click Refresh at the top of the custom forms screen to 
pull additional data or to update the form with any changes you have made in charting.

To print the actual custom form as it appears on the screen, click Print Form. Clicking Print 
Data will print the fields and data that appear on the form. The data format can be included in 
case report configurations (see “Case Report Configuration” on page 140).

3.4.5  Transcription

To access the Transcription module, click HEMODYNAMICS > TRANSCRIPTION. To create a 
report, select the template from the Templates drop-down list on the Transcription toolbar 
and click Add. The new template will be completed, as well, using data elements from charting 
and hemodynamic sampling.

You may create multiple revisions of any report. After you have selected a template and the 
available data has been filled in, you may make changes to the report, then click Save to 
update the revision. The most current revision will then be available on the History tab for 
review and corrections by you or another user. To update a saved draft, click the Edit link next 
to the current revision on the History tab, make changes on the Editor tab and click Save.

To review a report, select the Preview/Print tab.

To cancel a draft, click Cancel on the Transcription toolbar while on the Editor or Preview/Print 
screen.
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NOTE
You can only cancel a draft. After a report has been signed, it cannot be canceled and must be 
amended.

To electronically sign a report, click SIGN on the Transcription toolbar, then enter your 
username and signature password. This will create a PDF of the report that will be available for 
viewing and printing on the Documents tab, and will be sent through the Results interface, if 
you have one. If your interface requires a transcription type, select the appropriate type from 
the Transcription Type drop-down menu. After a report has been signed, you may create an 
amended report by clicking the AMEND link next to the signed report on the History tab.

NOTE
A user must be assigned as a resource on a study in order to sign a document or finalize a 
study, unless the user account is set for Transcription Signature Override. See “User 
Administration” on page 82 for more information.

When all reports are complete, you can change the status of the case to Finalized and lock the 
signed transcription documents. Click HEMODYNAMICS > CASE TOOLS > FINALIZE STUDY. You 
will be prompted to enter your username and signature password. If there are transcription 
drafts that have not been signed, Xper Information Management System displays a message 
requesting that you sign all unsigned documents prior to finalizing. After clicking OK, the Case 
Finalized flag will be set on the Case Details screen. The study will no longer appear in the 
Unread Studies pane, but will be listed under Finalized Studies.

3.5  Image Review

Xper Information Management System uses Philips Xcelera for image review and frame 
capture. Xcelera is a standalone application with its own Instructions for Use. Consequently 
this chapter will describe only the procedures needed to open cases in the imaging program 
and to import still frames for inclusion in transcription reports. For other X-ray Angiography 
related functions, such as quantitative coronary analysis or left ventricular analysis, you must 
refer to the imaging product user’s guide and/or the Xcelera Instructions for Use.

To display cine runs or still frames in Xcelera, click HEMODYNAMICS > IMAGING >VIEW 
IMAGING. Xcelera opens and displays the available images for the study. To capture still 
frames, pause the cine run, then click and drag the image to the image folder in the lower left 
hand corner of the screen. 

Right-click on each image and select “Make available to CIS” to import the images one by one. 
Alternatively, click anywhere in the black area of the image folder, right click and select “Make 
available to CIS” to import all the images in the image folder at once. When you are finished, 
click the X icon to close Xcelera. The captured still frames may be included in a transcription 
report.

To view still frames for a study, click HEMODYNAMICS > IMAGING > STILL FRAMES. Any stills 
captured in Xcelera are displayed.
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WARNING
The image viewing screen provides some basic functions, such as contrast level, brightness 
level, and zoom, to manipulate the images to be included in a transcription report. This 
image viewing screen and these basic functions are NOT intended to be used for diagnostic 
purposes.

3.6  Still Frame Capture

If an Xper Information Management System host is equipped with a video capture card, you 
can select and store frames from a patient’s cineangiograms. The still frames can be printed as 
part of the case report, or they can be included in a transcription report.

To capture still frames:

1 On your x-ray equipment, loop a cine run from the patient’s study.

2 Click HEMODYNAMICS > IMAGING > FRAME CAPTURE (if your host is not equipped, this 
option will be disabled in the menu).

3 Click Play. After a short time, the cine run selected on the x-ray equipment will appear on 
the Xper Information Management System screen.

4 On the x-ray equipment, advance to the frame you want to capture and pause the 
playback.

5 Click Capture Frame to acquire and store the still frame in the patient’s study.

6 Repeat as necessary to capture additional frames.

7 Click Stop to clear the image from the screen.

NOTE 
It is not necessary to click Stop between runs or to close the module.

If you have a dual-monitor system, you can display the image full screen on either monitor. 
Select Monitor 1 or Monitor 2, then click Enable Full Screen. Hit the ESC key to return to 
normal viewing.

You may crop the image by checking Enable Cropping. Set the desired level of cropping for left, 
right, top and/or bottom, then click Refresh. The cine run will be redisplayed in cropped 
format. To return to normal mode, uncheck Enable Cropping and click Refresh.

3.7  Printing a Case Report

To print a case report, click Print Case on the Case Details screen. You will be prompted to 
select a report format (see “Case Report Configuration” on page 140). Choose the desired 
format and printing option:

• Print: sends the selected case report format to the printer.

• Archive: creates a PDF of the selected case report format.
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• Print & Archive: sends the selected case report format to the printer and create a PDF 
file, as well.

• Print & Close Case: sends the selected case report format to the printer and close the 
case when printing is complete.

• Preview: allows you to review the case report before printing. The preview screen 
opens, and you can scroll through the various pages of the report. When you are ready 
to print, click the Printer icon at the top left corner. The selected report format prints to 
your default printer. To select a different report format, close the Preview and repeat 
the process, selecting a different format when prompted.

3.8  Finalizing a Case

Once a procedure is over and all required documentation has been completed (case notes, 
transcription reports, etc.), you may finalize the case so that no changes can be made to the 
case data. To finalize a case:

1 Click Lock Study.

2 Enter your username and signature password (see “User Administration” on page 82).

3 Click OK. The Case Finalized box on the ID screen will be checked, and the Finalized Date 
will be populated with the date on which you locked the case.

After a case has been locked, users are able to open the case and review the data, but are not 
able to make any changes, additions or deletions to the data.

Locked cases may be unlocked, in the event that changes do need to be made. The process is 
basically the same as locking a case. The button will now display Unlock Study. Click Unlock 
Study, type your username and signature password, and click OK. You may then make the 
necessary changes and lock the case when you are finished.

NOTE
Users must have Lock and/or Unlock privileges in order to lock or unlock a case. For more 
information, see “User Administration” on page 82.

3.9  Electrophysiology

NOTE
Requires an Xper Connect interface to import the EP data.

Xper Information Management System can display data collected during electrophysiology 
studies performed on an EP-Workmate. The data can also be included in transcription reports. 
To view EP data:

1 Open the case.

2 Click HEMODYNAMICS > EP > EP-Workmate. The data screens open, populated with the 
data that was sent from the EP system.
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3 To add data, click Add. A blank line appears at the bottom of the selected tab, allowing you 
to add information.

4 To delete data, click on the line you want to delete to highlight it and click Delete.

5 To save changes, click Save.

6 To export the data from the selected tab to an Excel spreadsheet, click Export.

7 To import the data into a charting menu, click TRANSFER TO MENU. You may then scrape 
or query the data as you would any other menu.

NOTE
Data can be transferred to a charting menu one time only. Do not perform this operation until 
you are sure the data is complete.

If you have created transcription templates for EP studies, the report begins to auto-populate 
as soon as you have assigned a procedure on the Case Details screen and selected a template.

NOTE
Arterial trees cannot be created for EP studies.

3.10  IntelliVue Interface

The Xper Information Management System application includes a configuration setting that 
allows users to activate an interface with IntelliVue patient monitoring for pre- and post-
procedure vitals recording.

When the IntelliVue interface is configured on a workstation, the following fields are required 
on the Case ID screen in order to start a case in Xper Information Management System:

• Last Name

• First Name

• Medical Record Number 

• Gender

• Date of Birth

The interface sends and accepts the following information between Xper Information 
Management System and IntelliVue patient monitoring:

• Patient name

• Date of birth

• Medical record number

• Heart rate

• Non-invasive blood pressure

• Pulse oximetry

• Temperature

• End tidal carbon dioxide
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• Respiration rate

NOTE
Patient must be admitted on both an Xper Information Management System Workstation and 
an IntelliVue patient monitor.

Patient Data and Polling 

When the patient study is opened on the Xper Information Management System Workstation, 
the patient’s demographic data (name, date of birth, MRN, and gender) is matched and 
validated.

When matching patient data is found, available vitals with NIBP for the study are pulled into 
Xper Information Management System.

All existing vitals data for a study, after polling, are flagged so that they are not reposted.

Xper Information Management System will continue to poll the IntelliVue table and post new 
records as they are received.

Level of Consciousness and Level of Pain

If activated in Settings, Xper Information Management System automatically prompts for Level 
of Consciousness (LOC) and Level of Pain (LOP) assessments when vitals are posted to the 
record.

Vitals Data

Users can:

• Edit, delete, or manually insert vitals data.

NOTE
When a refresh is requested, Xper Information Management System scans the IntelliVue table 
for updated information and posts new records to the study. These records are flagged so that 
they are not reposted during the next automatic polling cycle.

Physiological Alarms/Arrhythmia Detection

All physiological alarms are configured, controlled, and monitored by the IntelliVue patient 
monitors. Xper Information Management System does not have alarm capabilities.

• Arrhythmia detection is performed by the IntelliVue patient monitors. The Xper 
Information Management System does not have arrhythmia detection capabilities.

• Arrhythmia detection information in not posted to the Xper Information Management 
System vitals record.

• Stat vitals recording is not available in the Xper Information Management System 
application.
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3.11  Philips TraceMaster Interface

This system supports a view-only interface with Philips TraceMaster ECG carts. Through the 
Xper Connect interface, a TraceMaster patient will be placed in the Unread Studies or Patient 
Locator window. To view the ECG:

1 Open the case from the Unread Studies or Patient Locator list;

2 Click the History tab;

3 In the LINKS section, click on the link provided for the ECG;

4 The ECG will be displayed in an embedded browser window.

3.12  GE MacLab Interface

NOTE
Requires an Xper Connect interface to import the MacLab data.

This system can display hemodynamic data collected during cardiac catheterization studies 
performed on a GE MacLab system. The data can also be included in transcription reports. To 
view the data:

1 Open the case.

2 Click HEMODYNAMICS > HEMO INTERFACES > GE MACLAB. The data screens open, 
populated with the data that was sent from the MacLab system.

3 To add data, click Add. A blank line appears at the bottom of the selected tab, allowing you 
to add information.

4 To delete data, highlight the line you want to remove and click Delete.

5 To save changes, click Save.

6 To export the data from the selected tab to an Excel spreadsheet, click Export.

7 To import the data into a charting menu, click Transfer to Menus. You may then scrape or 
query the data as you would any other menu.

NOTE
Data can be transferred to a charting menu one time only. Do not perform this operation until 
you are sure the data is complete.

If you have created transcription templates for MacLab studies, the report will begin to auto-
populate as soon as you have assigned a procedure on the Case Details screen and selected a 
template.
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4 Extended Operation

4.1  Scheduling

This system includes a scheduling system that allows you to enter both procedures and staff. In 
addition, the Work Hours scheduler allows you to manage staff working hours and vacation, 
and the Room Staffing module gives you the ability to better manage resources by ensuring 
that procedure rooms are fully staffed to meet your department needs.

4.1.1  Study Scheduler

The Study Scheduler module allows you to manage your procedure room utilization effectively. 
You can display all your procedure rooms at once, or narrow the view to a single room. In 
addition, you can display scheduled procedures for a single day, a week or month, or even an 
entire year at a time. To access the Study Scheduler, click MODULES > SCHEDULER > STUDY 
SCHEDULER.

To set up the Study Scheduler, you must first add rooms. To add a room:

1 Click Rooms to open the Rooms Configuration window.

2 Click New Room.

3 Enter the room name.

4 Click Apply. 

To display a room, place a check in the box next to the room name. If you wish to turn off the 
display for a room, uncheck the box. To delete a room from the list, highlight the room name 
and click Delete.

After you have configured your rooms, you can begin to schedule procedures. To schedule a 
procedure:

1 Double-click on the desired time slot in the appropriate room.

2 Enter the type of procedure (Subject)

3 Set a Start and End time

4 If you wish, enter notes on the patient or procedure. 

5 Click OK to save the procedure, or click Cancel to discard it.

You may also change the procedure room, or even schedule an event in all rooms by using the 
Resources drop-down list. To save an event, click OK, or click Cancel to discard the event.

To add patient data (name and medical record number), CPT codes and staff:

1 Click on the newly scheduled event. The Event Information window opens on the bottom 
right side of the screen.

2 Drag staff names to the event and drop them to assign them to the procedure.

3 Hover over the event to view all the data.
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You may also place pre-admitted patients from the Waiting List into schedule time slots. Simply 
drag the patient from the Waiting List tab to the desired slot on the schedule. Patients 
assigned to the schedule from the Waiting List appear in green. You may then assign additional 
resources and procedures.

To move a study to a different room:

1 Click on the study

2 Drag it to the room and time slot to which you want to move it.

To move a study to a different day:

1 Click and drag the study to the desired day in the calendar view at the top right. This moves 
the study to that day, placing it in the same room and time slot. 

2 Click on the new day in the calendar to move the study to a different room and time.

To save all changes and additions, click Apply. If you do not remember, you will be prompted to 
save your modifications when you close the Scheduler.

You can admit from the Scheduler, if you have entered the patient’s first and last names and 
medical record number. To admit from the Scheduler, right-click on the scheduled study and 
click Admit. A new Case Details screen opens with the patient’s data. If you have assigned 
resources, they will be present, as well.

4.1.2  Staff Schedule

The Staff Schedule is directly tied to the Study Scheduler. To access staff scheduling, click 
MODULES > SCHEDULER > STAFF SCHEDULER. 

Double-click on the desired time slot for the staff member you wish to schedule. You may then 
enter the type of procedure (Subject), a Start and End time. To save an event, click OK, or click 
Cancel to discard the event.

4.1.3  Staff Work Hours

The Staff Work Hours module allows you to manage work schedules for all members of your 
staff, including physicians. You can enter work times for each individual for a number of time 
periods, daily, weekly, monthly, and so on. Access the Work Hours module by clicking 
MODULES > SCHEDULER > STAFF WORK HOURS.

To create a work schedule for a staff member:

1 Select the individual from the drop-down list. Any existing hours scheduled for the person 
selected will be displayed in the Available Work Hours list below. 

2 Click Add Work Hours to activate the Staff Work Hours Editor window at the bottom left.

3 Select a start and end date for the period you wish to schedule. When you click on the 
drop-down list, a calendar appears, allowing you to specify the start date and end date of 
the time period. 

4 Once you have specified the dates, you can click into each day of that time period, 
highlight a time block, and right-click to create a scheduled time block.
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5 Continue creating as many blocks as necessary. To save time, you may click on a block, 
right-click and copy it, then click and paste it into a new time slot. You can copy multiple 
blocks at once by holding down the Ctrl key, clicking on each block, then right-clicking and 
selecting COPY.

6 Click Save to schedule the time. Click Cancel to discard the changes. 

7 To delete a time block, right-click on it and select Delete. 

8 To delete an entire work period, highlight the date range in the list and click Delete in the 
Editor window.

4.1.4  Room Staffing

Once you have created work hours schedules for your staff, you may then assign them to 
procedure rooms and roles using the Room Staffing module. To access Room Staffing, click 
MODULES > SCHEDULER > ROOM STAFFING.

To assign staff to rooms:

1 Use the calendar at the top right to select a day. Staff members who are scheduled to work 
on that day will be available in the list on the bottom right. 

2 You can click on a name and drag it to the procedure room in which you wish to place the 
person. 

3 Right-click on the time blocks for that individual to assign a procedure role: Nurse, Scrub, 
Circulate, Record, or X-ray Tech. Staff members whose names appear in dark gray windows 
are not scheduled to work on that day. 

4 As in the other scheduling modules, you can click and drag a block to a different room or 
date, but you cannot schedule a staff member on a day on which he or she is not 
scheduled to work. Click Apply to save changes.

4.2  Data Scrapers

The data scrapers are powerful tools that enable you to collect data more efficiently, and 
eliminate duplication of work and errors in data entry. The functionality of the data scrapers 
has been expanded to allow you to copy data from one field to another, as well as copying data 
from charting to related fields in the patient demographics screen, registry screens, and to 
transcription reports.

To access the data scraper utility, you must have a case open. We suggest creating a test case 
that you can use to build and test your data scrapers. Before creating any scraper line, you can 
chart the pertinent data into the case, so that you can see the results of your scraper as you 
build, and make adjustments so that you can collect data in the correct format. To access the 
Scraper module, click HEMODYNAMICS > CASE TOOLS > SCRAPERS.

4.2.1  Scraper Types

There are three types of data scrapers you can create: Direct Copy, Label, or Data Mining. The 
Scraper Administration screen displays a short description of the different types:
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Direct Copy: A direct copy scraper copies the contents of one data field to another data field, 
usually on a different screen. For example, you can create a direct copy scraper that will copy 
the contents of the ALLERGIES field on the Demographics screen to the PERTINENT HISTORY 
field on the Sedation Flowsheet.

Data Mining: Data mining scrapers pull data from information which has been charted in a 
case and places it in data fields or in transcription reports. For example, you can create a data 
mining scraper that pulls a patient’s allergies from the charting in the History & Assessment 
menu and places the data into the ALLERGIES field on the Demographics screen.

Label: A label field is used primarily in transcription. If data is present in a case, a label, or tag, 
will be entered in the indicated point in your transcription report. For example, you may want 
an “ALLERGIES:” label in a particular place in your transcription report. You can decide when 
creating the scraper whether you want the label to appear only when data is present in the 
patient’s case, or whether you always want the label to be inserted.

The Scraper Administration screen consists of several sections. At the top is the Scraper Entries 
list. This is a list of all the scraper fields you have created, along with data about each entry, 
such as type, the scraper field name (Destination) and other information about the items.

The controls for creating, editing, deleting and testing items are located on the scraper toolbar 
in the center of the screen. The bottom of the screen is a quick-view information section 
which will display all pertinent data about any scraper field you have selected in the Scraper 
Entries list at the top.

4.2.2  Scraper Creation

Direct Copy

Direct copy scraper fields are relatively easy to build. You begin by identifying the destination 
field; that is, the field in which you want to place data. To begin, click Add. This opens the 
Scraper Creation Wizard.

The Scraper Creation Wizard helps you create the scraper items you need to collect your data 
and direct it to fields on various screens. The Live Scraper section shows you the results of your 
scraper line as you build it, so that you can make adjustments to get exactly the data you want 
in the format you want. The only thing you have to do is to chart menu entries or fill in source 
fields ahead of time, which you can easily do in a test case without affecting actual patient 
data.

Click “Direct Copy” to set the scraper type and open the Destination Field dialogue. There are 
two tabs on the Destination Field screen, Fixed and Transcription Value. A fixed field has a 
name that has been specified by the application and cannot be changed. A transcription value 
will be a field that you create and assign a name. The fields and their functions are listed in the 
following table:

Destination Field - Fixed Description

Screen Select the screen that you are scraping TO.
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The following is an example of how to create a direct copy, fixed destination field, NOTES, on 
the Sedation Flowsheet screen that pulls data from a field on the patient demographics 
screen, ALLERGIES:

1 Click Add.

2 Select DIRECT COPY in the Type section.

3 In the Screen drop-down list, select “SEDATION FLOWSHEET”.

4 In the Field Name drop-down list, select “NOTES”. You have now a system-assigned Merge 
Name “F.Sedation FlowSheet.Notes”.

5 Click Next >. This opens the Source Field dialogue window.

The Source Field contains information that tells the application where to find the data you are 
looking for. The fields and their functions are listed in the following table:

Condition Used only for the Hemodynamic Data screen, indicates hemodynamic condition 
to scrape to.

Field Name Select the field that you want the data to scrape to.

Merge Name The system-assigned scraper field name. These names are set automatically by 
the application.

Description Enter a short description of the scraper field, if desired.

Destination Field - 
Transcription Value

Description

Transcription Field Name Enter the desired field name.

Merge Name The system-assigned scraper field name. These names are set automatically by 
the application.

Description Enter a short description of the scraper field, if desired.

Source Field - Fixed Description

Screen Select the screen that you are scraping FROM.

Condition Used only for the Hemodynamic Data screen, indicates hemodynamic condition 
to scrape from. You can have the scraper check ALL conditions, you can specify 
a condition from 1 – 5, or you can select the condition name.

Occurrence Refers to the index of a value in a table (e.g., Procedures, Resources, 
hemodynamic data, etc.).

Field Name Select the field that you want the data to scrape from.

Merge Name The system-assigned scraper field name. In a direct copy scraper, the names are 
set automatically.

Destination Field - Fixed Description
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To continue building our scraper:

1 In the Screen drop-down list, select “DEMO”. This will tell the scraper to look for a field on 

the patient demographics screen.

2 In the Field Name drop-down list, select “ALLERGIES”. The resulting merge name is the 
system-level field name for the ALLERGIES field on the demographics screen.

3 Click Finish.

Your line is now complete and should appear in the Scraper Entries list at the top of the screen. 
You can check the results by highlighting the field F.Sedation FlowSheet.Notes in the list and 
clicking Test Match. The test match function applies the scraper to your test case and displays 
the resulting data. In this case, however, unless you have filled in the ALLERGIES field on the 
patient demographics screen, the scraper result returned is “No data returned from source 
field.”

Data Mining

You can go to the patient demographics screen and manually type in an entry in the ALLERGIES 
field, but there is another way to fill in that field. You can use a Data Mining scraper to pull 
data from the charting menus and place it in any field on any screen. If you need the data to go 
to more than one location, you can create a Data Mining scraper to fill in one field (in this case, 
ALLERGIES), and then use Direct Copy to duplicate the data in other locations. To create a Data 
Mining field:

1 Click Add.

2 Select DATA MINING in the Type section. The drop-down list will become active.

3 From the drop-down list, select the menu in which the data will be charted. If the same 
data might be charted in more than one menu, select “ALL”.

4 Select “DEMO” in the Screen drop-down list.

5 Select “ALLERGIES” in the Field Name drop-down list. You should now have a Merge Field 
name “F.DEMO.Allergies”.

6 Click Next >.

The next step in creating a Data Mining scraper is to identify the “key” words and/or phrases 
that will indicate what data you want to scrape. A key can be a single line, or it can be a string 
of words or phrases.   What a data mining scraper basically does is tell the application to go to 
a certain menu, look for a certain phrase or phrases that have been charted, and if it finds the 
key(s), to apply a set of instructions to that line in the menu. You can also tell it what to do if it 
does not find the key(s).

Source Field - Transcription 
Value

Description

Transcription Field Name Select the existing Transcription field from which you want to copy data.

Merge Name The system-assigned scraper field name. These names are set automatically by 
the application.
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To create a key, you will be presented with the menu you selected in step 3 in the previous step 
list. If you selected “ALL,” you will have a drop-down list of all menus from which to select. The 
next step is to “chart” the key into the Virtual Charting window by clicking through the menu 
selections. Then, highlight the word (or words) you want to use as a key. In this case, 
“Allergies:” is highlighted. In our example, the word “Allergies:” (with punctuation included) is 
the phrase that identifies the target data to be scraped. You may chart more than one entry (X-
ray contrast, latex, strawberries), but they will all be prefaced with the word “Allergies:”. The 
most important thing to remember about a key is that it will always be present in the charting, 
and therefore can always be used by the scraper to identify the target.

Now that the key has been identified, click and drag it to the Criteria window. If you need to 
identify more than one key, chart the next line and highlight and drag the next key to the 
window. You may need to adjust the condition of the key. By default, the condition of a key is 
set to AND and EXISTS. If you have more than one key, and the condition is set to AND and 
EXISTS for all of them, you are basically telling the scraper to look for Key 1 and Key 2 and Key 
3 and if it finds all of them, apply its instructions. If you set the condition to AND and NOT 
EXISTS for a key, you are telling the scraper to apply its instructions in a case where Key 1 is 
present and Key 2 is not present. In this case, if Key 2 is present, the scraper will not apply its 
instructions, because the conditions for applying them are not met.

If you have multiple keys that may exist, use the condition modifier OR. This tells the scraper to 
look for Key 1 or Key 2 or Key 3, and if it finds either of them, apply the instructions. OR can 
also be used with NOT EXISTS.

When you do have more than one key, you must group them into a string in order to use them 
correctly in a data mining scraper. To do this, highlight the first key in the group, hold down the 
Ctrl key, and click the last key you want to include in a group, then click Group.

By grouping the different keys, you have created a key string. The scraper treats a key string as 
a single key, even though the string may contain many words or phrases.

You can create multiple groups of keys to create more than one key string. Just highlight and 
group the first set, then repeat the operation for any subsequent sets. If you need to ungroup 
a set, highlight the first key in the set, hold down the Ctrl key and click on the last key in the 
set, then click Ungroup. Ungroup All deletes the grouping for any and all sets in your Criteria 
window.

You can delete a key by highlighting it in the list and clicking Delete. Clear All deletes all the 
keys in the Criteria window.

Once you have identified your keys, you are ready to create the instructions that will allow the 
scraper to operate. The first element is OUTPUT TYPE. There are three types:

Type Description

Label Yes/No Selecting this type will instruct the scraper to insert a particular phrase in the 
target field if the conditions of the scraper are met. You may also instruct the 
scraper to insert a different phrase if the conditions are not met, or you can do 
both in the same line.

Data Mining Selecting this type will open up the Data Mining criteria window, where you can 
give the scraper more elaborate instructions on what to scrape and how to 
format it.
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The SEARCH PATTERN tells the scraper to search for data in a single menu or in all available 
menus.

If you select Label Yes/No, the Yes default and No default windows will activate. You can then 
type in the phrase the scraper will output if it finds the key, and if desired, the phrase the 
scraper will output if it does not find the key.

If you select Data Mining as your scraper type, the Data Mining window will be activated. A 
data mining type scraper searches through the charting for the keys, then apply a set of 
instructions that you create here. You can also tell it what to do if it does not find the keys by 
giving it a NO default phrase, if necessary. In the example below, if the scraper does not find 
the key “Allergies:” charted in a menu, it inserts the phrase “NKDA” in the destination field.

The Prefix and Suffix fields allow you to enter a phrase of up to five hundred (500) characters 
that appears before (Prefix) the scraper results, or after (Suffix) the scraper results in a 
transcription document. These fields are available only with Data Mining scrapers.

NOTE
You can configure your system to add the prefix and/or suffix to each line of a group, or to add 
the prefix only to the first line, and suffix only to the last line of a group. For assistance in 
configuring your Xper Information Management System, contact Customer Support, or your 
local Philips Healthcare representative.

The POSITION section tells the scraper where the target data is located in relation to the key:

The OUTPUT section tells the scraper how much of the target data to output:

Once you have set the position and output settings, you can select the key(s) from the drop-
down lists below. If you have chosen between as the position setting, both lists will be active. 

Time Stamp Selecting this type will instruct the scraper to pull the time/date stamp (that is, 
the time and date on which a line was charted) and insert it in the target field.

Before Scrapes data that occurs in the charted line before the key.

After Scrapes data that occurs in the charted line after the key.

Between Scrapes data that occurs between two keys.

Line Outputs data from any line in which it finds the key, using the position setting to 
identify which data will be scraped.

All Outputs all data in the menu that occurs before, after or between the keys, depending 
on the position setting.

Word Outputs a single word either before, after or between the keys, depending on the 
selected position setting.

Type Description
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After selecting the keys, position and output, you must tell the scraper the format in which you 
want the data output. Output formats are described in the following table:

You can also tell the scraper to look for only the numeric characters in a line, and to output 
them in a particular data format:

NOTE
The date and time formats are applied to data within a charted line. The TimeStamp output 
type refers to the time and date when the line was charted.

Label

Label scrapers are used primarily in transcription templates, but can be used for other fields, 
as well. The most common use is to insert a label for hemodynamic data, such as AO pressure, 
Heart Rate, etc. However, you can also use a label scraper to insert data into a fixed field, 
based on certain criteria you set when building the scraper.

You begin creating a label scraper in the same manner as the other types, by selecting a 
destination field. In the case of a Fixed field, the field names already exist. In the case of a 
Transcription field, you have to assign a name to the field.

The following is an example of a Label scraper that will insert the phrase “Allergies:” into a 
transcription template. To begin:

Format Description

Single Line The default output format, outputs scraped data from a single line.

Group Comma When multiple lines are identified, the scraper outputs the results in a string with 
commas between each entry (e.g., X-ray contrast, Iodine, Latex,).

Group Period When multiple lines are identified, the scraper outputs the results in a string with 
periods between each entry (e.g., X-ray contrast. Iodine. Latex.).

Group When multiple lines are identified, the scraper outputs the results in a string with 
no additional punctuation between each entry (e.g., X-ray contrast Iodine Latex).

List When multiple lines are identified, the scraper outputs the results in a list format: 

X-ray contrast

Iodine

Latex

Quantity When multiple lines are identified, the scraper outputs the total number of results 
found (e.g., 3).

Format Description

Alpha Numeric The default data format, includes letters, numbers and other characters.

Numeric Scrapes numbers to a field as a numeric value that can be used in calculations.

Date Scrapes numbers to a field and applies a date format (mm/dd/yyyy).

Time Scrapes numbers to a field and applies a time format (hh:mm:ss).

Include Keyword Includes the keywords with the scraper results.

Include Time Includes the time stamp with the scraper results.
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1 Click Add and select the LABEL scraper type.

2 In the Transcription Field Name box, type ALLERGIES. The Merge Name will read 
“L.ALLERGIES”.

3 Enter a description, if desired.

4 Click Next > to open the Reference Field screen.

5 In this case, we are looking for allergy data on the patient demographics screen:

6 In the Screen drop-down list, select DEMO.

7 In the Field Name drop-down list, select ALLERGIES. The Merge Name should now read 
“F.DEMO.Allergies.”

8 Click Next > to display the CRITERIA screen.

The Criteria screen allows you to set specific conditions that must be met in order for the 
scraper to operate. The fields and their functions are specified in the following table:

In our example, we are simply checking the Allergies field on the patient demographics screen 
to see whether data is present, so we will select the DATA PRESENT option. Now we can set a 
Yes default response, and if desired, a No default response. In the YES: field, enter ALLERGIES:.

You do not have to specify both a Yes and a No default response. You only need a No default if 
you want the label to appear on a report even when there is no data in the reference field. In 
the case of the ALLERGIES field on the demographics screen, we created a Data Mining scraper 
that inserts the phrase “NKDA” if it does not find any allergies charted in the case; therefore, 
the ALLERGIES field will always contain data, so we do not need a No default response. Click 
Finish to complete the new Label scraper.

You can use the Label type for fixed fields, too. For example, say you want to insert the word 
“True” in the Diabetes field on the ACC registry screen if a patient’s glucose is between 110
199. In this case, your destination field would be the ACC Core field “Diabetes,” your reference 
field would be GLU on the demographics screen, and you would set a Value condition of 
between, a value of 110, and an upper value of 199.

Data Present button Select this if the only criterion for scraper function is that data be present in the 
reference field.

Value button Select this if you want to set a value criterion for scraper function.

Condition (Value) Specify the condition for the value (e.g., equal to, greater than, less than, etc.).

Value Specify a value, or the lower limit of a range.

Upper Value Specify the upper limit of a range.

Field Length button Select this if you want to set a field length criterion for scraper function

Condition (Field Length) Specify the condition for the value (e.g., equal to, greater than, less than, etc.).

Value Specify a field length, or the lower limit of a range

Upper Value Specify the upper limit of a range.

Yes: The default response if scraper criteria are met.

No: The default response if scraper criteria are not met.
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Sedation/Reversal Agent Scrapers

Sedation and Reversal Agent scrapers, which scrape data to the Sedation Agents and Reversal 
Agents sections of the Sedation Flowsheet, have a specific structure that must be followed in 
order for them to work. Since both types of scraper are built in the same way, we will use the 
Sedation Agent scraper as an example. To create a sedation scraper:

1 In the Menu Builder, highlight the word or phrase to be used as the scraper key and check 
the SEDATION (or REVERSAL) attribute, then apply changes (see section 4.11.3 ‘Building 
and Editing Menus’).

2 In Scraper Administration, click Add.

3 Select Data Mining and choose the menu in which the keys are charted from the drop-
down menu.

4 Select Sedation Flowsheet as the destination screen, and Sedation Agent as the destination 
field. Click Next.

5 Chart the line containing the key (e.g., {Narcotics/Sedation} Versed 2 mg IV).

6 Highlight the key (previously identified in the Menu Builder; in the example above, 
{Narcotics/Sedation} is the key) and drag it to the Criteria list. Click Next.

7 Select Output Type of Data Mining.

8 Select Data Mining position as AFTER and select the key from the drop-down menu.

9 Set Output to LINE and Output Format to LIST.

10 Set Data Format to ALPHA NUMERIC. Click Save.

Case Status Scrapers

Case status scrapers automatically sends a designated status message to update the 
Whiteboard Viewer (see “Patient Status Viewer” on page 27). To create a case status scraper:

1 Click New.

2 Select the Data Mining type.

3 Select the appropriate menu from the Data Mining drop-down menu.

4 Set the designation screen to DEMO.

5 Set the Field Name to Case Status.

6 Click Next.

7 Chart and drag keys to the Criteria list.

8 Click Next.

9 In Output Type, select Case Status to activate the Case Status drop-down menu.

10 Select the desired case status message from the list.

11 Click Finish.

During a procedure, when you chart the keys and click Scrape, the status message will be sent 
to the designated Whiteboard.
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You can see how data scrapers give you the ability to maximize data collection while 
minimizing workload. You can eliminate the need for staff to duplicate their efforts by charting 
in the menus, and then manually entering the same data on multiple screens. In the case of 
the transcription fields, you can create many different transcription reports, from physician 
reports to nursing notes, to custom forms for data submission to state agencies, and many 
more. The possibilities are limitless!

4.3  Structured Reports

This system gives you the ability to create structured report templates that may be used to 
generate transcription reports for procedures. You can create as many report templates as you 
desire per modality. Once you have created your templates, you can assign them to a modality 
and procedure, designating one template as the default for each procedure type. When a 
study is opened and the procedure type indicated, the default template opens. As the study 
progresses, the template is completed automatically (see “Transcription” on page 54).

4.3.1  Transcription Builder

To access the structured reporting module, click TOOLS > TRANSCRIPTION, then select 
TRANSCRIPTION BUILDER. Several tabs appear on the left side of the screen. Click the 
Templates tab to view the list of available report templates or to create a new template. 

The Transcription Builder is a fully functional word processor with all the commands and 
capabilities of other word processing applications. The template builder controls and their 
functions are listed in the following table.

Control Description

File Menu Contains commands for working with files (New, Open, Save, etc.).

Edit Menu Contains commands for editing documents.

View Menu Contains commands for viewing different elements of the editor (rulers, 
headers/footers, etc.).

Insert Menu Contains commands for inserting elements into a document.

Format Menu Contains formatting commands.

Tools Menu Contains tool commands (spell checker, macros, etc.).

Table Menu Contains commands for creating and editing tables.

New Document Creates a new, blank document.

Open Opens an existing document in the user’s My Documents folder.

Save Saves the open document to the user’s My Documents folder.

Print Prints the open document.

Print Preview Displays the document as it will appear when printed.
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Templates

The Templates tab contains a list of available report templates that have been created or 
loaded to the system. To view a template, click on the name in the list. The selected template 

Spell Check Checks the spelling in the document.

Cut Cuts selected text from the document and places it on the clipboard.

Copy Copies selected text to the clipboard.

Paste Pastes selection from the clipboard to the document.

Undo Undoes the last performed action.

Redo Repeats an action that was cancelled by Undo.

Insert Hyperlink Inserts a hyperlink to a file or URL into the document.

Insert Table Inserts a table into the document.

Show Paragraph Codes Displays paragraph and text formatting codes on an open document.

Zoom Level drop-down Allows a user to select a zoom level.

Style drop-down Allows a user to apply a style to selected text.

Font drop-down Allows a user to select font types for selected text or the entire 
document.

Font Size drop-down Allows a user to specify a font size.

Bold Displays and prints selected text in bold type.

Italic Displays and prints selected text in italic type.

Underline Underlines selected text in display and printing.

Left Justify Aligns text to the left margin.

Center Justify Aligns text along the center point of the document.

Right Justify Aligns text to the right margin.

Full Justify Aligns text to both left and right margins.

Bullets and Numbering Allows a user to format bulleted or numbered lists or paragraphs.

Decrease Indent Decreases the amount of indentation of selected text.

Increase Indent Increases the amount of indentation of selected text.

Control Description
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will load to the editing screen, where you can make changes or preview the printed document. 
You can save changes to a template by clicking Save Template. 

If you want to save a template under a different name, click Save Template As and type in a 
new name. If you want to replace an existing template, select the name of the template you 
want to replace in the list and click OK. You will be asked if you want to overwrite the existing 
template.

To delete a template, highlight it in the list and click Delete. You will be asked to confirm the 
deletion. Click OK to delete or Cancel to cancel the operation.

NOTE
Certain characters ( | ^ ~ \ & ) cannot be used in transcription templates if you have a results 
interface. If these characters are included in your template, the transfer of reports across the 
interface will fail.

Sections

The Sections tab contains a list of report sections that may be inserted into templates. Sections 
include such items as headers, footers, or tables. To create a section, start with a blank 
document and create the section in the same way you create a new report template. Click 
Save Section to save your work.

If you want to save a section under a different name, click Save Section As and type in a new 
name. If you want to replace an existing section, select the name of the section you want to 
replace in the list and click OK. You will be asked if you want to overwrite the existing section.

To delete a section, highlight it in the list and click Delete. You will be asked to confirm the 
deletion. Click OK to delete or Cancel to cancel the operation.

NOTE
It is recommended that you do not copy and paste from one template or section to another. 
The templates and sections contain underlying code that will be replicated by copying and 
pasting. Creating sections or templates in this way can greatly increase the file size of your 
transcription templates and subsequent reports, resulting in performance degradation and 
decreasing space on your server and local hard drives. The correct method is to build sections 
first, then place them in your templates, or to build templates separately.
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Tables

The Tables tab contains a list of data tables that may be included in a template. These tables, 
when placed in a template, will be automatically populated with the appropriate data from a 
procedure. The tables include:

• Case Procedures: list of all procedures from the Case Details screen.

• Case Resources: list of all resources (staff) from the Case Details screen.

• Case Diagnosis Codes: list of all diagnosis codes assigned to a study’

• Patient Vitals: list of vitals signs recorded during a procedure.

• Hemo Saturation: list of any oxygen saturation results recorded during a procedure.

• Hemo Pressure: list of invasive pressures recorded during a procedure.

• Hemo Cardiac Output: list of thermal cardiac outputs recorded during a procedure.

• Hemo Gradients: list of valve gradient data recorded during a procedure.

• Hemo Functional Measurements: list of functional measurements samples recorded 
during a procedure.

• Sedation Agents: list of sedation agents administered during a procedure.

• Sedation Reversing Agents: list of reversal agents administered during a procedure.

• Charges: list of patient charges generated during a procedure.

• Procedure Log: list of all charting entries performed during a procedure.

• Lab Series: list of all lab results received during a procedure.

Names

The Names tab allows you to place specific entries from the Procedures and Resources tables 
from the Case Details screen into a template. To add a name field to a template, position the 
cursor in the template and then double-click the field.

Signatures

The Signatures tab allows you to insert up to five (5) digital signature markers for resources 
assigned to a case. To add a signature marker to a template, select the resource type, position 
the cursor in the template and double-click the field (e.g., Physician 1). When the user applies 
a digital signature to a report, a signature stamp containing the name of the person signing, 
and date and time that the signature was applied appears in the report. If a signature bitmap 
has been assigned to the user, it will also appear in the report (see section 4.5.3 ‘User 
Administration’). If more than one signature marker has been placed in a template, signatures 
for each resource must be applied before the report is finalized and converted to a PDF.

Addresses

The Addresses tab allows you to insert markers for resources assigned to a case. When the 
report is executed, the name and address of the designated resource appears in the report.
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NOTE
User demographics must be entered in the user account. See section 4.5.3 ‘User 
Administration’.

Scrapers

The Scrapers tab contains a list of available scraper fields, which can be included in a template. 
To add a scraper field to a template, position the cursor in the template and then double-click 
the field.

Custom Fields

The Custom Fields tab contains a list of all custom forms and their associated fields, which can 
be included in a template. To add a custom field to a template, select the form on which the 
field appears, position the cursor in the template and double-click the field. To add a charting 
menu to a template, position the cursor in the template and then double-click the menu.

Charting

The Charting tab contains a list of current charting menus, which can be included in a 
template. If placed in a template, the report will populate with any charting done during a 
procedure in the specified menu.

Images

The Images tab contains markers for up to ten (10) still frames, arterial trees, and waveforms, 
which can be included in a template. To add an image to a template, select the type of image 
to be inserted, position the cursor in the template and then double-click the field. The number 
corresponds to the order in which the images were acquired during the procedure (e.g., Wave 
1 would be an image of the first waveform sample acquired during a procedure, Wave 2 would 
be an image of the second, etc.). When a template containing images is selected for a study, 
any markers that do not have corresponding images in the study will be removed from the 
report.

Data Fields

The Fields tab contains lists of all available database fields, which can be included in a 
template. To add a database field to a template, position the cursor in the template and then 
double-click the field.

Conditional Markers

Conditional markers allow you to designate sections of a template to appear in a report only 
when a certain condition is met. For example, you may have one section of the template that 
you want to use only when a right heart catheterization is performed.

GE MacLab

The GE MacLab tab contains a list of all fields for electrophysiology cases imported from a GE 
MacLab system.
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EP Workmate

The EP Workmate tab contains a list of all fields for electrophysiology cases imported from an 
EP Workmate system. 

Cardiolab

The Cardiolab tab contains a list of all fields for electrophysiology cases imported from a 
Cardiolab system. 

NOTE
EP tabs will be available only if you have an EP interface.

4.3.2  Transcription Configuration

In order to utilize transcription templates during a procedure, you must associate the 
templates with the type of procedure. To access the Transcription Configuration module, click 
TOOLS > TRANSCRIPTION > TRANSCRIPTION CONFIGURATION.

The Transcription Configuration screen is divided into two sections. On the left is a list of study 
modalities and their associated procedures (see section 4.17 ‘Coding’). On the right is the list of 
transcription templates.

To associate a template with a procedure, click on the template in the list on the right and drag 
it to the desired procedure on the left. You may drag and drop as many templates to a 
procedure as you want. Once templates have been associated with a procedure, you may 
designate one as the default template by clicking with the right mouse button on the template 
name, then selecting Make Default from the list. The default template for a procedure is 
indicated by a green check mark.

To remove a template from a procedure, click with the right mouse button and select Delete 
Document. This will not delete the template, but it will no longer be associated with the 
procedure and cannot be accessed during a study (see “Transcription” on page 54).

4.3.3  Transcription Types

Transcription types are used to identify the type of document being sent across the Xper 
Connect or IntelliBridge Enterprise interface to a facility’s results interface.

To add a transcription type:

1 Enter a description.

2 Select X-Ray Angiography (XA) modality.

3 Click Add.

To edit a type, select it from the list, make the necessary changes, and click Update.

To hide a type, select the type from the list and click Hide. If a type is already hidden, you may 
redisplay it by selecting it and clicking Show.
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4.4  Registries

This system includes a data collection module for the American College of Cardiology (ACC) 
registry, and the Implantable Cardiac Defibrillator (ICD) registry. The module contains all the 
fields required by the various bodies for reporting. You can elect to enter data manually in 
both registries, or build data scrapers to complete the fields for ACC and ICD as a study is 
charted.

To access any registry, open a study and click Registries, then select the appropriate registry 
from the list. The screens opens, and you can begin filling in the data, or, if you have built 
scrapers, the data is populated.

4.5  Security

4.5.1  User-Centric Navigation

This system stands out from other applications by utilizing user-centric navigation. That is, the 
user interface configures itself to the assigned role of a user’s account, instead of the 
traditional “patient-centric” focus that forces most users into a screen configuration that they 
do not need or that presents them with information or functions not applicable to their job. By 
having a user-centric focus, this system helps you work more efficiently by giving you only the 
tools you need to perform your job and avoid information overload. User-centric navigation 
also increases the security of your system by allowing you to restrict user access to certain 
functions by removing them from the user interface when not appropriate for the user role. To 
access the Portal Designer, click SYSTEM > SECURITY > PORTAL DESIGNER.

User Roles

User roles are the heart of user-centric navigation. This system provides you with a wide 
variety of preconfigured user roles which you can fine-tune for your needs, or you can create 
your own. Once you have created and defined a role, you can assign it to users in the User 
Administration module (see section 4.5.3 ‘User Administration’). Keep in mind that creating 
user roles is not the same as adding users to the system. You must create your user roles prior 
to adding users, or use the roles provided when adding new users.

To create a user role:

1 Click Add below the user Roles Description list. 

2 You will be prompted to enter a description for the new role, then click OK to save the new 
role or Cancel to discard it. 

Once you have saved the new role, it will appear in the User Roles list, and you will be 
prompted to create a Portal Layout. 

3 To delete an existing role, highlight it in the list and click Delete.
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Portal Designer

The Portal Designer is the next step toward designing a user-centric system. You can use the 
Portal Designer to create custom user roles, define the functions that will be assigned to these 
roles, and determine the layout of the workspace a user sees when logged in to the system, as 
well as the functions available on the user’s toolbar.

The first step in creating a Portal Layout is to determine how the workspace should look. Use 
the Pane Layout drop-down list to select the number and configuration of panes (or windows) 
appropriate to the role, then use the Pane Contents drop-down list to determine what the 
contents of each pane will be. For example, users assigned as Scheduler may need to see the 
Schedule viewer, the Basic Search screen, and Room Usage information, while an IT role might 
need only System Status or Users Logged On.

If you would like to designate the Study Scheduler as read-only for a particular role, check 
Scheduler View-Only. Any user assigned a role with this setting are able to view the Study 
Scheduler, but are not able to make changes.

To assign content to a pane, select the item in the Pane Contents drop-down list, then click and 
drag the selected item to the pane in which you want it to appear. Click Save to save the 
layout, or Clear to start over.

Some of the pane contents items contain columns. You can choose to hide or display particular 
columns within a pane. Clicking the COLUMN SELECTOR will open a list of the available 
columns for the selected content. To hide a column, uncheck the box next to the column title. 
To display a column, mark the box with a check. You can adjust column order by clicking on a 
column header and dragging and dropping it in its new location.

You can duplicate an existing user role’s settings under a new name, and adjust the settings for 
the new, similar role. To do this, click Duplicate, then give the “new” role a name and click 
Save. You can then adjust the layout and contents as needed, and save again when you are 
ready.

Menu Bar Builder

Once you have determined how the workspace will look for a role, you must create a toolbar 
layout to match. A user toolbar contains navigation tools, such as LOGOUT, and permits access 
to the other modules within Xper Information Management System, such as Inventory, 
Transcription utilities, System tools, or Scheduling.

To create toolbars, highlight the desired user role and click the Menu Bar Builder tab. You will 
notice several toolbar type selections at the top of the screen: MAIN, CASES, and CASES 
(QUERY). The Main toolbar is the one a user will see when first logging into the system. The 
Cases toolbar is what a user will see when he has opened a case.

Underneath the toolbar types is the toolbar functions tree. This is where you decide which 
buttons will be available on a given toolbar for the user role. Functions marked with a green 
check will be available on the toolbar, while functions marked with a red “X” will not appear.

You can restrict user access within a given module to individual functions within the module. 
For example, the Scheduler module has four main functions, Study Scheduler, Staff Scheduler, 
Staff Work Hours and Room Staffing. You can restrict a user to accessing only the Study 
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Scheduler by marking it with a green check, and marking the other three screens with a red 
“X”. When the user clicks the Scheduler button on the main toolbar, the only associated 
function he can select is Study Scheduler.

The Sample Layout section shows you how the toolbars you create will appear to a user 
assigned to the selected role. When the main toolbar and any appropriate modality toolbars 
are arranged to your liking, click Save to save your toolbar configurations.

4.5.2  Password Management

The Password Management module allows you to perform operations such as setting 
username and password lengths and characteristics, specify how long a password history will 
be kept, and set user lockout limits. This module is closely related to the User Administration 
module. To access password management, click SYSTEM > SECURITY > PASSWORD 
ADMINISTRATION.

User Name Settings

On this screen, you set the minimum and maximum character lengths for usernames. The 
minimum length has a range of 3–10. The maximum length has a range of 3–20.

System Password Settings

On this screen, you maintain various settings for system login passwords. The fields and their 
functions are specified in the following tables:

Field Definition

Minimum Length Specifies the minimum number of characters (letters, numbers, and symbols) 
for a system login password. The range is 3–15.

Maximum Length Specifies the maximum number of characters for a system login password. The 
range is 3–20

Minimum Digits Specifies a minimum number of digits that must be included in a system login 
password. The range is 0–4.

Minimum Letters Specifies a minimum number of letters that must be included in a system login 
password. The range is 0–20.

Passwords are Case Sensitive Check if you want passwords to be case sensitive.

Minimum Upper Case 
Letters

Specifies the minimum number of upper case letters for a case-sensitive system 
login password. The range is 1–20.

Minimum Lower Case 
Letters

Specifies the minimum number of lower case letters for a case-sensitive system 
login password. The range is 1–20.

Force Password Expiration When checked, forces password expiration of a set interval for all users in the 
system.

Passwords Expire Every 
(Days)

Sets the interval for system-wide password expiration. The limit is 30–90 days.

Enable Password History When checked, keeps a history of user passwords for a specified interval.

Password History is Kept for 
(Months)

Sets the interval for retention of password history. The limit is 1–60 months.
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Signature Password Settings

On this screen, you maintain various settings for signature passwords. The fields and their 
functions are specified in the following tables:

Enable User Lockout Activates the user lockout feature. Users who attempt to log in with an incorrect 
password will be locked out after a specified number of attempts.

Lock out users after (Failed 
Login Attempts)

Specifies the number of attempts a user can make with an incorrect password 
before the user account is locked.

Do Not Allow Login For 
(Minutes)

Sets the amount of time (in minutes) that a user account will be locked after a 
specified number of failed attempts.

Lock out all users now When checked, initiates a system-wide lockout. No users may log in while this is 
active.

Enable User Password Clues When checked, activates the “Forgot Password” function. Users who have 
forgotten their passwords will be prompted to answer the System Password 
Clue Question entered in their user profile (see section 4.5.3 ‘User 
Administration’).

Field Definition

Minimum Length Specifies the minimum number of characters (letters, numbers, and symbols) 
for a signature password. The range is 3–15.

Maximum Length Specifies the maximum number of characters for a signature password. The 
range is 3–20

Minimum Digits Specifies a minimum number of digits that must be included in a signature 
password. The range is 0–4.

Minimum Letters Specifies a minimum number of letters that must be included in a signature 
password. The range is 0–20.

Passwords are Case Sensitive Check if you want passwords to be case sensitive.

Minimum Upper Case 
Letters

Specifies the minimum number of upper case letters for a case-sensitive 
signature password. The range is 1–20.

Minimum Lower Case 
Letters

Specifies the minimum number of lower case letters for a case-sensitive 
signature password. The range is 1–20.

Force Password Expiration When checked, forces password expiration of a set interval for all users in the 
system.

Passwords Expire Every 
(Days)

Sets the interval for system-wide password expiration. The limit is 30–90 days.

Enable Signature Password 
History

When checked, keeps a history of user passwords for a specified interval.

Password History is Kept for 
(Months)

Sets the interval for retention of password history. The limit is 1–60 months.

Enable Signature Password 
Clues

When checked, activates the “Forgot Password” function. Users who have 
forgotten their passwords will be prompted to answer the Signature Password 
Clue Question entered in their user profile (see section 4.5.3 ‘User 
Administration’).

Field Definition
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After changes to any of the screens, click Save to accept the changes. If you make changes and 
forget to click Save, you will be prompted to save or discard changes when you close the 
Password Management module.

4.5.3  User Administration

The User Administration module allows system administrators to create and maintain the 
security settings for individual users in the system. User Administration is closely tied to the 
other security modules, Portal Designer and Password Management. It also allows an 
administrator to see security settings for any user at a glance and to create and maintain 
physician groups. To access User Administration, click SYSTEM > SECURITY > USER 
ADMINISTRATION.

User Settings

The list of current users appears on the left. At the bottom of the list are several filter tools 
that can be helpful when maintaining users. There are alphabetical tabs and an ALL tab, which 
displays the entire list of users. The Filter List By section allows you to filter the user lists by 
user type. You can also click on the title of any column to sort the list in ascending or 
descending order for that column.

To the right, the User Settings screen is used to enter information about the user and to set 
passwords. At the top right are the controls for adding and deleting users. To create a new 
user, click Add User. This clears the User Settings screen and assigns a new User ID number. Fill 
in the rest of the user data and click Save to save the changes. If you forget to click Save, you 
will be asked to save changes when you close the User Administration module. The fields and 
their functions are specified in the following tables:

User Settings Description

User ID This number is automatically assigned by the application when you click ADD 
USER.

User Name Enter the user’s login name here.

Login Allowed Enables login for the user account.

Allow System Configuration Gives the user access to the Configuration Screens module.

Last Name The user’s last name

MI The user’s middle initial (optional)

First Name The user’s first name

Title The user’s professional title, if any (optional)

User Type Assigns a user resource type

Physician ID This field can be used to enter a physician’s license number or other identifier 
(optional)

Physician UPIN Unique Physician Identification Number field

Show Only Patients When checked, the physician will see only his/her patients

Transcription Signature 
Override

When checked, allows a physician to sign a transcription report as proxy for 
another physician.
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Physician Groups A list of groups to which a physician can be assigned (see section 4.5.3 ‘User 
Administration’). When physicians are assigned to a group, only patients 
belonging to the group will be visible when the physician logs in to Xper 
Information Management System.

Assigned Groups Displays the group to which a physician is currently assigned

> ADD Adds a group to the Assigned Groups list

< REMOVE Removes a group from the Assigned Groups list

Disable Charting Timestamp When selected, user will be unable to edit time stamps on charted line

Approve Patient Charges When selected, user will be able to approve a patient's charges for processing 
(see Coding)

Billing Override When selected, a user will see all queued patients, regardless of the user 
assigned (see Coding)

System Password Settings Definition

System Password Change 
Next Login

When checked, prompts the user to change his/her system password on the 
next attempt to log in

Validate Macro Security Gives the user privileges to create, edit and delete recording macros

System Password Expiration When checked, user’s password will expire after a designated interval

System Password Enter the user’s system password

System Password (Verify) Re-enter the user’s system password for confirmation

System Password Expiration 
Days

Sets the interval for the system password expiration period (30 - 180 days)

System Password Clue 
Question

Enter a question that the user must answer when resetting a lost or forgotten 
system password

System Password Clue 
Answer

Enter the response the user must provide to the System Password Clue 
Question

Validate Disable Audible 
Alarms

When selected, a user will be permitted to disable audible physiomonitoring 
alarms (Flex Cardio only)

Signature Password Settings Definition

Use Signature Password Check this box if you want to assign a unique password for applying digital 
signatures.

Signature Password 
Expiration

Check this box if you wish to set an expiration limit on a signature password.

Signature Password Enter the user’s signature password here.

Signature Password (Verify) Enter the user’s signature again to be verified.

Lock Study When checked, gives the user rights to lock a study so that no changes can be 
made to the patient data, and sets the Case Finalized flag and date

User Settings Description
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To delete a user account, highlight it in the list on the left and click Delete User. You will be 
prompted to click Yes to delete the user account or No to cancel the deletion.

User Demographics

The User Demographics screen stores data such as mailing address, telephone and cell phone 
number, fax and pager numbers, and e-mail address. Enter any desired data and click Save to 
record the information.

A signature bitmap may be attached on this screen to a user account. If you have a bitmap of a 
physician’s or other staff member’s signature, right-click on the Signature field, click Load, 
browse to the location of the bitmap, and Double-click the file. The image will appear in the 
Signature field. When the user applies a digital signature to a transcription report, the image is 
inserted at the place in the template where a signature marker has been inserted (see section 
4.3.1 ‘Transcription Builder’).

User Roles

On this screen, you assign the roles created in the Portal Designer to the individual users. You 
can assign just one role, or a user could have multiple roles. Whatever the number of roles 
assigned to a user, you must specify a Primary User Role. This is the default role the user sees 
when he logs in to the system. If a user is assigned more than one role, he can switch roles 
after logging on by using the User Roles drop-down list at the bottom of the main screen.

The available user roles appear in the list on the right. To assign a role, highlight it in the 
Available Roles list and click < Add. If you want to create a “super user” who is assigned to all 
available roles, click << Add All. Once you have assigned at least one role to a user, it will 
appear in the Primary User Role list. If a user has been assigned more than one role, use the 
Primary User Role drop-down to choose which of the assigned roles will be the user default. If 
you want to remove an assigned role, highlight it in the Assigned Roles list on the left and click 
> REMOVE. Once you are satisfied with the list of assigned roles, click Apply. Use Cancel to 
start over.

Checking the box next to Allow Case History Criteria Change allows the user to set criteria for 
linking historical cases (see section 4.23 ‘Patient Historical Links’).

Unlock Study When checked, gives the user rights to unlock a study that has been locked

Physical Signature Required Check this box to set physical signature as required instead of digital signature.

Signature Password 
Expiration Days

The interval (in days) after which a user will be asked to enter a new signature 
password. The interval can be set from 30 to 180 days.

Signature Password Clue 
Question

Enter a question that the user must answer when resetting a lost or forgotten 
signature password.

Signature Password Clue 
Answer

Enter the response the user must provide to the Signature Password Clue 
Question.

Signature Password Settings Definition
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Repositories

The Repositories section allows you to assign user access to specific data repositories within 
the Xper Information Management System database. To grant access, place a check next to the 
repository name. When the user logs in to Xper Information Management System, only the 
designated repositories will be available. Checking GLOBAL USER gives the user access to all 
available repositories. When a user logs in, the repository will default automatically to the last 
repository the user had accessed. If a user is given access to multiple repositories, he can 
access a different repository after logging on by using the Repositories drop-down list at the 
bottom of the main screen.

LDAP Settings

The LDAP Settings tab allows you to associate an Xper Information Management System user 
account with the user’s LDAP (Light Directory Access Protocol) account. If your system is 
configured to use LDAP authentication, enter a valid domain and username in the LDAP 
Username field, typing a slash between (e.g., domain\username). When you log in to Xper 
Information Management System, you then may enter your Windows username and 
password.

4.5.4  Audible Alarms Deactivation

When Xper Information Management System Workstations are paired with Xper Flex Cardio 
Physiomonitoring systems, you may disable audible alarms, if desired (visible alarm signals 
cannot be disabled, but will terminate automatically when the alarm condition is corrected). 
To do so, open Alarm Setup and check Disable Audible Alarms. Click OK to save the setting. 
You will be prompted to enter your username and password.

To disable audible alarms:

1 Open Alarm Setup and select the Disable Audible Alarms check box.

2 Click OK to save the setting.

You will be prompted to enter your username and password. 

NOTE
Users must be assigned alarm disable privileges in order to be able to disable audible alarms. 
See “User Administration” on page 82 for more information.

On the live screens, an Audible Off indicator will be displayed next to the heart rate indicator 
at the top center of the screen as a reminder that audible alarms are disabled. A reminder 
tone will sound every three (3) minutes while audible alarms are disabled. If you enable 
audible alarms, the icon will no longer be displayed, and audible tones will sound. 
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4.5.5  Macro Validation Security

Xper Information Management System Workstations that are paired with Xper Flex Cardio 
Physiomonitoring systems may be configured to require the entry of a username and 
password to save or delete monitoring macros. In order to enable macro validation security, 
you must activate the function for each user, and also enable the security check on each 
workstation:

1 In User Administration, for each user to whom you want to assign macro privileges, check 
Validate Macro Security on the User Settings tab.

2 On each workstation where macro security will be required, check Validate Macro Security 
on the System Setup tab of the Configuration Settings screen.

After enabling macro security on a workstation, any user who attempts to save or delete a 
monitoring macro will be prompted for a username and password. If the user has not been 
assigned the privilege in User Administration, the user will not be permitted to save or delete 
the macro.

NOTE
Macro security must be enabled on the workstation. If macro security is not enabled on a 
workstation, any user may save or delete macros without being prompted for username and 
password, regardless of the user account settings.

4.5.6  Physician Group Administration

Physician groups give an additional layer of security to patient information. When physicians 
are assigned to a group, only studies performed by physicians assigned to the same group will 
be available in the patient lists.

NOTE
If no group is assigned, a user will be able to access any patient unless additional security is 
applied (see section 4.5.3 ‘User Administration’, for information on applying the Show Only 
Patients filter).

Use this screen to maintain the list of physician groups (see section 4.5.3 ‘User 
Administration’). A physician group can be a professional group, a departmental group, or a 
group you create. To create a group, enter a name or other identifier in the GROUP field. Enter 
an optional description in the GROUP DESCRIPTION field. Click Save to add the group to the 
list. If you want to clear the fields without saving, click Cancel.

You can edit existing groups by Double-clicking on the Group name in the list. Make the 
desired changes and click Save.

To delete a group, highlight the item in the list and click Delete. You will be prompted to click 
Yes to delete the group, or No to cancel the deletion.
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4.5.7  System Password Reset (Forgot Password)

The application has a “Forgot Password” function that allows a user to create a new system 
password if necessary. To reset a lost or forgotten system password:

1 On the login screen, enter your user name and click Forgot Password.

2 You will be prompted to enter the answer to your system security question. Enter the 
response and click Submit.

3 Enter your new password, then re-enter the password a second time for confirmation. If 
the two entries do not match, you will be prompted to retype your new password.

4 Click Submit. You will receive a confirmation that your password has been successfully 
reset.

4.6  Inventory Management

Effective inventory management plays a crucial role in the smooth and efficient running of any 
organization. Inventory control for your department, procedure suites, or facility can be 
performed by tracking inventory as it is received, moved and issued. You are able to quickly 
perform physical inventory and cycle counting, or receive system alerts when inventory levels 
are getting low. Track disposable supply levels and use barcodes to expand your data entry 
capabilities. The entire inventory function is seamlessly integrated within the menu structure 
(see “Charting a Procedure” on page 30). As items used are charted into a case, your inventory 
is decremented automatically. The Inventory Module can import a supplies list from an Excel 
file and interfaces with supply cabinets such as Pyxis and Omnicell.

4.6.1  Inventory Overview

The Inventory Overview screen allows you to view all active or inactive inventory items, as well 
as specific information pertaining to each item, such as part number, location, serial number, 
quantity at hand, barcode value, expiration date, and so on. In this screen, you may perform 
searches by multiple criteria, build and view orders, and generate preset reports to either view 
on screen, print out, or export to MS Excel. To access Inventory Overview, click MODULES > 
INVENTORY > OVERVIEW.

Dragging and Dropping Column Headers

You can adjust Inventory column order by clicking on a column header and dragging and 
dropping it in its new location. Once you have arranged Inventory columns, click Save Grid 
Settings.

Grouping by Columns 

You can drag a column header to the top of the list in order to group items by that category. 
You can also drag more than one header if you want to create subgroups. For example, if the 
Location column is dragged up to this position, all items will be grouped by location. Dragging 
the Mfg Name header creates a subgrouping under Location. Drag the column headers off to 
the left to undo the grouping.
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You can choose to hide or display particular columns within a pane. Clicking the Column 
Selector will open a list of the available columns for the selected content. To hide a column, 
uncheck the box next to the column title. To display a column, mark the box with a check. You 
may also see this feature in other modules.

Clicking on Column Selector at the top left corner of the Search Results list displays a list of 
available columns. Column order, column size and contents can be arranged and saved, 
permitting you to organize the display as you desire. Use the scroll bar on the right to see the 
complete list of available columns. Check the column headers you wish to display, and uncheck 
headers you do not want. When you have finished, click on the top left square of the Search 
Results again to hide the column list.

Click Save Grid Settings to save changes to your column format. The format you select will 
appear the next time you access the Inventory Module. However, the Under Par Row Color is a 
global setting activated in the system configuration screen. You may change the color while in 
Inventory, but it will revert to the global system configuration setting the next time you enter 
Inventory.

Searching Inventory

Search for items by specifying values in the Input Inventory Search Criteria section and clicking 
Search. You may also select the number of items displayed in the search result by selecting a 
choice in the Max # of Records drop-down list. Clicking on any column header sorts the fields 
by that header. Items highlighted in red are those whose total quantities are below their par 
value. To highlight these items in a color other than red, select a different "Under Par Row 
Color" using the drop-down box located directly above the search results to change the color 
of the highlighted rows. You can use “Wildcard Search” when attempting to find something. If 
you place a “%” before or after a partial search string and click Search, the application 
searches for any items that fit the criteria. The fields and their individual functions are listed in 
the following table:

Field Description

Bar Code Internally generated barcode number

Mfg Bar Code Manufacturer’s barcode number

Item (Active) When checked, only items marked as Active are displayed.

Item (Under Par) When checked, only items whose quantities are below a desired quantity on hand 
are displayed.

Location The location where an item is stored.

Part Number A required field for each item. May be an internal number or the manufacturer’s 
part number.

Mfg Part Number The manufacturer’s part number.

Exp Date From Specifies a starting expiration date for a search range

Exp Date To Specifies an ending expiration date for a search range

Serial Number Manufacturer’s serial number

Last Ordered Date when the item was last ordered.

Lot Number Manufacturer’s lot number
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Exporting to Excel

The Export button saves the contents of any screen to a Microsoft® Excel file. The default Save 
In location is your My Documents folder, although you may specify any other location. Export 
to Excel includes data for all selected columns and contains all column headings. 

NOTE 
Excel must be installed on your computer in order to use this function.

Adding and Editing Inventory Items

To add a new item, click Add Item. The Item Maintenance screen opens, where you can enter 
information including the item name, cost, packaging, vendor and manufacturer details as well 
as barcode information. Required fields are indicated in bold print. The Quantity in Stock field 
is not enabled. You will be prompted to set a Cycle Count Class and to receive the item once 
you click Save. Receiving an item activates the Quantity in Stock field.

The Type designation indicates whether an item is general stock, diagnostic equipment, or 
interventional equipment. If you have a Results interface, all items in your inventory must be 
designated as the correct type. If you do not have a Results interface, Type is not required, but 
recommended.

To edit an existing item, double-click on the item to be edited. This opens the Item 
Maintenance screen for the selected inventory item. Make your modifications and click Save 
to record or Cancel to discard the changes.

Ordering Inventory Items

Clicking Order brings up the Inventory Order screen. To place an order:

1 Enter the manufacturer name and select the part number from the drop-down list.

2 Select the Order Unit. If you did not specify an Order Unit when adding the item, the only 
option under the order unit field will be EACH (Individual item). 

3 Order the number of items requested in the order under Order Qty.

4 Click Insert Line. 

5 To add more orders, click Clear Criteria to reset the fields. 

6 When you have finished placing your order, click Save Order. The order displays in print 
preview. 

7 You can select Print or click Close to exit. 

You can keep track of order information and status or modify existing orders on the View 
Orders tab. 

Max # of Records Specifies the maximum number of results to be displayed. Selections include 100, 
500, 1000, or ALL.

Manufacturer Name Item manufacturer or vendor

Field Description
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Receiving Inventory Items

You can receive items into inventory from the Inventory Overview screen by double-clicking 
the item to open the Item Maintenance window:

1 Click Receive to begin.

2 Select the storage location from the drop-down list, then enter the quantity. If you must 
enter a serial number for individual items, set the quantity to 1 and enter the numbers. 
You must receive items with serial numbers one at a time.

3 If the item you are receiving is checked as an implantable item and has an additional 
barcode containing information such as lot number, serial number, and/or expiration date, 
scan that barcode into the Attribute Bar Code field. This ensures that, when the item is 
scanned during a procedure, the correct item is removed from inventory.

4 Click Save.

5 You can also indicate an expiration date. If you do not have to enter lot or serial numbers, 
enter all other information, then click Save.

To enter a new location:

1 Click the ellipse button next to the drop-down list. The Location Maintenance screen will 
be displayed.

2 Enter a location name, a brief description (optional) and section (optional).

3 Click Save New.

To edit a location, highlight it in the list and click Update. To delete a location, highlight the 
location and click Delete. If the location is assigned to active inventory items, you will not be 
able to delete it until you have indicated a different location for these items.

It may also be helpful to receive items into inventory from the Orders section so you can verify 
whether you received a complete or partial shipment. If a partial shipment was received, the 
order can be modified. Items can be placed on back order, and an expected date of delivery 
can be inserted for your records. Remember to click Save if you have received or modified an 
order.

Deleting Inventory Items

In order to delete an item, highlight the item in the Inventory Overview list and click Delete. 
You will be prompted to click Yes to delete or No to cancel. The item record is not actually 
deleted, but instead has been made inactive. You can review inactive items by unchecking the 
Active box and clicking Search. If you have accidentally deleted an item, you can restore the 
item to current inventory by opening the item record and rechecking Active in the Item 
Properties section.

Reports

The Inventory Overview screen allows you to view and print some preset reports. Click the 
Reports drop-down list to specify the type of report to be generated:

• Items: Displays a report of all items in the search results list, arranged by manufacturer.
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• Below Par: Displays a report of items under par, arranged by manufacturer. Items under 
par are highlighted by color in the search results.

• Location Inventory: Displays a report of items arranged by location. Items that have not 
been assigned a location are displayed first on the report.

• Expiration Aging: Displays a list of items with expiration dates, arranged by location.

To print a report, select the type, enter desired search criteria, and click Search. The Preview 
and Print buttons become active. To view the report prior to printing, click Preview. To print 
the report, click Print.

4.6.2  Inventory Maintenance

There are several tools available to help you maintain all aspects of your inventory, from items 
to categories, manufacturers, vendors, cycle counting, and locations. To access the 
maintenance screens, click MODULES > INVENTORY > MAINTENANCE and select the 
appropriate screen from the list.

Item Maintenance

The Item Maintenance screen contains all data about a specific inventory item. You can access 
the Item Maintenance screen by clicking on an item in the Inventory Overview list. This 
displays the properties for that item. The controls for performing maintenance on an item 
appear at the top of the screen. The specific controls and their functions are listed in the 
following table:

Within the Item Maintenance screen, the different categories of information are grouped into 
several sections. The Identification section contains information about the item itself. The 
fields and their functions are listed in the following table:

Button Description

Add New Adds a new item.

Edit Edit information for an existing item

Receive Activates the fields in the Receiving/Putaway section.

Transfer Activates the fields in the Transfers section.

Delete Deletes an item.

Cancel Cancels any operation without saving.

Save Saves any modifications.

Field Description

Part Number (Required) A unique identifying number. This can be a facility-generated number or the 
manufacturer’s part number.

Mfg Part Number The manufacturer’s part or catalog number

Manufacturer (Required) The manufacturer of the item

Vendor Allows you to indicate a preferred vendor, if you do not order an item directly from 
the manufacturer
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To add a manufacturer or vendor, click the ellipse button next to the field. This opens the 
Manufacturer Maintenance or Vendor Maintenance screen. You may add a category to the 
Categories list, as well (see section 4.6.2 ‘Inventory Maintenance’).

The Pricing section contains information about costing. The fields and their functions are listed 
in the following table:

The Properties section contains information such as whether an item is currently used, 
consignment status, etc. The fields and their functions are listed in the following table:

Item Name (Required) The name of the item

Item Description A brief description of the item

Mfg Bar Code The manufacturer’s barcode

Bar Code An internally generated barcode

Categories Used by the Menu Builder when adding Inventory Items to menus (see section 4.11 
‘Menu Builder’).

Category List A list of all categories to which an item belongs

Type Used to specify whether the item belongs to a General, Diagnostic or Interventional 
equipment group. Default is General.

Field Description

List Cost The manufacturer’s suggested retail price

Cost The cost to your facility

Patient Cost The cost charged to the patient

Charge Code Will appear on the patient’s bill

Chargeable Denotes whether or not an item is chargeable. If not checked, the item will be 
maintained in Inventory, but will not appear on patient bills.

Category Code (C-Code) Device category code. Determining which category code is applicable for a specific 
item will be the responsibility of the billing facility.

Field Description

Active Item is currently in use.

Consignment Item is used on a consignment basis.

Critical Item is considered critical to the department and should not go under par.

Evaluation Item is being evaluated for inclusion in active inventory.

Investigation Item is part of a research or clinical trial.

Non Stock Item is not routinely stocked in the department and is being used during a 
procedure.

Stocked in Lab Stock is kept in procedure room.

Implantable Stents, ICDs, pacemaker generators, leads, etc.

Field Description
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If you have assigned the Implantable attribute to an item, you will be prompted during 
charting to enter the item’s lot number, serial number, and/or expiration date (see “Charting a 
Procedure” on page 30).

The Packaging section allows you to indicate the order unit for an item. In many cases, items 
are ordered in bulk quantities, although they may be dispensed as individual items from 
inventory. The fields and their functions are listed in the following table:

The Print Barcode Labels section allows you to print internally generated bar codes onto labels 
which can then be placed on the product. The fields and their functions are listed in the 
following table:

To generate an internal bar code for an item, click Barcode in the Identification section. Once a 
barcode has been generated, the BarCode Labels button becomes enabled. Clicking on this 
button section activates the remaining fields in the section and causes the Preview and Print 
buttons to appear at the top of the screen. You may then specify the quantity, size, and format 
of the labels to be printed. Two formats of Avery labels are currently supported. To preview 
the label sheet, click Preview. To print, click Print.

The Inventory/Ordering section of the screen contains information such as the quantity 
currently in stock, quantity on order, and the date of the last order for that item. The Reorder 
Level is the level of stock at which an item should be marked for reordering. Min Order Qty 
specifies the smallest amount to order at a time when building a new order for the item. If you 
know how many days it takes to fill an order, you can enter that information in the Order Lead 
Time field. The fields and their functions are listed in the following table: 

Field Description

Qty Per Case Quantity of items in a case

Qty Per Box Quantity of items in a box

Qty Per Pack Quantity of items in a pack

Field Description

Labels to Print Specify the quantity and size of the labels.

Formats Specify the type of barcode that will be printed on the labels.

Field Description

Quantity in Stock The amount of stock currently on hand.

Issue Unit Indicates the number of units issued from stock when an item is used.

Last Order Date The most recent date the item was ordered.

Qty on Order The amount of the item currently on order.

Max Quantity The maximum desired amount of stock for the item.

Order Unit Specifies whether an item is ordered by Each, Case, Box, or Pack. Refer to the 
Packaging section.

Order Lead Time The time in days necessary to complete an order.
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In the event that you perform cycle counting, the Cycle Counting section is where you specify 
the cycle count class of the given item (see section 4.6.2 ‘Inventory Maintenance’). The fields 
and their functions are listed in the following table:

The Receiving/Putaway section contains information regarding an item’s storage location, 
serial and lot numbers, and expiration dates (see section 4.6.2 ‘Inventory Maintenance’). The 
fields and their functions are listed in the following table:

NOTE
Your system must be configured to use the Attribute Bar Code. For assistance, please contact 
your Philips Healthcare representative.

The Transfer section allows you to transfer items from one storage location to another. The 
fields and their functions are listed in the following table:

Reorder Level Indicates the Par amount. When an item’s Quantity in Stock drops below this 
number, the item will be highlighted in red on the Inventory Overview screen.

Min Order Qty The smallest amount of the item that should be ordered.

Critical Quantity The amount of an item that must be in stock at any given time.

Field Description

Cycle Count Class A, B, or C, depending on the Cycle Count frequency

Last CC by Item Displays the last time a Cycle Count by Item was performed on the selected item.

Last CC by Location Displays the last time a Cycle Count by Location was performed on the selected 
item. 

Last CC by Item w/Attr Displays the last time a Cycle Count by Item with Attributes was performed on the 
selected item.

Field Description

Receive Item Into Specify the location that the item will be stored.

Qty To Receive The amount being stored at the stated location.

Lot Number A number provided by the manufacturer for tracking purposes.

Expiration Date Expiration date of the item, if applicable.

Serial Number A unique number given to an item.

Attribute Bar Code A bar code containing the serial number, lot number and expiration date of an item.

Field Description

Transfer Amount Specify whether the Entire Quantity or Partial Quantity of an item is to be 
transferred

Location Qty The desired amount of items to be transferred, if Partial is selected.

From Specify the current location of the items to be transferred.

To Specify the destination of the items to be transferred.

Field Description
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The Miscellaneous section contains information about item substitutions. The fields and their 
functions are listed in the following table:

Category Maintenance

Inventory categories are designed to group similar inventory items and to link items with 
charting in menus (see “Charting a Procedure” on page 30). Inventory items may belong to 
more than one category. An item can be placed in a category in the Item Maintenance screen 
or added from the Category Maintenance screen. The category is then associated with 
inventory items in the menu builder (see section 4.11 ‘Menu Builder’). You can create 
categories by vendor or size, but keep in mind if the categories are too general they may 
generate a large charting detail list (see “Charting a Procedure” on page 30). You may also 
export your category list to Excel by clicking Export.

Adding, Editing or Deleting a Category

To add a category, access the Category Maintenance screen. Type a name in the Category field 
and, if you want, a brief description, then click Save New. Your new category appears in the 
list.

To edit an existing category, highlight the category in the list, make changes and click Update to 
save the changes.

To delete a category, highlight it in the list and click Delete. You will be prompted to click Yes to 
delete the category and all associated items, or No to cancel. The items are not deleted from 
inventory, only the category and its associations.

Adding Items to a Category

There are two ways to add items to a category. The first is to associate an inventory item with a 
category when you add the item to inventory:

1 Click the Categories drop-down list and select the category.

2 Click the  +  key to associate the item with that category, which will appear in the 
Categories list.

You may associate an item with multiple categories. If you find that you need to create a new 
category with which to associate an item, clicking the ellipse button opens the Category 
Maintenance screen.

The other option is to add items to a category from the Category Maintenance screen:

1 Click on a category in the list to highlight

2 Click the Part Number drop-down list and select a part number.

3 Click Save New to add the item to the category.

Field Description

Substitute Part Exists Denotes whether a similar item may substituted for the currently selected item.

Substitute Information Information regarding the use of a substitute part.

Comments Enter additional notes or comments.
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4 Clicking the ellipse button next to the Part Number drop-down list opens the Inventory 
Overview screen.

Once you have added items to a category through either method, you can view the associated 
items by clicking the + next to each category to expand the list of items.

Deleting Items from a Category

Deleting items from a category can also be done from the Category or Item Maintenance 
screens. To delete an item from a category in the Category Maintenance screen, expand the 
category items list, highlight the item you wish to delete, and click Delete. You will be 
prompted to click Yes to delete the item from the list, or No to cancel.

To disassociate an item from a category from the Item Maintenance screen, highlight the 
category in the Categories list and click the -  key. Click Save to accept the changes or Cancel to 
cancel the operation.

Cycle Counting Maintenance

A cycle count is an inventory management procedure where a small subset of inventory is 
counted on any given day. Cycle counts differ from traditional physical inventory counting in 
that a physical inventory count stops operation at a facility until all items are counted, audited, 
and recounted. Cycle counts are less disruptive to daily operations, provide an ongoing 
measure of inventory accuracy and procedure execution, and can be tailored to focus on items 
with higher value or movement.

Ranking items into A, B, and C groups—either by value or volume—should be the basis for 
cycle counting schedules. As a sample configuration, inventory items belonging to group A 
could be counted once or twice a month, B items once or twice per quarter, and C items once 
or twice per year. Scheduling cycle counts can be done on the Configuration Settings screen.

Cycle Counting Overview

The Overview screen allows you to view existing cycle counts without making changes to the 
data. By entering data into the appropriate search criteria fields, you can search for certain 
cycle counts. To list all cycle counts, click Search without inputting any search criteria. Note 
that cycle counts are not generated from the overview screen.

As is the case with many search results pages, you may group cycle counts by any column or 
series of columns by clicking and dragging column headers to the blue section labelled “Drag a 
column header here to group by that column.” You can sort in ascending or descending order 
by clicking the column header. The search criteria fields and their functions are listed in the 
following table:

Field Description

Repository Allows you to review cycle count information for a specific repository.

Bar Code Barcode number assigned to inventory item by the internal barcode generation 
feature.

Mfg Bar Code Manufacturer’s barcode number.
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To perform a search, enter the desired criteria and click Search. Clear Criteria resets all fields.

You may print your search results as a worksheet for performing a cycle count, or as a final 
report after adjustments have been made. To preview the report, click Preview, and click Print 
to print.

You may also export your search results to an Excel spreadsheet by clicking Export.

Cycle Count Generation

You can generate cycle counts on the Generation tab. By default, the Auto radio button is 
selected, so all criteria fields are inactive. To generate a cycle count:

1 With the Auto option selected, choose a type of report from the Type drop-down box 
(Item, Location, Item w/Attr). 

Manufacturer Name Name of the manufacturer.

Item Name of the item.

Part Number A unique identifying number. This can be a facility-generated number or the 
manufacturer’s part number.

Mfg Part Number The manufacturer’s part or catalog number.

Location The physical location where the item is stored. 

Serial Number Manufacturer’s serial number

Lot Number Manufacturer’s lot number

Exp Date From Specifies a starting expiration date for a search range

Exp Date To Specifies an ending expiration date for a search range

Scheduled From Specifies a starting scheduled cycle count date for a search range

Scheduled To Specifies an ending scheduled cycle count date for a search range

Report Number The cycle count report number

Completed From Specifies a starting completed cycle count date for a search range

Completed To Specifies an ending completed cycle count date for a search range

User Name The user who scheduled the cycle count.

Max # of Records The maximum number of records that will be returned after Search is clicked.

Status CAN (canceled cycle count)

CMP (completed cycle count)

DIS (discrepancy in cycle count)

NEW (new cycle count available)

RCT (recount scheduled due to discrepancy or Item attribute)

REP (report generated and available for cycle counting)

Type Item (returns all items), 

Location (returns all items, separated by location),

Item with Attributes (returns all items, separated by location, lot number, serial 
number, and expiration date)

Field Description
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2 If you want to generate a cycle count for different repository than the one you logged into, 
select the repository from the drop-down menu.

3 Click Auto Generate to generate the cycle counts, which are displayed in the lower half of 
the screen.

To manually generate cycle counts, click on the Manual radio button. This deactivates the Auto 
Generate button and enables all of the previously inactive Criteria fields. In addition to 
selecting a Type of report, you can then specify as many additional criteria as desired to search 
for the specific items you wish to count before clicking on Manual Generate to create a filtered 
list of cycle counts. A wild card can be used by inserting “%” before or after your search 
criteria. To remove an unwanted item from the list of pending cycle counts, select the row 
containing the item, then click Remove. Once all of the unwanted items have been removed, 
click Save to save the report for use on the Confirmation tab, or click Export to save the report 
as an Excel spreadsheet. The search criteria fields and their functions are listed in the following 
table:

Cycle Count Confirmation

After a cycle count list has been generated and saved, you can specify assorted criteria for 
retrieving available, non-completed cycle count reports on the Confirmation tab. Clicking 
Search without specifying any criteria displays the complete list of available cycle counts. Click 
Generate to create a worksheet for counting the items. The report contains the names and 

Field Description

Repository Allows you to select a specific repository in which to generate a cycle count.

Bar Code Barcode number assigned to inventory item by the internal barcode generation 
feature.

Mfg Bar Code Manufacturer’s barcode number.

Item Name of the item.

Location The physical location where the item is stored. 

Part Number A unique identifying number. This can be a facility-generated number or the 
manufacturer’s part number.

Mfg Part Number The manufacturer’s part or catalog number.

Exp Date From Specifies a starting expiration date for a search range

Exp Date To Specifies an ending expiration date for a search range

Serial Number Manufacturer’s serial number

Lot Number Manufacturer’s lot number

Max # of Records The maximum number of records that will be returned once SEARCH is clicked.

Manufacturer Name Name of the manufacturer.

Type Item (returns all items), 

Location (returns all items, separated by location),

Item with Attributes (returns all items, separated by location, lot number, serial 
number, and expiration date)
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locations of each item, the expected (Original) quantity on hand at each location, and a 
column where you can write the actual (or Audit) quantity for each item.

If you find discrepancies between the expected and actual quantities of an item:

1 Enter the Audit quantity in the column next to the item on the Confirmation tab.

2 When you have made all necessary adjustments, click Save. You will be prompted: “Would 
you like to generate a report before saving Audit Quantities?” Click Yes to generate a 
report, or No to continue. 

3 You will then be prompted: “Have you adjusted the audit quantity on each row for 
discrepancies?” Click Yes to continue or No to cancel the operation. If you have adjusted 
the quantity for an item, you must proceed to the Discrepancy/Adjustment tab to 
complete the cycle count.

Cycle Count Discrepancy/Adjustments

If you have found and entered audit quantities for items on the Confirmation tab, you can 
check the quantities for any adjusted items under the Discrepancy/Adjustments tab:

1 Click Search to generate a list of items that were adjusted on the Confirmation screen. The 
items appear with the original and audit quantities. If a particular item is stored in more 
than one location, there will be a row for each location. 

2 Click Adjust to accept the adjustments and record the new quantities to the inventory item 
records. The list clears automatically.

If you have adjusted the quantity of any item, Xper Information Management System 
automatically creates a recount (RCT) report for those items. To perform a recount and 
complete the cycle:

1 On the Confirmation tab, set the Status to RCT and click Search. The items available for 
recount appear in the list.

If necessary, adjust the quantity in the Audit Qty column.

2 If you have made the necessary adjustments, click Save and proceed to the Discrepancy/
Adjustments tab to complete the cycle count (see above). Any adjusted items will once 
again generate a recount. 

3 If no adjustments were made, click Save to complete the cycle count. Completed cycle 
count reports can be viewed in Cycle Counting Overview by setting the status to CMP and 
clicking Search.

Manufacturer Maintenance

The Manufacturer Maintenance screen contains data about the different manufacturers from 
which you may purchase inventory. Since the Manufacturer is a required field when building 
inventory, you must create a list of manufacturers prior to entering items.

To add a new manufacturer, simply fill out the fields and click Save New. The only required 
field is Name, but you may complete as many other fields as you would like. The new 
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manufacturer record appears in the list. The fields and their functions are listed in the 
following table:

To edit an existing manufacturer’s information, double-click on the item in the list, make 
changes at the top, and click Update to save the changes or Cancel to discard them.

To delete a manufacturer from the list, double-click on the item and click Delete. However, if 
you have active items in your inventory that are associated with the manufacturer you wish to 
delete, the application will not allow you to complete the procedure until you have 
deactivated or changed the manufacturer for these items. You can deactivate the 
manufacturer instead by unchecking the Active box and clicking Update.

You can search for a particular manufacturer by entering data in the criteria fields and clicking 
Search. You may preview and print a report of manufacturer data or export the report to Excel 
by using the Preview, Print and Export buttons.

Vendor Maintenance

The Vendor Maintenance screen serves much the same function as the Manufacturer 
Maintenance screen. Vendors are companies or organizations from which you may purchase 
items which are manufactured by other corporations. Unlike Manufacturer, Vendor is not a 
required field in item maintenance.

Field Description

Name Manufacturer’s name

Contact Name Name of your sales contact

Contact Title Title of your contact

Contact Email E-mail address of your contact

Address 1 Address field (P.O. Box, Street address, etc.)

Address 2 Additional address information

City City in which the manufacturer is located

Region State or province in which the manufacturer is located

Mfg Abbreviation Abbreviation or display name (optional)

Postal Code Zip or postal code

Country Country in which the manufacturer is located

Phone Number Manufacturer’s phone number

Fax Number Manufacturer’s facsimile number

Home Page URL of the manufacturer’s website

Active Check to make manufacturer active in Inventory

Notes Comment field
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To add a new vendor, simply fill out the fields and click Save New. The only required field is 
Name, but you may complete as many other fields as you would like. The new vendor record 
appears in the list. The fields and their functions are listed in the following table:

To edit an existing vendor’s information, double-click on the item in the list, make changes at 
the top, and click Update to save the changes or Cancel to discard them.

To delete a vendor from the list, double-click on the item and click Delete. However, if you 
have active items in your inventory that are associated with the vendor you wish to delete, the 
application will not allow you to complete the procedure until you have deactivated or 
changed the vendor for these items. You can deactivate the vendor instead by unchecking the 
Active box and clicking Update.

You can search for a particular vendor by entering data in the criteria fields and clicking Search. 
You may preview and print a report of vendor data or export the report to Excel by using 
Preview, Print and Export.

Location Maintenance

The location maintenance screen allows you to maintain information on the various locations 
in which inventory items may be stored in your facility. The fields and their functions are listed 
in the following table:

Field Description

Name Vendor’s name

Contact Name Name of your sales contact

Contact Title Title of your contact

Contact Email E-mail address of your contact

Address 1 Address field (P.O. Box, Street address, etc.)

Address 2 Additional address information

City City in which the vendor is located

Region State or province in which the vendor is located

Vendor Abbreviation Abbreviation or display name (optional)

Postal Code Zip or postal code

Country Country in which the vendor is located

Phone Number Vendor’s phone number

Fax Number Vendor’s facsimile number

Home Page URL of the vendor’s website

Active Check to make vendor active in Inventory

Notes Comment field

Field Description

Location The name of the location

Active Check if this location is being used to store items
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To add a new location, simply fill out the fields and click Save New. The only required field is 
Name, but you may complete as many other fields as you would like. The new location appears 
in the list.

To edit an existing location, double-click on the item in the list, make changes at the top, and 
click Update to save the changes or Cancel to discard them.

To delete a location from the list, double-click on the item and click Delete. However, if you 
have active items in your inventory that are stored in the location you wish to delete, the 
application does not allow you to complete the procedure until you have changed the location 
for these items (see section 4.6.2 ‘Inventory Maintenance’).

The list of locations, in addition to the fields above, also reports the date of the last cycle count 
performed on items stored in those locations. You may export your location data to Excel by 
clicking Export.

4.6.3  Inventory Ordering

The Inventory Order screens are used to create new orders, or to view existing orders and back 
ordered items. There are two screens: Build Order and View Orders. To access the Order 
screen, click MODULES > INVENTORY > ORDER.

The Build Order tab is where new orders are created. You may automatically build an order 
consisting of all inventory items whose quantities are under par by clicking Build Par Order. 
You may also create orders for individual items. To manually create an order:

1 Select the manufacturer from the Manufacturer Name drop-down list or select the vendor 
from the Vendor drop-down list.

2 Select the part number from the Part Number drop-down list.

3 Select the appropriate unit from the Order Unit drop-down list. If you specified an order 
unit on the item’s maintenance screen, it is automatically selected.

4 Enter the desired quantity in the Order Qty field.

5 Click Insert Line to create the order.

You may continue adding parts from the same manufacturer or vendor, or you may select a 
different manufacturer or vendor and create additional orders. You may delete any line by 
highlighting it in the list and clicking Delete. Clicking Clear Orders clears the screen without 
saving. When you are finished creating orders, click Save Order to generate an order report, 
which is automatically displayed in a preview window from which you can print. If you placed 
orders with more than one manufacturer or vendor, each order appears on a separate page.

The View Orders tab allows you to keep track of your orders. You may search for orders using 
any combination of criteria, then clicking Search to display results. The default grouping is by 
Order Number, then date, and manufacturer and order status. You can also use the filters to 

Description A brief description or comment (optional)

Section The section within a specific location in which an item is stored (optional)

Field Description
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the left of the Search button to narrow your view. If you would like to see any orders that are 
complete, have been voided, or are on back order, check the Yes box, or check the No box to 
see orders that do not meet any of these criteria. If no boxes are checked or other criteria 
indicated, all orders are displayed. Clicking Preview generates a report displaying each order 
on screen along with its status. You may then print the report by clicking Print.

To process incoming orders, click Confirm. Additional columns are activated on the right side 
of the Order Results screen. The additional columns and their functions are listed in the 
following table:

To receive a complete order:

1 Check the COMPLETED box.

2 Select a location from the LOCATION drop-down menu.

3 Click Save. The total quantity and location quantity for the item is updated and may be 
verified on the Inventory Overview screen.

To receive a partial order:

1 Select a unit type from the UNIT REC drop-down menu.

2 Enter the quantity to be received into the QTY REC field.

3 Select a location from the LOCATION drop-down menu.

4 Click Save.

To receive a completed order into multiple locations:

1 Select a unit type from the UNIT REC drop-down menu.

2 Enter the quantity to be received into the QTY REC field.

3 Select a location from the LOCATION drop-down menu.

4 Click Save.

5 Click Search and Confirm to refresh the order status.

6 Repeat as necessary for each remaining location.

You may preview, print and export order data by using the appropriate buttons at the top of 
the screen.

Column Description

Unit Rec The received unit. Note: this should match the Order unit of the item.

Qty Rec The quantity received (may be a partial quantity).

Complete Check if the order is completed.

Void Check if the order is voided.

Back Order Check if the order or any part of it is on back order.

Expected Date The date the remaining number of items is expected.

Modified If a row has been modified by a user, this box will be checked.
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4.6.4  Inventory Transactions

The Inventory Transactions screen is where you may view the log of all actions that have taken 
place in the Inventory module. To access the Transactions screen, click MODULES > 
INVENTORY > TRANSACTIONS.

The Transactions log tracks the following:

• Cycle Count adjustments

• Orders placed

• Orders received

• Orders inserted by Inventory Import Wizard (if you had entered order information in 
your import spreadsheet)

• Items received and the location to which the items were received

• Items transferred and the location to which the items were transferred

The log also displays the user who performed each action.

To view all inventory transactions, click Search, or you may filter search results by entering 
criteria in the appropriate fields. Search results can be grouped by any column header by 
dragging and dropping the column header into the dark blue section of the screen located at 
the top of the list. Clicking on any column header sorts the list by that data. The results can be 
saved as an Excel spreadsheet by clicking Export.

4.6.5  Importing Inventory

Rather than build your inventory manually, you may import inventory data from an Excel 
spreadsheet. To open the Data Import Wizard, click TOOLS> INVENTORY IMPORT, then click 
Import Wizard. A message asking you to be sure the part number are correctly assigned the 
barcodes in the spreadsheet appears. Click OK to continue or Cancel to cancel the import. 
After clicking OK, the file type, Excel spreadsheet, is selected by default in the Import Wizard 
window. To continue:

1 Click Next >.

2 Use the ellipse button to browse to your Excel file. You may also select ANSI or ASCII file 
origin.

3 Click Next >.

4 Set any necessary data formats, such as delimiters, currency symbols, etc.

5 Click Next > to display a preview of the spreadsheet. Click on the header of each column to 
select the data field to which you will import the column data.

6 Click Next > to check the mapping of the spreadsheet columns to the data fields in the 
inventory module (e.g., if your part numbers are in column C of your spreadsheet, map the 
Part_Number destination field to source column C).

7 Click Next > to preview your mappings. If you have mapped a column to an incorrect 
destination field, click < BACK to make corrections, then Next > to check your mappings.

8 Click Next > to view the Summary page 
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9 Click Execute to complete the process.

4.7  Query Wizard

The Query Wizard module allows users to query their data and compile statistical reports, 

extract data elements to other formats (Microsoft® ExcelTM and AccessTM) or write more 
complex SQL queries. To access the Query Wizard, click MODULES > QUERY WIZARD.

The first step in performing a query is to specify a date range (section 1). To set the range, you 
may use one of three methods:

1 Select one of the choices from the Range box (last three months, last 6 months, etc.);

2 Manually enter a From date and To date in the Exact Dates section, or

3 Use the calendar tools to set the From and To dates.

After you have specified a date range, you may click Search to find all the patients that exist for 
those dates, or you may want to refine your search to patients who match specific criteria 
(e.g., all patients who received a specific medication, or all cases performed by a specific 
physician). If you wish to set up additional search parameters, click Next to activate the Query 
Parameters section (section 2).

To create a new filter (a set of search parameters):

1 Click New;

2 Assign a name to the filter;

3 Click Save. This activates the Parameters window.

4 Click Add to create a search parameter. Parameters can be created for data fields or 
charting elements.

To create a data field parameter:

1 In section A, select an operator (AND, OR, NOT, AND NOT, OR NOT) to activate the Folder 
list;

2 From the Folder list, select the source screen (Case Details, Hemodynamics, etc.);

3 From the Fields list, select the desired field and click Next;

4 In section B, select the appropriate statement (equals, between, is greater than, etc.);

5 In section C, set the value to search for. If you have selected a field that could have a high 
and low range (e.g., Age), you will be able to set the high and low values.

6 Hit Enter on the keyboard and click Save Filter.

To create a charting element filter:

1 In section A, select an operator (AND, OR, NOT, AND NOT, OR NOT) to activate the Folder 
list;

2 From the Folder list, select Charting Menus;

3 Select a modality;

4 Select the menu;
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5 Chart through the entire line, then highlight key words from the charting results and drag 
to the VALUE field

6 If the text you are searching for could appear in more than one menu, check IN ALL 
MENUS;

7 Click Save Filter.

After creating a search filter, click Search. The list on the right populates with matching cases. 
You may then select an output type from Section 3:

1 Fixed Report, one of a number of pre-configured reports;

2 Export to Microsoft® Excel or Access;

3 View the filter’s SQL statement;

4 Import the current query statement into the Advanced query module.

This system contains an Advanced query module where users can create raw SQL queries, 
custom reports and charts. The Advanced module is intended for users who have experience in 
writing SQL statements. For more information and assistance, contact Customer Support.

You may also create a custom report incorporating a wide range of formats and data. To create 
a custom report:

1 Click the Custom Reports tab in Section 3.

2 Click Add to open the Custom Report writer.

3 Enter a name in the field labeled “Report Layout Name.

4 Select a format (bar graph, pie chart, raw data, matrix) in step A.

5 Click Next to activate step B.

Depending on the format you selected, you are now able to identify the data fields to be used 
in the report.

To create a bar graph or pie chart:

1 Select the X field (the parameter that appears on the X, or horizontal, axis of the graph).

2 Select the calculation to be performed. You may select Average, Total or Difference.

3 Select the Y field (the parameter that appears on the Y, or vertical, axis of the graph).

NOTE
If you selected Difference, you will be prompted to enter two fields. The first of the two Y fields 
should be the larger value, and the second should be the smaller value.

4 If desired, you may select a field by which to group the results.

5 Click Next. You may then save, preview and save, or cancel without saving the report.

To create a matrix:

1 Select up to three (3) X fields.

2 Select up to three (3) Y fields.

3 If desired, select a field by which to group the results.
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4 Click Next. You may then save, preview and save, or cancel without saving the report.

To create a raw data report:

1 Select up to six (6) fields, clicking Add after each one.

2 If you want to group by a particular field (e.g., room number), select the field and check 
GROUP, then add the field.

3 You may add a user-defined label by entering the desired text in FIELD LABEL. The custom 
label appears as the column header on the printed reports.

4 You can adjust the order in which the data columns appears by highlighting a field and 
using the UP or DOWN arrows to move the field.

5 If you would like to customize the look of your report (e.g., change column width, column 
headers, add calculations, etc.), check the box labeled Use Custom Design, then click 
DESIGN to open the custom report designer. For more information on using the custom 
report designer, please contact Customer Support.

6 Click Next. You may then save, preview and save, or cancel without saving the report.

Once you have created a custom report, it is available in the Custom Reports list to be run on 
demand. Simply run a search and select the custom report you wish to run.

Batch Reporting

Batch reporting allows you to schedule reports to print automatically at a selected interval 
(e.g., daily, weekly, monthly, etc.).

4.8  Kit Builder

Kits are a special tool in this system that allows you to incorporate inventory items, 
procedures, and charting elements in a “kit” that charts all elements with a single click. To 
access the Kit Builder, click TOOLS > KIT BUILDER.

The list of current kits is at the top of the screen. You can review the contents of a kit by 
clicking  +  next to a kit name to expand the tree view. You can search for a particular kit or kit 
type using the search fields. The fields and their functions are listed in the following table.

To perform a search, enter the desired parameter and click Search. To clear the search 
parameters and perform a new search, click Clear Criteria.

Field Description

Kit Name Searches for a kit by name.

Type Searches for kits that contain a particular item type (Menu, Billing Procedure, 
Inventory).

Item Searches for kits containing a specific item.

Description Searches for a kit by description.
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Creating a Kit

To create a kit:

1 Click Add.

2 Enter a name in the Kit Name field. You can then add one of three types of item:

• Menu: items from the charting menus;

• Inventory: items from currently active inventory;

• Billing Procedures: active items from the Procedures table (see section 4.17 ‘Coding’).

To add a menu item:

1 Select the modality from the drop-down list on the left.

2 Select the menu from which you want to chart.

3 As you click through the menu choices, the line is added to the kit. You can put as many 
items as you wish from any menu, with the exception of Inventory items.

To add an inventory item:

1 Find the item under the Inventory tab at the bottom left.

2 Double-click to move the item to your kit. 

You may search for inventory items in the Kit Builder just as you can in Inventory Maintenance 
(see section 4.6 ‘Inventory Management’). The search fields and their functions are listed in 
the following table.

To add procedures:

1 Click the Billing Procedures tab at the bottom left.

2 Select the desired modality.

3 Double-click the procedure you want to add. 

You can search the procedures list by entering a search string in the Procedure field and 
clicking Search. To search a partial string, use the “%” symbol as a wild card (e.g., “%heart” will 
return all procedures containing the term “heart”).

Field Description

Item Search by item name.

Part Number Search by item part number.

Mfg Part Number Search by manufacturer’s part number.

Barcode Search by internally generated barcode.

Mfg Bar Code Search by manufacturer’s barcode.

Location Search by inventory location.

Manufacturer Search by manufacturer name.

Category Search by inventory category.

Max Records Select the number of records to return (100, 500, 1000, or All).
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Once you have added all necessary items, click Save to save the new kit, or Cancel to discard it. 
You can now create a menu item linked to the kit that, when charted, places all items within 
the kit into the appropriate menus in a patient study (see section 4.11 ‘Menu Builder’).

Editing a Kit

To edit a kit:

1 Select the kit name in the Kit Entries list.

2 Click Edit. You will be prompted to confirm that you have selected the kit you wish to edit.

3 Click Yes to continue, or No to cancel and select a different kit.

4 Once the kit has loaded, you may add any of the three types of item.

5 You may also change the order in which items appear in the kit (and the order in which 
they will be entered in charting), by using the Move Up and Move Down arrows.

You may also remove items. Highlight an item, then click Remove, or you can remove all items 
from a kit by clicking Clear All.

After you have made all necessary changes, click Save, or click Cancel to discard the changes.

4.9  List Management

The List Management module allows you to import lists to be used in charting menus (see 
section 4.11 ‘Menu Builder’). The list may be an Excel spreadsheet, or it may be a CSV (comma 
separated values) list. To access the List Management module click TOOLS > LIST 
MANAGEMENT.

To import a list:

1 Enter a name for the list (e.g., “Interventional Physicians”).

2 If a user is required to enter a serial number when charting items from the list, check the 
box labeled “Serial Number required.”

3 Click Import Wizard.

4 Click the ellipse button to browse to your file. You may also select ANSI or ASCII file origin.

5 Click Next >.

6 Set any necessary data formats, such as delimiters, currency symbols, etc.

7 Click Next > to display a preview of the spreadsheet. Click on the header of each column to 
select the data field to which you will import the column data.

8 Click Next > to check the mapping of the spreadsheet columns to the data fields in the 
inventory module (e.g., if your part numbers are in column C of your spreadsheet, map the 
Part_Number destination field to source column C).

9 Click Next > to preview your mappings. If you have mapped a column to an incorrect 
destination field, click < Back to make corrections, then Next > to check your mappings.

10 After importing a list, you may preview it by clicking View. If you are not satisfied with the 
list, click Reimport to repeat the process and make any changes.
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After importing a list, you may want to designate titles for the columns, which can be used as 
key words when building scrapers. To rename column headers:

1 Highlight the name of the list and click Load Import. The list will appear in the Imported 
Table window.

2 Click on a column to load the title into the Column Name window.

3 Rename the column and click Update.

4 Continue until all column titles are changed.

5 You may delete a column entirely by highlighting it and clicking Delete.

6 Click Save Changes to save the new titles, or click Cancel Changes to discard.

Once a list has been successfully imported, you may associate it with an item in the Menu 
Builder so that it can be used when charting a procedure (see section 4.11 ‘Menu Builder’).

If you have unwanted lists or lists you no longer want to use, you may hide them so that they 
will no longer be displayed in List Management or in the Menu Builder. To hide a list, uncheck 
the Active box next to the list name. To display inactive lists, uncheck the Show Only Active 
box.

4.10  Registry Lists

The Registry Lists module is specifically meant to enable users to maintain the lists utilized by 
the ACC Registry screens. These include Medications, Closure Devices, Lesion Segments, and 
Intracoronary Devices. The ACC updates these lists frequently, so it is important to maintain 
the lists by making any necessary additions or to hide obsolete items.

To add a new item to one of the lists:

1 Click TOOLS > REGISTRY LISTS to open the module.

2 Select the list you wish to edit from the List Name drop-down menu.

3 Enter the description of the new item in the Display Value field.

4 Click Add New. The entry will be added to the bottom of the list.

To update an item:

1 Select the correct list from the drop-down menu.

2 Double-click the item you wish to update.

3 Make the desired change in the Display Value field.

4 Click Update to save the change.

To hide an obsolete item:

1 Select the correct list from the drop-down menu.

2 Double-click the item you wish to hide.

3 Check the Hidden box next to the Display Value field.

4 Click Update to save the change.
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4.11  Menu Builder

The Menu Builder utility is a powerful tool that gives you the ability to fully customize your 
charting menus. You can create menu sets for each modality, edit existing menus, copy menus 
from one modality set to another, or delete unused or unwanted menus.

To access the Menu Builder, click TOOLS > MENUS BUILDER. The builder opens in the default 
modality (X-Ray Angiography). To edit menus in a different modality, click the MODALITY drop-
down list and select the modality in which you wish to work.

4.11.1  Menu Builder Screen

The Menu Builder screen consists of several sections:

• Main Menus list: Located on the left side of the screen, this is the list of existing menus 
for the selected modality. You will also find the command buttons to Add, Delete, or 
Duplicate a menu.

• Current Menu: The top center section of the screen is the section in which you will build 
and edit menu entries.

• Fixed Items/Global Fixed Items: The bottom center of the screen contains groups of 
fixed items (see below) that are used when building or editing menus.

• Edit Tools: At the very bottom of the screen are the tools used to insert charting 
statements into a menu, to save entries, or to delete existing line items.

• Menu Characteristics: The right side of the screen contains several tools for building 
special functions into your menus and to change the layout of the charting line items 
within a menu (see below). There is also a notification message to tell you whether you 
have selected a regular menu item or a fixed item in a group.

• Modality Selection List: This drop-down list allows you to select the menu set for the 
specified modality.

• Menu Status: The window at the top of the screen will indicate whether the menu can 
be edited, or whether it is locked by another user. If the status window displays a “READ 
ONLY” message and the menu builder title bar is highlighted in red, another user is 
currently working in that menu, and you will not be permitted to make changes until the 
other user has released the menu. A “READ/WRITE” status indicates that you can make 
changes to the menu.

You will also notice that the left margin of the Main Menus section and top margin of the Fixed 
Items section are collapsible. You can temporarily close these sections to give yourself more 
room to work by clicking on the arrows. Clicking the arrows a second time reopens these 
sections. You can also click and drag the arrows to resize these sections.

4.11.2  Creating and Deleting Menus

To create a menu:

1 Select the desired modality.
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2 Click Add at the bottom of the Main Menus section. The Current Menu section clears, and 
the cursor flashes in the MENU DESCRIPTION field.

3 Type in the name of your new menu and select a menu icon from the Image drop-down 
list.

4 Click Save at the bottom right. The new menu (with icon) appears in the list at the left. The 
menu title also appears at the top of the Current Menu section.

To delete a menu:

1 Click on the menu title in the Main Menus list.

2 When the Current Menu screen has updated to display the selected menu, click Delete at 
the bottom left.

3 You will be prompted: “Are you sure you want to delete the following menu: {Menu 
Name}?” Click Yes to delete (or No to cancel). The menu will be deleted from the list.

To duplicate a menu to a different modality:

1 Click on the title of the menu you want to duplicate.

2 Click Duplicate at the bottom of the menus list.

3 You will be prompted: “Are you sure you want to duplicate the following menu: {Menu 
Title}?” Click Yes to proceed.

4 You will then be prompted to choose the modality to which the menu will be copied, and 
to rename the menu (if desired).

5 Click Duplicate to proceed. Once the menu has been duplicated in the selected modality, 
the system will report “Menu has been duplicated.”

6 Click OK to clear the message.

7 Choose the modality from the drop-down list. Your new menu will appear in the Main 
Menus list, where you can make any changes.

4.11.3  Building and Editing Menus

Levels and Sublevels

Once you have created a menu, you need to build charting statements into it. The menu 
structure is a tree view, with levels and branching sublevels.

To begin adding levels:

1 Click on the menu title at the top of the Current Menu section and click Add Sublevel.

2 Type the first line of charting into the Menu Description field.

3 Click Save. The line will be inserted under the menu title in the Current Menu field. If you 
want to create a “remark” statement that will be seen on screen as instructions to the 
users, but will not be charted into the procedure, you must enclose it with vertical pipes ( 
|REMARK| ).
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To add subsequent lines on the same level, click on the new line item, then click Add at 
Current Level. Type in the next line item and click Save. You will now have two line item entries 
in your menu.

But what if the entries you have added have associated sublevels? To add sublevels:

1 Highlight the line item in the first level (not the menu title).

2 Click Add Sublevel. You can then type in the first associated entry.

3 Click Save. You will now see a sublevel under the “parent” line item.

4 Continue building your menu, using either Add at Current Level or Add Sublevel to place 
your entries where you want them. Your menu will start to expand into a “tree” view of 
levels and sublevels.

To delete a line item from any level, highlight the item and click Delete. You will be prompted: 
“Are you sure you want to delete the following node: …...” Click Yes to delete the item, or No to 
cancel. 

NOTE
If the item you are deleting has sublevels associated with it, they will also be deleted.

Variable Items

Variable items, when built into a menu, prompt the user to enter data from the keyboard, such 
as the amount of a medication administered during a procedure, a date, or name. The 
essential characteristic of a variable item is the DATA TYPE, along with the optional elements of 
UNIT TYPE and MASK. To create a variable item, use Add at Current Level or Add Sublevel and 
enter text into the Menu Description field, then check the VARIABLE ITEM box. You then assign 
the data type to the new item.

There are seven data types that you can assign to a variable item:

After you have chosen the data type, you can use the MASK element to change the format, if 
you wish. For instance, you might want to change the date format to DD/MM/YYYY. If you 
want to use the default format, you do not need to assign a mask. You can also create your 
own custom masks.

The final element of a variable item is the Unit Type. Assigning a unit type attaches text to a 
variable entry typed by a user. For example, you may create a variable item using the data type 
Number, “Heparin drip @,” and assign a unit type of units/hr. When a user charts a Heparin 

Data Type Definition

Text accepts any keyboard character, alpha, numeric, or other.

Number accepts whole numbers (see Float).

Date accepts a date. The default format is MM/DD/YYYY.

Time accepts a time. The default format is HH:MM:SS in military time.

True/False accepts a “True” or “False” response.

Float accepts a numeric value containing decimals (see Number).
4522 170 25991 Xper Information Management System 2.3  Instructions for Use



114  Menu Builder Extended Operation

P
h

ili
p

s 
H

e
al

th
ca

re
drip and is prompted to enter the amount, the application will attach “units/hr” to that entry. 
The resulting charted entry might read: “Heparin drip @ 1000 units/hr.”

Items can be added to the Unit Type list if you need them. To do this, click the ellipse button 
next to the Unit Type drop-down list. This opens the Unit Type edit window. To add a new unit 
type.

1 Click Add.

2 Enter the desired text in the Display field. Enter a description in the Description field if 
desired.

3 Click Post to add the new type to the list.

You can edit an existing item by highlighting it and clicking Edit. Make the desired changes, 
then click Post to save the change.

To delete an item, highlight it and click Remove. Click OK to save and close the Unit Type 
window. Click Cancel to exit without saving.

Fixed Items and Global Fixed Items

In some cases, you may want to use the same group of items as a sublevel for more than one 
line item. While you could type in the same entries over and over, the Fixed Items section 
allows you to build the group once, and then assign it to the line items you have already 
created. If you want to use the same group for more than one menu, you will create a Global 
Fixed Items group. Either way, the process is the same.

To create a new group, click in the Fixed Items (or Global Fixed Items) section and click Add 
Groups. Type the name of your group in the Menu Description field and click Save. Your new 
group title appears in the list. From there, simply use Add Sublevel to insert the line items 
within your group. It is basically the same process as building the menu itself. You can build 
sublevels and include variable items, whatever you need to do.

Once you have built your group, you can add it to the line items above by clicking on the title 
and dragging it up to the item or items to which it belongs. You can even drag a group onto 
another, previously placed, group item. If you need to make changes to a group, the changes 
are automatically applied to the menu items, so you do not have to reassign the group. To 
remove a group from a menu item, highlight the item and click Remove Fixed Levels.

Global Fixed Items are built and work in the same manner. The difference is that a global group 
are available for all the menus in a modality, whereas normal groups are available for use only 
in the menu in which you created them.

Inventory Items

Inventory items are a special function within the menus. When you create an inventory item in 
a menu, you associate it with an inventory category (see section 4.6 ‘Inventory Management’). 
When the item is charted, the user is presented with a list of the items belonging to that 
category. The user can then select the correct item from the list, or can use the barcode gun to 
enter the item. Once the item has been charted into a patient record, it is decremented from 
inventory, and a charge for the item is generated on the patient’s bill.
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To create the inventory item in the menu, use Add Sublevel to insert the item in the Menu 
Description field, then check the Inventory Item box and select the category from the drop-
down list. Typically, inventory items are enclosed by French brackets ({Sheath}), but this is not 
required.

NOTE 
In order to build inventory items into a menu, inventory must be present and assigned to a 
category. For more information, see the section on Inventory.

Kit Items

Kit items work in much the same way as the Inventory items. Once you have built charting kits 
(see section 4.8 ‘Kit Builder’), you can enter a line in a menu and check the Kit Item box, then 
associate the line item with a specific kit using the Kit Name drop-down list. Like Inventory, you 
must first build your kits before associating them with line items in a menu.

List Items

List items also work in much the same way as the Inventory items. Once you have imported a 
list (see section 4.9 ‘List Management’), you can enter a line in a menu and check the List Item 
box, then associate the line item with a specific list using the List Name drop-down list.

NOTE
ACC Registry lists are not imported using the List Management module, but may still be 
associated with menu items. For information on ACC Registry lists, see section 4.10 ‘Registry 
Lists’.

Menu Attributes

Menu attributes are special characteristics that are applied to all the entries in a menu. They 
are divided into three categories: multiple menu attributes, which may be assigned to as many 
menus as desired, single menu attributes, which may be assigned to only one menu in any 
repository, and line item attributes, which are assigned to line items within a menu. The 
attributes and their functionality are listed in the tables below:

Attributes - Multiple Menus

Attribute Description

Bolded Displays charted items in bold text and prints charted items in bold font in the 
procedure log.

History Charting from designated History menus will populate a study created by the 
Readmit function.

Synopsis If checked, the entries from a Synopsis menu will print in the Case Synopsis report. If 
not checked, entries from the menu will not appear on the Synopsis report.

Lesion Turns on automatic lesion numbering when charting in the specified menu.

No Free Text Disables the Free Text function for the specified menu.

Exclude from Log When checked, charted items from the menu will be excluded from the study’s 
procedure log.
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Attributes - Single Menu

NOTE
If a single menu attribute is already assigned to a menu in your repository, and you attempt to 
assign the same attribute to another menu in the same repository, you will receive a warning 
that the attribute is already assigned to a menu. You must remove the attribute from the first 
menu in order to assign it to a different menu.

Attributes - Line Items

Sedation/Reversal Scraper Attributes

The line item attributes, Sedation and Reversal, are assigned to levels within the menu. These 
attributes mark the line items as keys that will be used in creating data mining scrapers for 
sedation agents and reversal agents on the Sedation Flowsheet. The medications must be 
charted in a specific order: medication name, dose, unit of measure, route of administration 
(e.g., Versed 2 mg IV). If the medication is charted in any other order (e.g., 2 mg Versed IV), the 
scraper will not work. For more information on building sedation and reversal agent scrapers, 
see section 4.2.2 ‘Scraper Creation’.

NOTE
Sedation and Reversal Agent keys should be a single word or phrase, rather than the 
medication name itself. It is suggested that you create a level 1 line item, such as {Narcotics/
Sedation} or {Reversal} to be used as the scraper key.

Attribute Description

Coronary Indicates the menu in which statements from coronary arterial trees will be 
inserted.

Peripheral Indicates the menu in which statements from peripheral arterial trees will be 
inserted.

Monitoring Indicates the menu in which statements will be placed when using the MARK 
feature in monitoring.

Inflate Indicates the menu in which statements from the Merit Intellisystem will be placed.

Dictation Support Indicates the menu in which data from Nuance Powerscribe 360 will be inserted.

Ext Data When checked, data from external systems, such as GE MacLab, will be imported 
into the menu.

Epic Events Indicates the menu in which statements from the Events information from Epic 
Cupid will be placed.

Epic Medication Indicates the menu in which statements from the Medications information from 
Epic Cupid will be placed.

Epic Staff Indicates the menu in which statements from the Staff information from Epic Cupid 
will be placed.

Attribute Description

Sedation Indicates a line item that will be used to build a sedation agent scraper.

Reversal Indicates a line item that will be used to build a reveral agent scraper.
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Layout Operations

The Layout Operations tools enables you to move items exactly where you want them. If you 
have entered a line item that should be a sublevel of another line, simply click on the item and 
drag it to the “parent” level. To move a sublevel out from under another entry, highlight it and 
use Move Left to place it on the correct “branch” of the menu tree.

To change the order in which items appear on any level, use Move Up and Move Down. Using 
Move Up moves an item as far as the top of its current level. Move Down moves it down the 
“branch” until you have reached the bottom of that particular “branch.” If an item is already at 
the top of its branch, Move Down is active. If it is already at the bottom, Move Up is active.

Apply Changes

Once you have completed work in a menu, click Apply Changes to save all changes. It is also a 
good idea to click this button periodically if you are making lots of adjustments to prevent data 
loss.

4.12  Arterial Tree Builder

Editing an Arterial Tree Template

You can change or replace the existing templates to meet your needs by using the tools already 
described. To change or replace a template, it is best to use a test case to work with. First, click 
on TOOLS>ARTERIAL TREE BUILDER, then select the template you wish to change. Use the 
Tree Editing, Move, and Vessel functions to add, delete or redraw vessels, and adjust their size 
and position. The controls and their functions are listed in the following table:

Tree Editing Functions

Control Description

Art Label Allows the operator to change the display label (top right corner) of a vessel.

Termination Used when creating an arterial template.

Cusp Structure Used when creating new templates to draw non-artery structures, such as the 
aortic cusp or kidneys.

Move Artery Allows the operator to change the location of a vessel.

Move Note Allows the operator to change the location of a note.

Note Used to create and place notes on a tree.

Arrow Used to draw directional arrows from one point to another.

Vessel Artery Used to insert arteries into a template or tree.

Position Used to change the position markers (proximal, mid, or distal) within a vessel.

Vessel Size Allows the operator to adjust the diameter of a vessel using the scrollbar.

Undo Allows the operator to undo the previous ten (10) operations.

Delete Used to delete vessels, arrows, and notes.

Save Template Saves changes to the selected template.
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To draw a non-coronary structure (e.g, aortic cusp, kidneys, etc.), you will use the Cusp 
Structure tool. Click Cusp Structure, then select the type of structure you will draw. If you are 
editing a coronary template, you will need to create an aortic cusp on which you can place 
saphenous vein grafts. Use the other types (Structure 2 and Structure 3), to draw organs or 
other objects.

To add a vessel, click Vessel Artery. You will be presented with a list of vessels appropriate to 
the type of arterial tree you selected. Coronary trees will have a list of coronary vessels, while 
the peripheral trees will have the appropriate list of vessels for that system. Choose the type of 
vessel you wish to draw, or type in your own label and hit Enter on the keyboard. You will then 
be prompted to click on the point of origin of the new vessel. Draw the path of the new vessel, 
then click on the end point to complete the drawing.

NOTE
When drawing any object (i.e., vessel, arrow, etc.), do not hold down the mouse button. Click 
once and release, draw the path of the vessel or object, and click a second time to complete 
the process.

To delete a vessel, lesion or note, click Delete, then click on the object you wish to delete. If 
you wish to delete a note, click on the first character of the text.

The Undo control will reverse up to ten (10) previously performed functions, such as drawing 
lesions or grafts, moving vessels, or adding notes.

You may increase or decrease the diameter of a vessel by clicking Vessel Size. You will be 
prompted to select the vessel you wish to change, then use the scrollbar to increase or 
decrease the diameter.

NOTE
If you wish to change the length or tortuosity of a vessel, you must delete it before redrawing 
it.

You may move an artery, note or lesion to a different location on the tree. To move an artery, 
click Move Artery. Click on the artery you wish to move, then click on the position from which 
the vessel should originate. To move a lesion, click Move Lesion, select the lesion, and click on 
the new location within a vessel or graft. 

Notes are the white text on a tree. They can be vessel labels or annotation added by a 
physician. To move a note, click Move Note. Click on the first character of the note you wish to 
move, then click on the new location. Be careful not to move a note to a location that obscures 
a vessel or lesion, or another note.

The vessel label is the green text that appears in the bottom left corner when you move your 
mouse cursor over the tree. You may change the vessel label by clicking Art Label. Click the 
vessel you wish to relabel, then select from the list or type in a new description and click the 
vessel. Move your mouse cursor over the vessel to confirm the change.

Some vessels do not terminate, but are open or tapered (e.g., left main coronary). In order to 
specify a different type of vessel termination, draw the new vessel. Click Termination. You will 
be prompted to choose one of three types: Closed (the default selection), Half Open, or Open. 
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Half Open will create a tapered vessel that is open at the end. Open will create an open vessel. 
Next, click on the vessel and the termination will change. You can then continue drawing.

Once you have completed the changes, click Save Template to overwrite the old template with 
the new. The new template will then be available for use when creating arterial trees.

4.13  Custom Forms

The Field Builder is a tool that can greatly expand your data collection and query capabilities. 
You can create custom data fields which can be placed on screens (or “forms”) which you 
configure using the Form Designer tool. The custom forms and fields can be accessed by 
operators during a procedure, or you can build data scrapers so that the fields are completed 
automatically as studies are charted. As data is collected, you can query it and create reports 
(see section 4.7 ‘Query Wizard’). To access the Field Builder and Form Designer, click TOOLS > 
CUSTOM FORMS.

Field Builder

The first step to customizing data collection is to create data fields. In the Select Work Area 
section, choose Field Builder to open the module.

To add a new field, click Add Field. This opens the Field Definition section. Required data is 
marked with an asterisk. The fields and their functions are listed in the following table:

Creating a field is relatively simple:

1 Enter a field name. Field names should be one word, or should be separated using an 
underscore character (e.g., FIELD_NAME).

2 Enter a display name, or label. This is the text that will be viewed on the screen by the 
operators.

3 Enter a Page/Group name, or select from the existing groups using the drop-down list.

Field Description

Field Name The name of the field in the database, used in querying data. NOTE: field names should 
be one word, or be connected by underscore (e.g., FIELD_NAME).

Display Name The title of the field that will appear on the custom screen.

Page/Group The group to which a field belongs.

Data Type Identifies the type of data to be entered in the field.

Default Value Optional default value that will appear in the field.

Definition Optional description of the field.

Active When checked, the field will be available in the Forms Designer. If unchecked, the field 
will be inactive, and will not be available for inclusion in new forms.
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4 Select a data type. There are seven data types you can assign to a field:

5 Enter a default value, if desired. The default value will always appear in the field, but may 
be changed.

6 Enter a definition, if desired. This may help when placing the fields on a form.

7 Click Save to add the field to the group, or Cancel to discard the field.

To add a specific pattern to the field, click Add Pattern. It allows users to create field masks or 
use the samples already created. These field masks create their own acceptable data. Once the 
pattern is created, it can be assigned to as many custom fields as needed. The fields and their 

functions are listed in the following table:

To facilitate data collection, you can also associate a list of responses with a field using the Text 
Properties window. The fields and their functions are listed in the following table:

Data Type Definition

Text accepts any keyboard character, alpha, numeric, or other.

Number accepts whole numbers (see Float).

Date accepts a date. The default format is MM/DD/YYYY.

Time accepts a time. The default format is HH:MM:SS in military time.

True/False accepts a “True” or “False” response.

Float accepts a numeric value containing decimals (see Number).

Field Definition

New Mask Name the name of the mask created.

Mask Region region/country appropriate for the mask (ALL, USA).

Input mask pattern to display the information added to the field created.

Test input the way the information typed is displayed on the field created. It does not 
accept information added out of the pattern established.

Sample list of masks available to be used. 

Description description of the mask created.

Save saves the mask created.

Cancel discards the information changes/information added.

Field Definition

Valid Data List entry window for inputting list items.

Max Letters sets the maximum number of characters for a field.

Add (button) adds an item to a list.

Del 1 (button) deletes a selected item from a list.

Del All (button) deletes all entries from a list.

Save (button) saves a list to a text file.
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To create a list of responses for a field, type the desired entries into the Valid Data List, then 
click Add after each entry. You can also specify the maximum number of characters allowed in 
a field using the Max Letters setting. For example, a field set to a maximum length of 20 
characters will truncate any response over 20 characters. You may also select the display style 
for a field, and sort the list alphabetically using the Sort List check box.

If you have created a list that you may want to use for multiple fields, you can save the list to a 
text file format by clicking Save in the Text Properties window. You will be prompted to select a 
name for the list and a location to save it. When you want to recall the list for use with another 
field, click Load and select the location and name. The saved list will be loaded to the window, 
and you can then save the new field.

To edit an existing field, double-click the field in the Field List on the left. You may then make 
any necessary changes and click Save to save, or Cancel to discard the changes.

The Field List contains all custom fields, sorted by group. You can quickly view a field and its 
attributes by expanding the tree view (click the  +  next to a group or field).

As you create more groups and fields, your list may become quite long, which can make 
locating fields somewhat difficult. You can easily find any field using the Find Field Definition 
window. You can search for fields using the Field Name or Definition, or selecting from the 
drop-down lists. The group in which the field appears is expanded in the Field List, and the 
field attributes appear in the Field Definition window. You may then click Update to make 
changes.

Form Designer

After you have created custom data fields, use the Form Designer to create screens that can be 
accessed by operators during a procedure, or by data scrapers. In the Select Work Area 
section, choose Form Designer to open the module. The Field List remains on the left.

The Form Designer screen consists of four sections. The Field List, which contains all the active 
custom fields available, appears on the left. The Form Management section contains the tools 
used to create a form appear at the top. The workspace is divided into two sections, the 
header section at the top, and the form section beneath it.

The header section allows you to place an element that appears at the top of every page in 
your form. You can place fields, boxes, labels, or even images. You can place the same 

Load (button) recalls a saved list to the window.

Display Style - Drop Down 
Fixed

creates a drop-down entry field that forces selection from a list.

Display Style - Drop Down 
Edit

creates a drop-down entry field that allows selection from a list or manual 
entry.

Display Style - Radio Group creates a window containing list items displayed as radio button choices.

Select Pattern allows the application of a pattern to a field (e.g., zip or postal code, social 
security number, etc.).

Sort List check box when checked, sorts a list in ascending alphabetical order.

Field Definition
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elements in the Form section, but you can also add pages so that you can organize your fields 
in a coherent order.

Creating a New Form

To create a new form:

1 Click Load. You will be prompted to enter a name for the new form.

2 Click OK to continue, or Cancel to start over.

3 You can now use the tools in the Form Management section to create your form. The 
controls and their functions are listed in the following table:

Begin building your form by selecting fields from the Field List and dragging them onto the 
form. You can arrange them in roughly the order and position you wish, then use the 

Control Function

Load Loads the selected form to the Designer window.

Save Saves the selected form.

Delete Deletes the selected form.

Unload Unloads the selected form from the Designer window.

Preview Previews the form as a user would see it.

1 Page Adds a page to a form.

Box Click and drag to create a box on the form.

1 Line Click and drag to insert a divider line on the form.

Label Click and drag to insert a label on the form.

Picture Click an drag to insert a picture on the form.

Align Left Aligns the left edges of multiple selected items.

Align Right Aligns the right edges of multiple selected items.

Align Center Aligns multiple selected items on their center points.

Space Equally 
Vertically

Spaces multiple selected items vertically.

Space Equally 
Horizontally

Spaces multiple selected items horizontally.

Align Bottom Aligns multiple selected items along their bottom edges.

Align Top Aligns multiple selected items along their top edges.

Tab Order Can be used to change the order in which users tab through the fields.

Grid Size Changes the size of the alignment grid.
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alignment tools to refine the appearance of the form. If you wish, you may change the grid size 
to make placement easier.

To align fields on the form, you must first select the group you wish to align. Hold the Shift key 
down and click on all the fields that need to be aligned, then click on the appropriate 
alignment control (right, left, center, top, or bottom). Depending on how you have arranged 
your fields (e.g., in two columns), you may have to group the fields more than once and in 
different combinations.

NOTE
The top and bottom alignment tools are used to align fields horizontally across a form, while 
the right, left and center alignment tools are used to align the fields vertically.

Align fields vertically using Right, Left, or Center

Align fields horizontally using Top or Bottom
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Once you have aligned the fields, you can use the spacing controls to evenly space the fields 
horizontally or vertically.

You can group fields on a form by using the Box or Line tool. To insert a box around a group of 
fields:

1 Click Box and drag it to the form.

2 Enter a title for the box, then click OK.

3 You can then drag the box to the appropriate place on the form and drag the corners or 
sides to size it correctly around the desired fields.

To insert a horizontal line between groups of fields, click 1 LINE and drag it onto the form. You 
can then adjust the line’s position, or adjust the length by dragging either end left or right.

To add a label, click Label and drag it to the form. Enter the desired text and click OK, then 
position the label wherever you want it.

To add a background image to a form:

1 Click Picture and drag to the form.

2 A window opens prompting you to point to the image file you wish to import. You may also 
select the image type (supported image types are JPEG, BMP, GIF, WMF, and ICO).

3 Once you have located the image file, click Open. The image appears on the form at the 
insertion point.

4 You may then resize the image by right-clicking on the image and selecting a percentage of 
the original size (100%, 50%, or 25%). You may also resize by dragging the corners or sides.

NOTE
Background images are not stored as part of the Xper Information Management System SQL 
database. If you use an image that is stored in a location that is inaccessible to other users 
(e.g., on your local hard drive), the image will not be visible on other users’ workstations. It is 
recommended that you store the images in a central location on a server that is accessed by all 
Xper Information Management System workstations. If an image is not available to a particular 
workstation, the form appears without the background image.

You can add pages to your form by clicking 1 PAGE. You will be prompted to enter a title for the 
new page, then click OK. You may then place fields and other objects on the new page just as 
on the first. You may change the title of any page by right-clicking on the page tab, then 
selecting Rename Page. Enter a new title, then click OK. To delete a page, right-click on the 
page tab and select Delete Page, then click Yes to delete it, or No to cancel the operation.

Creating a Header

A header is an optional feature that will appear above all pages of a form. The Header section 
is located above the form section, directly below the dark blue line. Click into the grid area 
below the line and drag the bottom to resize your header section. You can then use the Form 
Management tools just as you did when creating your form to add images, fields or other 
elements, with the exception of pages.
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Once you have created your form and header, click Preview to see how the form will appear to 
users and to check the functionality of the fields. Click Design on the preview screen to return 
to the Form Designer and make any necessary adjustments, then click Save to save the form.

Forms Configuration

After creating a form, you must associate it with a procedure modality in order to access the 
form during a patient study. On the Forms Configuration screen, click and drag the form to the 
desired modality (currently, only XA Cine Angiography is supported). The form will be available 
under the SCREENS drop-down menu when a study is open.

4.14  Case Status

The Case Status screen allows users to configure procedure status messages used by the 
Whiteboard viewer (see “Patient Status Viewer” on page 27). To create status messages:

1 Click into the Status Description field and enter the desired status text (e.g., Patient arrived 
in Holding).

2 Select the Status Parent from the drop-down menu (Pre-procedure, Procedure, or Post-
procedure).

3 Select a status color, if desired (if no color is selected, the message color will default to 
white).

4 Click Apply.

The new status message will be available for use on the Status tab on the Case Details screen 
during a procedure.

To edit a status message, select the message from the list, make any necessary changes, and 
click Apply. To delete an unwanted status message, select the message in the list and click 
Delete.

NOTE
The “Removed” status message is a system message and cannot be edited or deleted.

4.15  Room Status

The Room Status screen can be used to monitor which labs are in use at any given time. Any 
station can be monitored, but only hosts and Patient Care Consoles are recommended.

To set up room status monitoring:

1 Click the Station ID drop-down menu and select the IDs of the stations you wish to 
monitor. Host stations are typically indicated by H (e.g., HA, HB, etc.), while Patient Care 
Consoles are typically indicated by M (e.g., MA, MB, etc.).

2 After selecting the desired station IDs, click Save Monitored Stations.

3 Periodically, click Refresh to update the screen.
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4 To view a patient’s procedure log, click on the patient’s name. The log displays in the 
bottom half of the screen.

The Room Status columns will populate with data which can be used to update families, 
manage case flow, and even monitor a patient’s procedure log. The columns and their 
functions are listed in the following table:

4.16  Required Fields

The Required Fields module allows users to designate data fields and menu items as required 
elements in order for a case to be printed or closed. It ensures data integrity and more 
accurate query result. Required fields may be global, for use at all workstations, or local, for 
use at a specific workstation. You may also specify required fields for a particular user type 
(e.g., Nurse, Circulate, Physician, etc.)

To create a required field:

1 Click TOOLS > REQUIRED FIELDS. The Required Fields tab is selected by default.

2 Select the modality, if necessary.

3 Select the screen on which the required field appears. Available screens include the Case 
Details screen, the Sedation Flowsheet, and the ACC and ICD registry screens.

4 After selecting the screen, select the field from the Field Name drop-down menu.

5 If desired, select a resource type. 

NOTE
If you assign a resource type to any field, you must assign resource types to the remaining 
fields in order for them to appear in patient studies. 

6 Click Save.

To create a required menu element:

1 Click the Required Menus tab.

2 Select the modality, if necessary.

Column Description

Status Empty (no patient is active on the station), or Occupied

Station ID The unique, two-letter identifier of each Xper workstation.

Name Name of the active patient.

Procedure Procedure 1 from the Case Details screen.

Physician Physician 1 from the Case Details screen.

Event Event from the Case Details screen (e.g., Patient In, Setup Done, Begin Time, etc.)

Time The time stamp of the displayed event.

Case Number The case number automatically assigned by Xper Information Management System 
on admission of a patient into the system.
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3 Select the menu in which the required element appears.

4 Chart the required element.

5 In the box below the menu, highlight the section of the line that indicates the required 
element. For example, if you want to make “Allergies” a required charting element, chart 
“Allergies: NKA” and highlight “Allergies.” If you highlight the entire phrase, the entire 
phrase will become the required element.

6 Drag the highlighted section to the Required Name list and release.

7 If desired, select a resource type. 

NOTE
If you assign a resource type to any menu element or field, you must assign resource types to 
the remaining menu elements and fields in order for them to appear in patient studies. 

8 Click Save.

9 If you do not want to specify a particular line, but just want to ensure that data is entered 
in the menu, click ANY DATA, then click Save.

After Required Fields have been set up, users are prompted to complete any missing required 
data elements prior to printing or closing a study. If the user double-clicks one of the items in 
the list, the application opens the appropriate screen and highlights the field in red. When the 
user enters the data and hits the Enter key, the application moves on to the next required field.

If you specified resource types for the required fields, the list that is presented is dependent on 
the user type(s) of the staff member who is logged in to the workstation. For example, if the 
user is a physician, he/she is presented with fields that have been assigned the Physician 
resource type. If a user has more than one type (e.g., Nurse, Recorder), the list presented is 
based on how the user has been identified in the Resources table of the study. That is, if the 
user was designated a Nurse on the Case Details screen, he/she only sees those fields that 
were assigned the Nurse resource type. If the user was designated a Recorder, the list only 
contains those fields that were assigned to the Recorder resource type.

If the user was not assigned as a resource in the study, the user sees all fields for his/her types 
(e.g., a user with both Nurse and Recorder types sees fields assigned to both Nurse and 
Recorder resource types).

If the missing data is a menu item, double-click the required menu item to open the indicated 
menu. When the user charts the required element, that element are cleared from the list, and 
the user may move on to the next item.

After all items have been completed, the user may print or close the study.

If the user needs to close the case prior to completion of the study, clicking Cancel on the 
required fields box allows the user to close the study and reopen it at a later time.

If you do not want users to be able to cancel Required Fields, or if you would like users to be 
required to enter their usernames and passwords in order to bypass the required fields, each 
Xper Information Management System Workstation must be configured to disable the Cancel 
button. Contact Customer Support for information and assistance in configuring your 
workstations.
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NOTE
Closing a study using HEMODYNAMICS > CLOSE CASE automatically bypasses required fields, 
regardless of the workstation configuration. If you do not want users to be able to use this 
method to bypass required fields, you must disable the control in the user roles in Portal 
Designer (see section 4.5.1 ‘User-Centric Navigation’).

4.17  Coding

To access the Coding module, click SYSTEM > CODING. From there, you can select the 
particular screen you need to work with.

Tabs in the Coding Module:

• Procedures

• Procedural Codes

• Procedural Modifiers

• Diagnosis Codes

• Crosswalk

• Procedural Coding System (Tab is hidden unless opened)

• Diagnosis Coding System (Tab is hidden unless opened)

4.17.1  Procedures 

The Procedures tab is where you associate your procedures with the corresponding billing 
(CPT) code, charge code, patient cost, and procedure group.

The Procedures table is an integral part of the system, and is used by many other modules, 
such as queries, kit building, billing, and transcription. The procedures you enter on this screen 
are used on the Case Details screen when performing studies, as well. The fields and their 
functions are listed in the following table:

To enter a new procedure, type the name in the Procedure field. You may also enter or choose 
a CPT code or charge code. Click Save New to save the procedure to the list.

Field Description

Procedure The name of the procedure (required).

Procedural Code The CPT code associated with the procedure.

Charge Code The charge code assigned to the procedure for billing.

Cost The cost of the procedure that will be billed to the patient.

Type The type of procedure: General, Diagnostic, Interventional.

Procedure Group The group to which the procedure is assigned (see section 4.18.9 ‘Procedure 
Groups’)

Provider See “Insurance Providers” on page 138.
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To edit an existing procedure, highlight it in the list. Make the necessary changes and click 
Update to save the changes.

To delete a procedure from the list, highlight it and click Delete. You may also export the entire 
list to an Excel spreadsheet by clicking Export. The resulting spreadsheet contains all data from 
the table.

You can use the Criteria window to search for a particular procedure or modality. To search for 
a procedure, enter the name and click Search. If you do not know the entire name, you can 
enter a partial string with a wild card character (%) before or after the string, which returns all 
possible matches (e.g., %catheterization, Aorto%, %gram%). You can search for all procedures 
belonging to a particular modality by selecting the modality from the drop-down list and 
clicking Search. To clear the search results, click Clear Criteria. 

You can sort the list by clicking on the column headers, or group the list by dragging a column 
header to the area at the top of the list. To undo the grouping, drag the column header back 
into the list area.

4.17.2  Procedural Codes

The Procedural Codes tab is where you can enter procedure codes or import the codes using 
Excel. You can also associate modifiers with the codes. The fields are: 

• Procedural Code

• Description

• Modifier

• ID

• System-Version-Catalog

To create a new procedural code:

1 Type a code in the Procedural Code field.

2 Type a description in the Description field.

3 Select a modifier from the drop-down list.

4 If needed, select a coding system from the ID drop-down list. Note that the default coding 
system is the current active system.

4.17.3  Procedural Modifiers

The Procedural Modifiers tab is where you add or import procedural code modifiers. 

To add a procedural code modifier:

1 Type a modifier in the Procedural Modifier field.

2 Type a description in the Description field.

3 If the modifier is applied to all procedure codes, select the Universal check box.

4 Click Save New.
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NOTE

If Universal is set to True, the modifier will be automatically associated with all billing codes 
without requiring user intervention.

To import procedural code modifier, click Import.

4.17.4  Diagnosis Codes

The Diagnosis Code tab is where you add or import diagnosis codes.

To add a diagnosis code:

1 Type a code in the Diagnosis Code field.

2 Type a description in the Description field.

3 Select a coding system from the ID drop-down list.

4 Click Save New.

To import diagnosis code, click Import.

4.17.5  Crosswalk

Crosswalk allows you to create associations between required diagnosis codes to procedural 
(billing) codes. You can associate multiple diagnosis codes to a billing code.

4.17.6  Procedural Coding System

The Procedural Coding System tab is opened only when the ellipsis (three-dot) (...) button is 
clicked on the Procedural Codes tab. This is where a new coding system can be added. Insert 
the coding System name, version, catalog and activation date. The activation date is based on a 
configuration setting under Modules > Cases. The setting uses the coding system based on 
procedure date or admission date.

4.17.7  Diagnosis Coding System

The Diagnosis Coding System tab is opened only when the ellipsis (three-dot) (...) button is 
clicked on the Diagnosis Codes tab. This is where a new coding system can be added. Insert the 
coding System name, version, catalog and activation date. The activation date is based on a 
configuration setting under Modules > Cases. The setting uses the coding system based on 
procedure date or admission date.

4.18  User Tables

There are 13 User Tables which you can customize to meet your facility’s requirements:

• Conditions

• Contrasts
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• FFR site labels

• Lab Ranges

• Other Site Labels (Flex Cardio only)

• Peripheral Site Labels

• Physio Site Labels

• Probes

• Procedure Groups

• Races

• Resource Types

• Rhythms

• Subrhythms

To access the Table Editor, click TOOLS > TABLE EDIT, and select the table with which you wish 
to work.

4.18.1  Conditions

For each modality, users can create a list of conditions that are used to sort procedural data 
and calculations. To create a list, first specify the modality, then enter the condition name and 
click Save New. The condition lists are then available to operators when performing or charting 
procedures in a modality.

4.18.2  Contrasts

The Contrasts table contains the names of the x-ray contrasts that may be used during an 
invasive procedure. The contrasts appear on the Labs/Procedure data of the Case Details 
screen (Contrast Type 1 and Contrast Type 2).

To add a contrast, insert the name of the contrast in the Contrast description field and the limit 
in the Limit field. Clicking Save New to includes the information to the Contrasts list.

To edit an existing contrast, highlight it in the list, make the desired changes and click Update.

To delete a contrast from the list, highlight it and click Delete. You will be asked to confirm the 
deletion. Click Yes to delete the entry, or No to cancel.

4.18.3  FFR Site Labels

The FFR Site Labels list is a list of vessels that are used during invasive procedures to indicate 
where an FFR sample is collected.

To add an FFR site label:

1 Click Clear Criteria to clear the fields. 

2 Enter the desired label in the FFR Site Description field (to display correctly, labels must be 
twenty (20) characters or less). 
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3 Click Save.

To edit an existing site label, highlight the label in the list, make the desired changes, and click 
Update.

To delete a label, highlight it and click Delete. Click Yes to delete the label, or No to cancel the 
deletion.

4.18.4  Lab Ranges

To set lab ranges (a case cannot be open while doing this):

1 From the Tools menu, select Table Edit, then select Lab Ranges.

2 Select a Lab Label and Gender (male, female or non-specific) for any lab result.

3 Type the Low Value, if needed. (It is possible to enter a lab range of > or < with only a high 
value, e.g., <50.)

4 Select the appropriate range indicator from the list (-, >, or <).

5 Type the High Value.

6 Click Save New.

NOTE
Lab ranges are optional. Unless lab ranges are configured for the repository, notification of 
abnormal values are not displayed in the lab series list in a study. If the Xper Information 
Management System does not recognize or cannot interpret an incoming lab value, the lab 
range results are displayed in the Lab Series Non Interpretable grid.

4.18.5  Peripheral Site Labels

The Peripheral Site Labels list is a list of peripheral pressure site labels that are used during 
invasive procedures to indicate where and what type of pressure sample is collected when the 
peripheral site list is checked. You may also select a color for the wave form.

To add a peripheral site label:

1 Enter the desired label in the Peripheral Site Label field (to display correctly, labels must be 
four characters or less). 

2 Select a type from the Type drop-down list. Types include High/Low (H, marks the single 
highest and lowest points on a wave form), Arterial (A), Venous (V), and Ventricular (E). 

3 Select a color. 

4 Click Save New.

To edit an existing site label:

1 Click the label in the list.

2 Make the desired changes.

3 Click Update.

4 Click Clear Criteria to clear the fields.
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To delete a label:

1 Click the label to select it.

2 Click Delete. 

3 Click Yes to delete the label, or No to cancel the deletion.

4.18.6  Physio Site Labels

The Physio Site Labels list is a list of cardiovascular pressure site labels that are used during 
invasive procedures to indicate where and what type of pressure sample is collected. You may 
also select a color for the wave form and a default scale setting. The default scale setting sets 
the pressure scale to the indicated level when the label is applied to the pressure channel.

To add a physio site label:

1 Enter the desired label in the Physio Site Label field (to display correctly, labels must be 
four characters or less). 

2 Select a type from the Type drop-down list. Types include High/Low (H, marks the single 
highest and lowest points on a wave form), Arterial (A), Venous (V), and Ventricular (E). 

3 Select a color. 

4 Select a default scale setting. 

5 Click Save New.

To edit an existing site label:

1 Highlight the label in the list, make the desired changes.

2 Click Update.

3 Click Clear Criteria to clear the fields. 

To delete a label, highlight it.

1 Click Delete. 

2 Click Yes to delete the label, or No to cancel the deletion.

If you have configured your Xper Information Management System to use a language other 
than English, you may map the major cardiac sites with their English equivalent. Labels 
available for mapping are:

Label Description

AO Aorta

AOp Aortic pullback

FA Femoral artery

IVC Inferior vena cava

LA Left atrium

LV Left ventricle

LVp Left ventricular pullback
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Mapping pressure sites enables Xper Information Management System to use the customized 
labels in calculations, such as stenotic valve area calculation.

4.18.7  Other Site Labels

The Other Site Labels list is a list of user-defined site labels in addition to the Physio Site Labels 
that are used during invasive procedures to indicate where and what type of pressure sample 
is collected. You may also select a color for the wave form and a default scale setting. The 
default scale setting sets the pressure scale to the indicated level when the label is applied to 
the pressure channel.

To add a site label:

1 Enter the desired label in the Other Site Label field. 

2 Select a type from the Type drop-down list. Types include High/Low (H, marks the single 
highest and lowest points on a wave form), Arterial (A), Venous (V), and Ventricular (E). 

3 Select a color. 

4 Select a default scale setting. 

5 Click Save New.

To edit an existing site label:

1 Highlight the label in the list, make the desired changes.

2 Click Update.

3 Click Clear Criteria to clear the fields. 

To delete a label, highlight it.

1 Click Delete. 

Click Yes to delete the label, or No to cancel the deletion.

PA Pulmonary artery

PAp Pulmonary artery pullback

PV Pulmonic vein

PW Pulmonary capillary wedge

PWp Pulmonary capillary wedge pullback

RA Right atrium

RAp Right atrial pullback

RV Right ventricle

RVp Right ventricular pullback

SVC Superior vena cava

Label Description
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4.18.8  Probes

The Probes list is a list of thermodilution cardiac output catheters that are used when 
performing thermodilution cardiac outputs during a procedure.

To add a probe:

1 Enter a name (e.g., “S-Tip Swan Ganz”).

2 Enter the manufacturer’s indicated constant for the probe.

3 Enter the volume of injectate that will be used for each cardiac output recording.

4 Enter the French size of the catheter.

5 Click Save.

To edit an existing probe, highlight the label in the list, make the desired changes, and click 
Update.

To delete a probe, highlight it and click Delete. Click Yes to delete the probe, or No to cancel 
the deletion.

4.18.9  Procedure Groups

The Procedure Groups table enables you to create groups for your procedures (e.g., 
Diagnostic, Interventional, Urgent, Elective, etc.) and to assign a priority (high, medium or low) 
to each group. The priority assigned may be used as a filter for the Waiting List to identify 
those patients whose procedures need to be performed as soon as possible (high priority), or 
whose procedures are less urgent (medium and/or low priority).

To add a procedure group:

1 Enter the desired group name in the Group Description field. 

2 Click Save New.

To edit an existing description, highlight the procedure group in the list, make the desired 
changes, and click Update.

Click Clear Criteria to clear the fields. 

To delete a procedure group, highlight it and click Delete. Click Yes to delete the group, or No 
to cancel the deletion.

4.18.10  Races

The Races table is a list of races that are used during invasive procedures to indicate a patient’s 
race or ethnicity on the Case Details screen.

To add a race, click Add, type in the description and click Save New. The new description is 
added to the list in alphabetical order.

To edit an existing race, highlight it in the list, make your changes and click Save New to accept 
the change.
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To delete a race from the list, highlight it and click Delete. You will be asked to confirm the 
deletion. Click Yes to delete the entry, or No to cancel.

4.18.11  Resource Types

The Resource Types list is a list of specialties that can be assigned to user types (Physician, 
Nurse, Circulate, etc.). The specialties are available for selection when adding resources to a 
study.

To add a specialty, choose the resource in the Resource list, type in the description and click 
Save New. The new description is added to the list.

To edit an existing specialty, highlight it in the list, make your changes and click Update to 
accept the change.

To delete a speciality from the list, highlight it and click Delete. You will be asked to confirm the 
deletion. Click Yes to delete the entry, or No to cancel.

4.18.12  Rhythms

The Rhythms table is a list of heart rhythms that are used during invasive procedures to 
indicate a patient’s rhythm on the vitals screen.

To add a rhythm, type in the rhythm in the Rhythms description field and click Save New. The 
new description is added to the list in alphabetical order.

To edit an existing rhythm, highlight it in the list, make your changes and click Update to accept 
the change.

To delete a rhythm from the list, highlight it and click Delete. You will be asked to confirm the 
deletion. Click Yes to delete the entry, or No to cancel.

If you have configured your Xper Information Management System to use a language other 
than English, you may map atrial rhythms with their English equivalent (i.e., Atrial Fibrillation 
or Atrial Flutter). When these rhythms are used during a procedure, A-waves are not marked 
on atrial rhythms.

4.18.13  Subrhythms

The Subrhythms table is a list of heart subrhythms that are used during invasive procedures to 
indicate a patient’s subrhythm complex on the vitals screen.

To add a subrhythm, type in the subrhythm in the SubRhythm description field and click Save 
New. The new description is added to the list in alphabetical order.

To edit an existing subrhythm, highlight it in the list, make your changes and click Update to 
accept the change.

To delete a subrhythm from the list, highlight it and click Delete. You will be asked to confirm 
the deletion. Click Yes to delete the entry, or No to cancel.
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4.19  Patient Billing

The Patient Billing screen allows you to review billing information for patients, to perform 
necessary adjustments and transmit them. To access Patient Billing, click MODULES > PATIENT 
BILLING.

4.19.1  User Settings

If set up in User Settings, Approve Patient Charges will allow users with this attribute to 
process patient billing for patients that they have placed in queue by entering username/
system password on the Billing Queue screen.

The attribute, Billing Override, will allow a user to process patients that have been placed in 
the queue by any user.

4.19.2  Configuration Settings

On the System Setup tab in Configuration Setting, there are four settings under Patient Billing

• Automatic Billing: Xper Connect or IntelliBridge Enterprise will process billing on a 
schedule.

• Manual Billing: User processes manually any cases checked ready for processing.

• Require Billing Approval: Credentials are needed to process billing. User must have 
Approve Patient Charges checked in User Administration.

• Process from pending: If checked then the queued tab is hidden and you can process 
from pending.

4.19.3  Patient Billing

There are three tabs on the Patient Billing screen:

• Pending

• Billing Queue

• Processed

Pending

The Pending tab shows search results (based on search criteria). You can save search 
parameters for reuse.

When a patient is selected, the charges for that patient display. 

If you double-click on a patient, the Search Results display. You can open the selected study 
and make billing adjustments (pre- or post-processing).

When an audit is complete, you can click Send to Queue to add case to the billing queue. The 
screen shows that a case was added to the queue, by whom and when. 
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Billing Queue

Billing Queue displays the studies that were marked for an auditor to work on or process, only 
the studies sent by the logged-in user, not all the queued studies, are displayed.

To display the billing details in the bottom pane, click on a patient in the Queue list.

If Require Billing Approval is checked in Configuration Settings, when you click Process, you 
will be prompted for your username and password.

If you have User with Billing Override privileges, you will be able to process all studies that 
have been queued.

Processed

The Processed tab displays all processed studies (based on search criteria).

To display the charge details in the bottom pane, click on a patient in the Queue list.

4.20  Insurance Providers

The Insurance Provider screen allows you to enter data for insurance companies that can then 
be matched with procedures when different patient costs are required for individual insurance 
providers. 

4.20.1  Creating and Maintaining a Providers List

To create or maintain a provider’s list:

1 Click TOOLS > INSURANCE PROVIDERS. 

The fields and their functions are listed in the following table:

Field Description

Health Insurance 
Company Name

Enter the name of the insurance provider.

Show deleted providers When checked, previously deleted insurance providers will be displayed in the list.

Street Address Street address of the insurance provider.

City/Town City or town of the insurance provider.

Zip/Postal Code Zip or postal code of the insurance provider.

State/Province/County State, province or county of the insurance provider.

P.O. Box Post office box number of the insurance provider.

Country Country where the insurance provider is located.

Phone No. Phone number of the insurance provider.

Contact person’s name Name of the contact person at the insurance provider.

Email address Contact’s email address.

Fax No. Fax number of the insurance provider.
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To enter a new insurance provider, enter the available data and click Save New.

To update insurance provider information:

1 Double-click the insurance provider in the list.

2 Enter the information.

3 Click Update to save the changes or Cancel to discard them.

To delete an insurance provider, highlight the provider in the list and click Delete. The provider 
is removed from the list, but you can view deleted providers by clicking on the checkbox 
labeled “Show Deleted Providers.”

4.20.2  Assigning Providers to a Procedure

To assign multiple providers to a procedure:

1 Open the Procedures table and select the procedure.

2 Select the provider from the Provider drop-down menu.

3 Enter the cost associated with that provider.

4 Click Update.

5 Repeat steps 2 through 4 as necessary for each provider.

You may also assign multiple providers when adding a new procedure. Either way, it is 
important that you first select the provider before entering the patient cost.

4.20.3  Assigning Providers to an Inventory Item

1 In Inventory Overview, double-click the item to which you want to add providers.

2 Click Edit.

Web address URL of the insurance provider’s website.

Group No. Insurance plan group number.

Subscriber ID Insurance plan subscriber ID number.

Optional data 1 Optional notes field.

Optional data 2 Optional notes field.

Optional data 3 Optional notes field.

Optional data 4 Optional notes field.

Description Insurance plan description.

Plan Type 1 Insurance plan type.

Plan ID 1 Insurance plan ID.

Plan Type 2 Insurance plan type.

Plan ID 2 Insurance plan ID.

Tax ID Number Insurance plan tax ID number.

Field Description
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3 Click the ellipse button next to Patient Cost.

4 Select the provider from the Providers drop-down menu.

5 Enter the patient cost.

6 Click Save New.

To ensure that a patient is billed with the correct amount for each item, you must assign the 
correct insurance provider on the Additional Data tab on the Case Details screen.

4.21  Case Report Configuration

The Case Report Configuration module allows you to create custom case report formats which 
can be selected when printing a study. For example, you may want one format for the Holding 
Area and a different format for the preliminary procedure report. To access the Case Report 
Configuration module, click SYSTEM > CASE REPORT CONFIGURATION. The fields and their 
functions are listed in the following table.

To create a report configuration:

1 Enter a name in the Description window.

2 Click Add New. The name appears in the Configuration window below.

3 Select the elements you want to include in the report configuration by checking the box 
next to the element name.

4 You may set the number of copies of a given report element by adjusting the quantity.

5 You may specify the number of copies of a report by setting the Collated Copies quantity.

6 Click Save.

To change the order in which report elements print, highlight an element and use the Up or 
Down arrows at the top right corner of the list to adjust its position. The report elements and 
their descriptions are listed in the following table.

Field Description

Description Enter the name of a new report configuration.

Add New Click to create the new report configuration.

Configuration Drop-down window contains the list of available report configurations.

Delete Click to delete a selected report configuration.

Print column Check the box next to the report element you want to include in a report configuration.

Report Description Lists the report elements that can be included in a report configuration.

Qty (Quantity) Select the number of copies of a report element 

Report Element Description

ACC Prints the ACC Registry screens.

Arterial Tree Prints any arterial trees generated during a case.

Blood Gases Prints any blood gases worksheets generated during a case.
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If you wish to create an additional configuration, type a name in the box and click Add New. 
The previously created configuration will be saved. To exit without saving a report 
configuration, click Cancel All and close the screen. Any configurations you have created in the 
session will be deleted.

4.22  Level of Consciousness/Level of Pain

The Level of Consciousness and Level of Pain lists are used on the Sedation Flowsheet to 
indicate a patient’s level of consciousness and pain. You may customize these lists by clicking 
SYSTEM > CONFIGURATION SETTINGS. Access the Modules tab and select LOC/LOP. You man 
then add codes and descriptions. When the Auto LOC Prompt and Auto LOP Prompt are active 
during monitoring, users may select an entry from the drop-down lists. The selections are 
entered in the appropriate columns on the Sedation Flowsheet. To delete an entry, highlight it 
and click Delete.

To add an entry to the LOC or LOP list:

1. Click Add to insert a blank row.

2. Enter the desired data in the following format: code = description (e.g., A = 
Alert).

3. Click outside of the new row.

You may sort the LOP list by using the up and down arrows to move entries.

Case Details Prints all elements of the Case Details and Labs/Procedure Data screens.

Case Synopsis Prints a report of all charted elements sorted by menu title.

Charge Sheet Prints the list of charges generated during a procedure.

Custom Screens Prints the custom data forms for a case.

Diagnosis Codes Prints the list of diagnosis codes associated with a procedure.

Hemodynamics Prints a report for each hemodynamic condition recorded in a case.

ICD Prints the ICD Registry screens.

Lab Series Prints the list of patient's lab results.

Procedure Log Prints the chronological procedure log for a case.

Sedation Flow Sheet Prints the Sedation Flowsheet format of the vitals record.

Valve Prints any valve gradient samples performed during a procedure.

Still Frames Prints any still frames captured during a case in a 2 x 2 table format.

Vitals Prints the vitals record for a case.

Wave Forms Prints recorded samples, one sample per page.

Wave Forms 6 on 1 Prints recorded samples, six to a page.

Collated Copies Specifies the number of collated reports to be printed.

Report Element Description
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4.23  Patient Historical Links

When a patient has had multiple studies performed at a facility, those studies may be linked so 
that the historical cases are available for review when a new study is started. To configure 
historical links:

1 Click SYSTEM > CONFIGURATION SETTINGS. 

2 Access the Modules tab and select Cases. 

3 Check the desired criteria to create historical links.

NOTE
MRN is the default setting and may only be unchecked when another item is selected. Be 
careful when selecting different historical criteria. Selecting only one (e.g., middle name) will 
link ALL cases in which there is a match. It is recommended that you use a minimum of three 
criteria to create historical links.

Once your criteria are established, a patient’s historical cases will be listed on the History tab 
on the Case Details screen.

4.24  Modality Performed Procedure Step (MPPS)

Some x-ray systems are capable of sending modality performed procedure step (MPPS) 
information. If your x-ray system sends MPPS information, you can configure Xper Information 
Management System to display up to 25 selected MPPS messages during a procedure. To 
configure MPPS:

1 Click SYSTEM > CONFIGURATION SETTINGS. 

2 Access the Miscellaneous tab and select HL7 / Interface. 

3 Select a desired field from the Standard Data Fields drop-down.

4 Click Add.

5 If you want to display a custom data field from your x-ray system, enter the x-ray system’s 
field name in Custom Data Field and click Add.

6 You may change the order in which the information is displayed by using the up or down 
arrows to change the field order.

7 To remove a field, highlight it in the list and click Remove.

During the procedure, the x-ray system sends MPPS data through the Xper Connect or 
IntelliBridge Enterprise interface. Selected fields are displayed on the MPPS tab on the Case 
Details screen.
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4.25  Patient Assignment

For accounts that have integrated this system with Xcelera, the Patient Assignment module 
allows users to merge studies admitted to this system with cineangiography studies from 
Xcelera. To merge a patient:

1 Click MODULES > PATIENT ASSIGNMENT.

2 Select an unplaced patient from the Unplaced Studies list and click Create Patient Folder (if 
a folder already exists for the selected patient, skip to merging additional patients).

3 Enter any necessary data and click Add New Patient. The selected patient will be removed 
from the Unplaced Studies list.

To merge additional unplaced patients to an existing patient folder:

1 Select the additional study in the Unplaced Studies list.

2 Select the patient folder to which the unplaced study should be merged.

3 Click Merge Studies to merge a study and to remove the study from the Unread Studies 
and/or Patient Locator list.

4 Click Merge Study With the Following Patient Folder to merge a study, but without 
removing it from the Unread Studies and/or Patient Locator list.

To unlink a merged study:

1 Open the desired patient folder.

2 Highlight the study you wish to remove.

3 Click Unlink the Following Patient Study.

4.26  Repositories

A repository is essentially a filter applied to menus, procedure lists, and patient studies. 
Repositories allow you to separate your patients into categories (e.g., Pediatrics, Adult, 
Radiology, etc.) and to maintain separate charting menus, inventories, and procedures for each 
repository within the main Xper Information Management System database.

Every Xper Information Management System has a default repository. To create additional 
repositories:

1 Click SYSTEM > ADMIN > REPOSITORY MAINTENANCE.

2 Enter a three-character abbreviation and a description.

3 Enter a facility name, if desired. The facility name that corresponds to a repository will 
print on case report headers and footers.

4 Click Insert.

The new repository is now available. Access to repositories must be assigned to each user 
through the User Administration screen. When users log on, a Repository drop-down list is 
available. Users only see the repositories to which they were assigned access.
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Once a user has logged into a repository other than the default, the repository abbreviation 
appears next to the user name to indicate which repository the user is logged in.

Each repository may have its own menus, inventory and list of procedures. Studies admitted to 
a repository are only accessible when logged in to that repository.
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5 Preventive Maintenance

5.1  Monitor Mounting Integrity

On a monthly basis, confirm monitor mounting integrity, including, but not limited to, boom 
assembly mounts, wall mounts, and rolling stand mounts.

5.2  Monthly Maintenance

On all Xper Information Management System Workstations:

1 Perform Scandisk.

2 Perform Defrag.

3 Clear all Windows event log files.

4 Delete the contents of C:\XIMS\LOGS (excluding Xper Connect, DataCenter, and Central 
Station).

5 Delete the contents of X:\datacenter\bin\logs (DataCenter only).
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6 Messages and Troubleshooting

6.1  Full System Reset

To perform a full system reset:

1 Power the front end off and back on.

2 Terminate the Xper Information Management System application on the workstation.

3 Click START > SHUTDOWN > RESTART. Allow the workstation to reboot into Windows.

4 Log on to the workstation. If necessary, relaunch the application (it may be set to relaunch 
automatically).

If problems still persist after a full system reset, contact Customer Support.

6.2  Troubleshooting Power and Video Issues

6.2.1  No Power to Workstation

1 Turn device on. If no response:

2 Check power cord connection to the back of the unit and to the wall receptacle.

3 If the workstation will still not power on, contact Customer Support.

6.2.2  No Power to Monitor

1 Turn monitor on. If no response:

2 Check power cord connection to the back of the unit and to the wall receptacle.

3 If the monitor will still not power on, contact Customer Support.

6.2.3  No Display on One Monitor

If a monitor is on, but there is no display:

1 Verify workstation is powered on.

2 Check video cable connections on the monitor and workstation.

3 If there is still no display, contact Customer Support.

If one monitor displays images, and another monitor does not:

1 Verify the monitor is powered on.

2 Swap video cable between the monitor displaying images and the blank monitor. If the 
blank monitor displays an image, change the video cable.

3 If the monitor does not display an image after swapping the video cables, contact 
Customer Support.
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6.3  Troubleshooting Audio

If an alarm condition is displayed on the monitor, but no audible tone is heard:

1 Verify the speakers are powered on.

2 Verify the volume is turned up.

3 Verify the audio is not muted.

4 If the speakers are external, verify the audio cable is connected to the correct jack.

5 If audio is not restored, contact Customer Support.

6.4  Troubleshooting Network Connection

When a workstation cannot connect to the network, a “Netfail” message is displayed in red. To 
reconnect to the network:

1 Hold down the Ctrl key and hit F10.

2 If connection is not restored, check the network cable. Make sure it is connected to the 
network card in the workstation PC and to the correct network wall outlet. It may be 
necessary to restart the workstation to restore network connection.

3 Check to see if other Xper Information Management System workstations have network 
connectivity. If not, your Datacenter may be down. Contact your facility’s IT department, 
or contact Customer Support.

NOTE
If network connectivity cannot be restored, you can still continue with a study. Data such as 
charting, vital signs and waveform samples will be stored on the local workstations, and will be 
automatically uploaded to the server when network connectivity is restored. However, remote 
stations, such as the Nurse Station or Central Station, will not be able to display or control 
patient monitoring and vitals data if no network connectivity is available.

NOTE

Rarely, problems with network connectivity can exist whereby the network is not fully 
disconnected but a connection with the Datacenter cannot be established. This can lead to a 
delay of several minutes for the workstation to go into “Net Fail”. If this occurs, Net Fail can be 
induced by disconnection of the network cable or disabling of the network interface card. 
Under these circumstances, please contact your local IT support or call Philips customer 
support for assistance.

6.5  Monitoring Control Screen

The Monitoring Control Screen has one error message that is displayed on the Patient 
Monitoring screen if an error is detected.

• Error Message: OFF
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This message indicates that communication with the front end device has been lost. Verify the 
front end is powered on. Check for airflow from the fan at the back of the unit. Make sure the 
power cord is tightly connected. If the cord is properly connected but you cannot feel airflow 
or hear the fan, contact Customer Support. If there is airflow, use the Windows Shut Down 
routine to restart the Xper Information Management System workstation. If signals are still not 
restored, contact Customer Support.

Customer Support Contact Information

For assistance with your Xper Information Management System, please contact your local 
Philips Healthcare representative.

In the U.S. and Canada, contact Philips Healthcare Customer Support: +1.800.669.1328.
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7 Product Disposal

7.1  Introduction

This section of the Instructions for Use is directed mainly at the body with legal authority over 
the medical device software and the IT equipment on which it is installed. Other users are not 
usually involved in disposal, except in the case of certain batteries.

7.1.1  Passing the Product on to Another User

If this medical device software and the IT equipment on which it is installed are passed on to 
another user, then it must be passed on in its complete state. In particular, the existing user 
must make sure that all the product support documentation—including this Instructions for 
Use—is passed on to the new user.

A new user should be made aware of the services that Philips Healthcare provides for 
installing, configuring and maintaining the medical device software and IT equipment on 
which it is installed, and for the comprehensive training of users.

It must be noted by all existing users that passing on medical device software to new users 
may create serious technical, medical and legal risks. Such risks can arise even if the device is 
given away. Existing users should seek advice from their local Philips Healthcare representative 
before committing themselves to passing on any devices.

When the device has been passed on to a new user, a previous user may still receive important 
safety-related information, such as bulletins and field change orders. In many jurisdictions, 
there is a clear requirement that the previous user communicates such safety-related 
information to new users. Previous users who are unable or not prepared to do this should 
inform Philips Healthcare about the new user, so that the new user can be provided with 
safety-related information.

7.1.2  Final Disposal of the Product

Final disposal is when the medical device software and the IT equipment on which it is 
installed are disposed of in such a way that they can no longer be used for their intended 
purpose.

CAUTION
With respect to disposal, follow the instructions in the documentation of the IT equipment 
on which the medical device software has been installed.
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7.1.3  Fitting, Removing, and Disposing of Batteries

With respect to the fitting, removing, and disposal of batteries, the instructions in the 
documentation of the IT equipment on which the medical device software has been installed 
must be followed.
Xper Information Management System 2.3  Instructions for Use 4522 170 25991



Technical data System Description   153 

P
h

ili
p

s 
H

e
al

th
ca

re
8 Technical data

8.1  System Description

The system contains a number of modules that collect and process cath lab clinical and 
administrative information, making it a powerful data management tool.

8.2  Specifications

The tables that follow represent the minimum specifications for the devices described.

Xper Information Management System Workstation

File Server

Specification Value

Hardware

(minimum 
specifications)

CPU: Intel iCore3 dual core

Memory: 4 GB

Operating System: Microsoft Windows 7 (32 bit)

Video Card: 1280 x 1024

Hard Drive: 1 TB

DVD/Blu-Ray Reader

1 Gb LAN Network Card (can be on-board)

Specification Value

Hardware

(minimum 
specifications)

CPU: Intel Xeon dual core

Memory: 12 GB

Operating system: Microsoft Windows 2008 Server

Video Card: 1280 x 1024

Hard Drive: 1 TB (should be in at least RAID 1 - mirrored)

DVD/Blu-Ray Reader

1 Gb LAN Network Card (can be on-board)
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Hospital Interface Broker

Specification Value

Hardware

(minimum 
specifications)

CPU: Intel Xeon dual core

Memory: 8 GB

Operating system: Microsoft Windows 2008 Server

Video Card: 1280 x 1024

Hard Drive: 1 TB (should be in at least RAID 1 - mirrored)

DVD/Blu-Ray Reader

1 Gb LAN Network Card (can be on-board)
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A Appendices

A1 Network Safety, Security, and Privacy

A1.1 Customer’s Role in the Product Security Partnership

Philips recognizes that the security of Philips Healthcare products is an important part of your 
facility's security strategy. However, these benefits can only be realized if you implement a 
comprehensive, multi layered strategy (including policies, processes, and technologies) to 
protect information and systems from external and internal threats.

The customer is responsible for setting up and maintaining a secure and stable IT environment 
according to general IT standards.

Following industry-standard practice, your strategy should address:

• Physical security (e.g., do not allow unauthorized people to use Xper Information 
Management System)

• Operational security (e.g., make sure that any sensitive information left on the system—
such as exported files—is removed; make sure that users of Xper Information 
Management System do not leave the open system unattended)

• Procedural security (e.g., create awareness with regard to the dangers of social 
engineering; every single user should be given a separate account; do not forget to 
remove an account when it is no longer needed)

• Risk management

• Security policies (e.g., make sure that the Xper Information Management System Service 
Documentation and media are securely stored)

• Contingency planning.

The practical implementation of technical security elements varies by site and may employ a 
number of technologies, including firewalls, virus scanning and anti-spyware software, 
authentication technologies, network segmentation (VLAN—Virtual Local Area Network), etc.

As with any computer-based system, protection must be provided such that firewalls and/or 
other security devices are in place between the medical system and any externally accessible 
systems.

Although the system incorporates state-of-the-art protection mechanisms to protect it against 
the intrusion of malware (for example, viruses), a remote possibility remains that a system can 
become infected. System safety remains guaranteed in all circumstances, but the user might 
notice unfamiliar system behavior and/or performance. If this happens repeatedly, e.g. also 
after the system has been switched off and on again, the user is advised to contact a Philips 
Healthcare service representative to have the system checked and, if needed, to remove the 
malware.
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The USA Veterans Administration has developed a widely used Medical Device Isolation 
Architecture for this purpose. Such perimeter and network defenses are essential elements in 
a comprehensive medical device security strategy.

Additional security and privacy information can be found on the Philips Healthcare product 

security web site at http://www.philips.com/productsecurity.

If you are interested in overviews of validated Security Patches:

• subscribe to the RSS Feed on this subject

• request an account that enables you to download documents illustrating the validation 
status for Xper Information Management System and other Philips Healthcare products 
(to do so, navigate to the “Vulnerability Tables” section of the site).

Antivirus software is not provided with the Xper Information Management System 
Workstation. To protect the data stored in the Xper Information Management System 
Workstation, Philips recommends that you run antivirus software on any Xper Information 
Management System server and all workstations, and keep the antivirus software up-to-date 
on any Xper Information Management System server and all workstations.

WARNING
Philips Healthcare is not responsible for the installation or maintenance of antivirus 
software or for the integrity of the Xper Information Management System infected with a 
computer virus.

Philips Healthcare has qualified the following antivirus applications as being compatible 
with the Xper Information Management System software:

• McAfee 8.8 Antivirus Scanner

Contact your Philips Healthcare service representative for information about qualified versions 
and configuring these applications so they do not affect Xper Information Management 
System functionality or performance. For more details on security, please refer to the 
Appendix, Network safety, security and privacy in the Systems Administrator Guide.

WARNINGS

• When disposing of the hard drive, erase all sensitive privacy information.

• Media such as CDs, DVDs, and printouts need to be disposed of in a secure manner 
when they are no longer needed, since they might contain sensitive privacy 
information.

• It is the responsibility of the users to keep their password secret.

• It is advised to use TLS to secure the communications over TCP/IP networks.

• It is advised to enable Windows Auditing and to inspect the audit log file on a regular 
basis to detect possible security threats.

• Users should guard their sessions and log off when they leave the Xper Information 
Management System Server and/or Workstation.

• Keep rooms where the Xper Information Management System Server and/or 
Workstation are located locked.
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• Make sure that in the BIOS of the Xper Information Management System Server and 
Workstation the option to boot from CD is disabled.

• Make sure that a BIOS password is configured for the Xper Information Management 
System Server and Workstation.

• It is the responsibility of the user to guard removable media at all times.

• Make sure (patient) data is encrypted before transporting it out of the hospital facility.

• Philips recommends installing the validated and published security patches.

• Philips recommends making backup copies of configuration data, the database, and 
the archive as described in the System Administrator’s Guide.

• Trained users are recommended to be careful when deleting patient or study data.

• External circumstances can influence the availability of the clinical data, e.g. network 
failure, power failures, environmental disasters, etc.

A1.2 Security and Privacy Requirements

It is the policy of Philips Healthcare to adhere to all the required standards and regulations. To 
assist the hospital in fulfilling the Health Insurance Portability and Accountability Act (HIPAA) 
requirements, introduced by the United States Department of Health and Human Services, the 
following functionality has been added to the Xper Information Management System:

Access Control

Intended to restrict access to the system to authorized users only:

• customizable on/off, a user Log-on/Log-off procedure is required to gain access to the 
system. Take care that a suitable password procedure is used to log on to your IT 
equipment, for instance:

a Use a mixture of upper- and lower-case letters, digits, and special characters.

b Change the password frequently.

• Access to the system is granted according to a customizable list of authorized users.

Network Time Synchronization

Intended to synchronize system time to an external time-standard:

• Uses a standard Network Time Protocol (NTP).

• The coupling is configured by Field Service during system installation.

Computer systems cannot be guaranteed to be safe in an insecure network. The user should 
provide some level of network protection e.g. installing firewalls.

Field Service

Field Service is used to enable the following configuration items based on information supplied 
by the hospital:

• authentication and encryption
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• time synchronization

• configuration of any other programs

HIPAA Security and Privacy rules

HIPAA defines a number of physical and technical safeguards which are either required or 
addressable. Some features, that could implement these functions, are differently 
implemented or not implemented, for reasons mentioned below:

Backup Procedure

It is not the intended use of the system to permanently store electronic personal health 
information. Information should be exported to a storage device as soon as possible.

Emergency Access Procedure

The system supports a generic emergency account. However, the user should be aware that 
the knowledge of this generic account and access to the system should be restricted to avoid 
unwanted access to electronic personal health information.

Automatic Logoff

The system supports automatic activation of the logoff function with administrator adjustable 
expiration time.

A2 Hemodynamic and Lab Value Conversion Calculations

A2.1 Hemodynamic Calculations

The following equations for the calculation of hemodynamic parameters are taken from 
William Grossman’s Cardiac Catheterization and Angiography, 3rd Ed., Philadelphia: Lea & 
Febiger, 1986.

Body Mass Index (BMI)

• BMI = (Weight kg)\((Height2 cm) \ 10000)

Body Surface Area (BSA):

• BSA (m2) = 0.007184  *  weight 0.425k g *  height 0.725cm 

Assumed O2 uptake:

• O2 (assumed) = K * BSA (K derived from LaFarge table)

Where 133 is a sample value that will be input from the LaFarge tables, as published by 
LaFarge CG, Miettinen OS: The estimation of oxygen consumption, Cardiovascular Research 
4:23, 1970.

In addition to the values derived from standard formulas, the Xper Information Management 
System contains a number of computer calculated values, such as dp/dt, Vpm, Vmax, valve 
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mean gradient, and valve period that are the result of digital wave form analysis. Their values 
are more the result of definition than equation.

Oxygen Content:

• ml O2 / L Blood = Hgb  * 1.36  *  10  *  % Saturation

Systemic Venous O2 (Flamm’s Equation):

• SV O2   = (3(SVC O2) + 1(IVC O2))/4

If RA, RV, or PA saturation is collected and is lower than the result produced using Flamm’s 
equation, the lowest saturation is used for systemic venous O2.

A-V O2 difference:

• A-VO2 = systemic arterial O2 content - systemic venous O2 content

V-A O2 difference:

• V-A O2 = pulmonary venous O2 content - pulmonary arterial O2 content

V-V O2 difference:

• V-V O2 = pulmonary venous O2 content - systemic venous O2 content

Pulmonary flow:

• Pulmonary flow (Qp) = Assumed O2/(PV O2  content - PA O2 content)

Oxygen Saturation Pressure Location Priority

Systemic Venous O2/Pressure RA (right atrium)*

RV (right ventricle)

IVC + SVC (Flamm’s equation)

IVC (inferior vena cava)

SVC (superior vena cava)

Systemic Arterial O2/Pressure FA (femoral artery)*

AO (aorta)

LV (left ventricle)

LA (left atrium)

Pulmonary Venous O2/Pressure PV (pulmonary vein)*

PW (pulmonary capillary wedge)

LA (left atrium)

LV (left ventricle)

AO (aorta)

Pulmonary Arterial O2/Pressure PA (pulmonary artery)*

RV (right ventricle)

RA (right atrium)

SVC (superior vena cava)

*Default locations used for pressure/saturation priority
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Systemic flow: 

• Systemic flow (Qs) = Assumed O2/(SA O2  content - SV O2 content)

Effective flow: 

• Effective flow (Qe) = Assumed O2/(PV O2  content - SV O2 content)

Cardiac Index:

• CO/BSA

Fick Cardiac Output: 

• COFICK = Assumed O2/(A - V O2 difference)

If CO_1 is set to Fick cardiac output or if CO_1 and CO_2 have no value, saturation data will 
take precedence over other cardiac output data in the calculation of flows, shunts, and 
resistances.

Left to right shunt:

• L > R (L/min) = Pulmonic Flow Qp - Effective Flow Qe

Right to left shunt:

• R > L (L/min) = Systemic Flow Qs - Effective Flow Qe

Shunts will be calculated if sufficient saturation data is present and an oxygen saturation step 
of 3% to 7 % occurs, depending on the location of the step up in oxygen content.

NOTE
Shunts that constitute less than a 10% flow difference are not reported unless a custom shunt 
threshold is set.

Pulmonary Vascular Resistance:

Dynes units (dyn/sec/cm5):

• PVR = ((Mean PA Pressure  -  Mean PV Pressure)/Pulmonary Flow Qp) * 80

Woods units (HRU):

• PVR = (Mean PA Pressure  -  Mean PV Pressure)/Pulmonary Flow Qp

Oxygen Step Limits

Chamber Locations Significant O2 Step

SVC to RA 7% step in O2 content

RA to RV 5% step in O2 content

RV to PA 3% step in O2 content

PV to LA 5% step in O2 content

Other locations 5% step in O2 content
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Systemic Vascular Resistance:

Dynes units (dyn/sec/cm5):

• SVR = ((Mean SA Pressure  -  Mean SV Pressure)/Systemic Flow Qs) * 80

Woods units (HRU):

• SVR = (Mean SA Pressure  -  Mean SV Pressure)/Systemic Flow Qs

Total Systemic Vascular Resistance:

Dynes units (dyn/sec/cm5):

• TSVR =  (Mean SA Pressure/Systemic Flow Qs) * 80

Woods units (HRU):

• TSVR =  Mean SA Pressure/Systemic Flow Qs

Total Pulmonary Vascular Resistance:

Dynes units (dyn/sec/cm5):

• TPVR = (Mean PA Pressure/Pulmonary Flow Qp) * 80

Woods units (HRU):

• TPVR =   Mean PA Pressure/Pulmonary Flow Qp

Stroke Work Index:

• SWI = (13.6 * COL/M * LVSYSTOLIC)/(HR * BSA)

Valve Area (mean gradient):

• A (cm2) = (CO / (HR * PRD in seconds))/(K *  

Where:

a The valve constant K = 37.7 for the mitral valve and K = 44.3 for the aortic, pulmonic, and 
tricuspid valves, and

b Stroke volume is defined by CO / (HR * PRD (seconds).

NOTE
Cardiac Output is in milliliters (ml).

Fractional Flow Reserve:

• FFR = (PD - PV) / (PA - PV)

Where:

• PD = mean distal pressure

• PA = mean aortic pressure

• PV = mean venous pressure

meangradient 
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Contrast Limit field (Case Details screen):

• Kg body weight x manufacturer’s recommended contrast limit (cc/kg).

Contrast Total Max field (Case Details screen):

• Contrast Total Max  = 5cc x Kg of body weight/creatinine

Creatinine Clearance (Cockcroft-Gault formula for GFR estimate):

• Male GFR     = ((140 - age) x (weight)) / (sCr x 72)

• Female GFR  = ((140 - age) x (weight)) x 0.85 / (sCr x 72)

A2.2 Lab Value Conversions

The following equations for the conversion of lab values from standard American units to 
standard international (SI) units are taken from “Implementation of SI Units for Clinical 
Laboratory Data,” Donald S. Young, M.B., Ph.D., Annals of Internal Medicine, Vol. 106; No. 1, 
January 1987.

Blood Urea Nitrogen, mmol/l

• (BUN mg/dl) x 0.357

Creatinine, µmol/l

• (Creat mg/dl) x 88.4

Creatinine Clearance, ml/s

• (Creat. clearance ml/min) x 0.0167

Glucose, mmol/l

• (Glu mg/dl) x 0.0555

Hematocrit, %

• (Hct) x 0.01

Hemoglobin, g/l:

• (Hgb g/dl) x 10

Hemoglobin, mmol/l:

• (Hgb g/dl) x 0.6206
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A3 Monitoring Site Abbreviation Definitions

The following is a list of cardiac and peripheral vessel and chamber labels used in Xper 
Information Management System.

Abbreviation Definition

AAO Ascending aortic artery

AO Aortic artery

AOm Aortic artery monitoring

AOp Aortic artery pullback pressure

AOpo Aortic artery pullback outflow

AoRt Aortic root

Art Arterial pressure

Atrm Atrium

Azyg Azygous vein

BLAL Blalock, Taussig

C/S Coronary sinus

ComV Common venous

Cond Conduit

Cuff NIBP Cuff pressure

DAO Descending aortic artery

DLPA Descending left pulmonary artery

DMPA Descending mid pulmonary artery

DRPA Descending right pulmonary artery

FA Femoral artery

FAC Femoral artery compensation

FV Femoral vein

GLEN Glenenatimosis

HepV Hepatic vein

HIVC High inferior vena cava

HLA High left atrium

HRA High right atrium

HRV High right ventricle

HSVC High superior vena cava

InnV Innominate vein

IVC Inferior vena cava

LA Left atrium

LAxA Left axillary artery
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LBA Left brachial artery

LCA Left coronary artery

LCCA Left common carotid artery

LCIA Left common iliac artery

LEIA Left internal iliac artery

LFA Left femoral artery

LFV Left femoral vein

LIJV Left internal jugular vein

LIVC Lower inferior vena cava

LLA Lower left atrium

LLPA Lower left pulmonary artery

LLPV Lower left pulmonary vein

LPA Left pulmonary artery

LPOP Left popliteal artery

LPV Left pulmonary vein

LPW Left pulmonary wedge

LRA Lower right atrium

LRNA Left renal artery

LRV Lower right ventricle

LSCA Left subclavian artery

LSVC Lower superior vena cava

LUPA Left upper pulmonary artery

LUPV Left upper pulmonary vein

LV Left ventricle

LVA Left ventricular apex

LVO Left ventricular outflow

LVp Left ventricular pullback pressure

LVpo Left ventricular pullback outflow

MIVC Mid inferior vena cava

MPA Mid pulmonary artery

MPV Main portal vein

MRA Mid right atrium

MSVC Mid superior vena cava

PA Pulmonary artery

PAp Pulmonary artery pullback pressure

PLPA Proximal left pulmonary artery

Abbreviation Definition
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PMPA Proximal mid pulmonary artery

PRPA Proximal right pulmonary artery

PT Pulmonary track

PV Pulmonary vein

PVW Pulmonary venous wedge

PW Pulmonary wedge

PWp Pulmonary wedge pullback pressure

RA Right atrium

RAp Right atrial pullback pressure

RArt Right arterial

RAxA Right axillary artery

RBA Right brachial artery

RCA Right coronary artery

RCCA Right common carotid artery

RCIA Right common iliac artery

REIA Right external iliac artery

RFA Right femoral artery

RFV RIght femoral vein

RHV Right hepatic vein

RICA Right internal carotid artery

RIJ Right internal jugular

RIJV Right internal jugular vein

RLPA Right lower pulmonary artery

RLPV Right lower pulmonary vein

RPA Right pulmonary artery

RPOP Right popliteal artery

RPV Right pulmonary vein

RPW Right pulmonary wedge

RRNA Right renal artery

RSCA Right subclavian artery

RSVC Right superior vena cava

RUPA Right upper pulmonary artery

RUPV Right upper pulmonary vein

RV Right ventricle

RVOT Right ventricular outflow tract

RVp Right ventricular pullback pressure

Abbreviation Definition
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A4 LaFarge Table

Reprinted from Cardiovascular Research 1970, 4, p. 27.

SMV Superior mesenteric vein

SpO2 Pulse oximetry site

SPV Splenic vein

SubC Subcutaneous

SVC Superior vena cava

SysV Systemic venous

UA Umbilical artery

UV Umbilical vein

Ven Venous

Vent Ventricular

VenV Ventricular venous

VV Venous ventricle

Abbreviation Definition

Age Heart Rate (beats per minute)

50 60 70 80 90 100 110 120 130 140 150 160 170

Males

3 155 159 163 167 171 175 178 182 186 190

4 149 152 156 160 163 168 171 175 179 182 186

6 141 144 148 151 155 159 162 167 171 174 178 181

8 136 141 145 148 152 156 159 163 167 171 175 178

10 130 134 139 142 146 149 153 157 160 165 169 172 176

12 128 132 136 140 144 147 151 155 158 162 167 170 174

14 127 130 134 137 142 146 149 153 157 160 165 169 172

16 125 129 132 136 141 144 148 152 155 159 162 167

18 124 127 131 135 139 143 147 150 154 157 161 166

20 123 126 130 134 137 142 145 149 153 156 160 165

25 120 124 127 131 135 139 143 147 150 154 157

30 118 122 125 129 133 136 141 145 148 152 155

35 116 120 124 127 131 135 139 143 147 150

40 115 119 122 126 130 133 137 141 145 149

50 60 70 80 90 100 110 120 130 140 150 160 170
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NOTE
The LaFarge table is not intended to be used for patients under three years or over 40 years of 
age.

Females

3 150 153 157 161 165 169 172 176 180 183

4 141 145 149 152 156 159 163 168 171 175 179

6 130 134 137 142 146 149 153 156 160 165 168 172

8 125 129 133 136 141 144 148 152 155 159 163 167

10 118 122 125 129 133 136 141 144 148 152 155 159 163

12 115 119 122 126 130 133 137 141 145 149 152 156 160

14 112 116 120 123 127 131 132 133 143 146 150 153 157

16 109 114 118 121 125 128 132 136 140 144 148 151

18 107 111 116 119 123 127 130 134 137 142 146 149

20 106 109 114 118 121 125 128 132 136 140 144 148

25 102 106 109 114 118 121 125 128 132 136 140

30 99 103 106 110 115 118 122 125 129 133 136

35 97 100 104 107 111 116 119 123 127 130

40 94 98 102 105 109 112 117 121 124 128

Age Heart Rate (beats per minute)
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creating lists 120
editing fields 121
Form Designer overview 121
forms configuration 125
grouping fields on forms 124
overview 119
previewing forms 125
using custom forms 53

Customer Support contact information 151
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Definitions, monitoring site abbreviations 165
Document scanning 29

JPEG format 30
PDF format 30

E
Electrophysiology 57
Epic

Charting Menu 33
Medication data 34

F
Finalize study 54
Finalizing a case 56
Form Designer

adding pages 124
header 124

Formulas
assumed oxygen uptake 160
body surface area 160
cardiac index 162
cardiac output, Fick 162
contrast limit 164
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Flamm’s equation 161
flow, effective (Qe) 162
flow, pulmonary (Qp) 161
flow, systemic (Qs) 162
fractional flow reserve 163
oxygen content 161
oxygen step limits 162
shunt, left to right 162
shunt, right to left 162
stroke work index 163
valve area 163
vascular resistance, pulmonary 162
vascular resistance, systemic 163
vascular resistance, total pulmonary 163
vascular resistance, total systemic 163

Full System Reset 149

G
Given By marker 32

H
Hemodynamics Screen 37

Blood Gases worksheet 43
BSA value 46
cardiac outputs 46
entering oxygen saturations 42
flow variables 46
heart diagram 42
Hgb value 46
K variable 45
LaFarge table 45
miscellaneous controls 47
O2 content 45
O2 difference variables 46
O2 differences 45
O2 flow 45
O2 uptake 45
sample display window 43
shunt variables 46
shunts 45
valve data 47
vascular resistance 45
ventricular data 47

Historical links 142

I
Image review 55
Insurance Providers screen 138
Inventory

adding items 89
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barcodes, internal 93
categories 95
category maintenance 95
cycle counting 96
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deleting items from categories 96
editing item properties 89
export function 89
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Ordering 102
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searching 88
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vendor maintenance 100

K
Kit builder

creating a kit 108
editing a kit 109
overview 107

L
LaFarge Table 168
Level of Consciousness 141
Level of Pain 141
List Management
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List management 109

deleting columns 110
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LOC 141
Locking a case 36
LOP 141

M
Menu bar builder 79

Menus
builder screen 111
builder, overview 111
building a menu 112
creating 111
deleting 112
duplicating 112
editing a menu 112
fixed items 114
inventory items 114
kit items 115
layout operations 117
levels and sublevels 112
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menu attributes 115
saving 117
sedation/reversal attributes 116
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Messages
full system reset 149
OFF message on control screen 150

MODULES
Inventory 87
Patient Billing 137
Scheduler 61

Multiple insurance providers 138

N
Navigation, user-centric 78

O
Ordering inventory 102

P
Password management 80
Patient Assignment, Xcelera interface 143
Patient billing 137
Portal designer 79
Preventive Maintenance

monitor mounting integrity 147
monthly maintenance 147

Printing a case report 56
Procedure log 36
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R
Registries

overview 78
Registry Lists 110
Repositories 143
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Room Status 125

S
Safety
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adding rooms 61
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overview 61
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Staff 62
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Scrapers
case status 71
creation, data mining 66
creation, direct copy 64
creation, labels 69
data mining 64
direct copy 64
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overview 63
prefix 68
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types of 63

Security
assigning repository access 85
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physician group administration 86
portal designer 79
signature password settings 81
system password reset 87
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user administration 82
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Specifications
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overview 72
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SYSTEM
Case Report Configuration 140
Codes 128
Security 78
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drafts 54

Troubleshooting audio 150
Troubleshooting network connection 150
Troubleshooting power issues 149

monitor 149
no display on monitor 149
workstation 149
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User roles, creating 78
User tables 130

cardiac output probes 135
conditions 131
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FFR site labels 131
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procedure groups 135
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User, changing during a procedure 36
User-centric navigation 78
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